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There has been significant growth in the online
storage space in the last few years—with email stor-
age going unlimited, multiple file hosting, large
sub-hosting sites, etc. A key driver to this revolu-
tionary growth is probably the increase in file sizes
of music and video files that are largely being dis-
seminated through the Internet. Look at the popu-
larity of social sites like YouTube and Rediff iShare. 

Look at the growing storage in e-mails today.
Google’s Gmail offers over 7 GB of email storage space,
and it’s ever increasing! You can also get an addition-
al 10 GB at $20/year to 400GB at $500/year if you want. 

Last year, Microsoft’s Hotmail, which was the last
to respond to the e-mail storage space wars,
increased to 5 GB. They also offer extra storage at a
cost to the consumer. On the lines of Google’s online
storage, Microsoft offers free storage through its
hosting service called Windows Live SkyDrive, a pass-
word-protected online file storage with an option for
it to be shared with other people. It now offers 5 GB
of storage space. Earlier this service was available in
Beta with a 1 GB storage cap—only in the US, the UK,
and India post the first version that was a 500 MB
online storage drive for US and UK only. 

Do you see what’s happening here? There is yet
another Google-Microsoft war brewing. Both giants
are expecting users to use more and more of their
online storage services. The e-mail part is perceiv-
able. Both Gmail and Hotmail have tens or hun-
dreds millions using the service. Both are available
in tonnes of languages, with exceptional features
that tend to lure users—geeks, power users and
amateurs—to get hooked on. 

In my case, I even use Picasa Web albums and
have some storage in SkyDrive as well. But are users
ever going to choose these free storage options as
their main storage mediums? I doubt it. Not because
we aren’t mature enough to do so, but because we
do not trust those who are providing these services. 

Both the giants have pulled back services—deny-
ing features that were earlier available to users.
Google pulled the plug on the DTO/DTR (download-
to-own/download-to-rent) portion of Google Video
last year, and sent its users a $2 Google Checkout
bonus that can be redeemed at their online stores.
Microsoft pulled off the WebDAV functionality
from Hotmail that allowed user e-mails to be down-
loaded locally via desktop e-mail clients. 

The move to charge users for online storage
would take some time to take off. In India it doesn’t
seem like people would pay for extra storage—and
that too online. But you never know, as users
become more and more Web-enabled, there is a
good opportunity in the online storage market.
Another reason is: trusting a free service with your
important documents and files. I would rather store
it on my own desktop storage—hard drive, DVD, etc.
I even store some on my email—as a backup, like
sending files to myself, etc. I would probably only
use the online storage as a backup of my backup. 

However, if companies like Google and Microsoft
are at war to establish their supremacy, there is
every possibility that the poor user could either be
the beneficiary or the loser—more likely the loser.
Haven’t you heard of the saying, when two elephants
fight, it is always the poor ant that gets squashed.

Editorial

Sujay Nair Editorial Director

When Two
Elephants Fight...

“There is yet another Google-Microsoft
war brewing. Both giants are expecting

users to use more and more of their
online storage services...”

editor@thinkdigit.com



September 2008 • Volume 8 • Issue 9

Managing Director Dr Pramath Raj Sinha

Printer and Publisher Kanak Ghosh

Publishing Director Asheesh Gupta

Editorial
Editorial Director Sujay Nair
Assistant Editor Robert Sovereign-Smith
Writer Aditya Madanapalle
Editorial Co-ordinator Kanvika Vishnoi

Copy Desk
Associate Editor Devarajan Mahadevan

Test Centre
Assistant Manager Sanket Naik
Reviewers Michael Browne, Rossi Fernandes 
Product Co-ordinator Yogendra Bagle

Design
Creative Head Kabir Malkani
Art Director Rohit A Chandwaskar
Senior Designers Vijay Padaya, U Ravindranadhan
Illustrators Shrikrishna Patkar, Kiran Bhosle,
Ashwini Baviskar
Photographer Jiten Gandhi

Multimedia
Project Head Robert Sovereign-Smith
Content Co-ordination Rossi Fernandes

Sales and Marketing
VP Sales and Marketing Navin Chand Singh
Product Manager Navneet Miglani
Assistant Brand Manager Arpita Ganguli
Marketing Communication Thomas Varghese  
Asst. Manager-Scheduling & MIS Ramesh Kumar 

Production and Logistics
GM—Operations Shivshankar Hiremath
Production Manager Mangesh Salvi
Logistics M P Singh, Vilas Mhatre, Mohd. Ansari,
Shashi Shekhar Singh 

Circulation and Subscription — Sales
GM Circulation Milind Prabhughate
Co-ordinator Rahul Mankar
Customer Service Prerana Panchal,
Vrushali Londhe

Head Office: Editorial, Marketing 
and Customer Service 
Nine Dot Nine Interactive Pvt. Ltd
C/o KPT House, Plot 41/13, Sector 30 
Near Sanpada Railway Station, Vashi, 
Navi Mumbai 400703
Phone: 40789666
Fax: 022-40789540, 022-40789640

Customer Service:
022-40789612/13/14

Cover Design Rohit Chandwaskar

Tell Us What You Feel About Digit
Each month, Digit walks through the technology
maze to bring you the most relevant, most
researched stories. If you have an opinion about
anything published in Digit, or about technology
in general, please write to editor@thinkdigit.com

Product Testing
Want your product reviewed by Digit?
Contact our Test Center at
testcenter@thinkdigit.com

Software On DVD/CD
To submit and suggest software for 
inclusion in the Digit DVD or CD, write to
cdcontent@thinkdigit.com

Help!
For subscription or copy-related issues,
send an e-mail to help@thinkdigit.com

Endorsements/Reprints
Interested in ordering article reprints,
or using our logos? Contact
reprint@thinkdigit.com

Business Enquiries
For any business-related enquiries, contact 
business@thinkdigit.com

News and New Product Launches
To announce new product launches, and press
releases, email us at pressrelease@thinkdigit.com

Advertisers’ Index

2 DIGIT SEPTEMBER 2008

Y O U R  T E C H N O L O G Y  N A V I G A T O R

Client . . . . . . . . . . . . . . . . . . . . Page

APC  . . . . . . . . . . . . . . . . . .Back Cover

Canon  . . . . . . . . . .Inside Front Cover

Creative  . . . . . . . . . . . . . . . . . . . . . .25

Dell . . . . . . . . . . . . . . . . . . . . . . . . . .13

ECS  . . . . . . . . . . . . . . . . . . . . . . . . .99

Gigabyte  . . . . . . . . . . . . . . . . . . . . .17

iBall  . . . . . . . . . . . . . . . . . . . . . .11, 59

Intel  . . . . . . . . . . . . . . . . . . . . . . . . .15

Kingston  . . . . . . . . . . . . . . . . . . . . .31

MSI . . . . . . . . . . . . .Inside Back Cover

Nanopoint  . . . . . . . . . . . . . . . . . . . .29

NEC . . . . . . . . . . . . . . . . . . . . . . . . .101

Nokia  . . . . . . . . . . . . . . . . . . . . . . . .23

Nvidia  . . . . . . . . . . . . . . . . . . . . . . .73

Palit  . . . . . . . . . . . . . . . . . . . . . . . .109

Plustek  . . . . . . . . . . . . . . . . . . . . . .53

Religre . . . . . . . . . . . . . . . . . . . . . . . .9

Samsung  . . . . . . . . . . . . . . . . . . . . . .3

Seagate  . . . . . . . . . . . . . . . . . . . . . .27

Topgun . . . . . . . . . . . . . . . . . . . . . . .57
Disclaimer: For every Digit contest, there will be only
one winner, unless specified otherwise. In the event of
a dispute, the Editor’s decision shall be final.

Printed and Published by Kanak Ghosh,
for Nine Dot Nine Interactive Pvt. Ltd.
C/o KPT House, Plot 41/13, Sector 30 
Near Sanpada Railway Station, Vashi
Navi Mumbai 400703

Editor: Sujay Nair
C/o KPT House, Plot 41/13, Sector 30, Near Sanpada
Railway Station, Vashi Navi Mumbai 400703

Printed at Silverpoint Press Pvt. Ltd, 
Kohinoor Estate, 165, Tulsi Pipe Road,
Lower Parel, Mumbai 400 013

To Advertise
South
Sanjay Bhan
E-mail: sanjay.bhan@9dot9.in
Mobile: +91 9341829285, 
Phone: (080) 25546370-73 
Fax: 41518330
Phone: (044) 28235186/88 
Fax: 28230731
Phone: (040) 27894167/ 55221051
Fax: 27720205

West
Arvind Ambo 
E-mail: arvind.ambo@9dot9.in
Mobile: +91 9819904050 

Phone: (022) 40373636/
40373626/24494572/24467130/1
Fax: 24482059/24481123

East
Jayanta Bhattacharyya
E-mail: jayanta.bhattacharyya@9dot9.in
Phone: +91 9331829284
(033) 22317344/46

North
Umang Kumar
E-mail: umang.kumar@9dot9.in
Phone: +91 9999000785, 
(011) 41608655/56/57/58

International
Navin Chand Singh 
E-mail: nc.singh@9dot9.in
Mobile: +91 99013 00772

Digital Cameras
Test . . . . . . . . . . . . . . . .42
Canon Digital IXUS 80 IS
Canon Digital IXUS 85 IS
Canon Digital IXUS 960 IS
Canon PowerShot A470
Canon PowerShot A590 IS
Canon PowerShot A720 IS
Canon PowerShot SX100 IS
Fujifilm FinePix J10
Fujifilm FinePix S5700 
Fujifilm FinePix Z100fd
Kodak Easyshare C713
Kodak Easyshare M1033
Kodak Easyshare M1063
Mustek MDC 530
Nikon COOLPIX L16
Nikon COOLPIX L18
Nikon COOLPIX S210
Nikon COOLPIX S52

Nikon COOLPIX S520
Nikon COOLPIX S550
Olympus FE-330
Olympus SP-570 UZ
Olympus Stylus 1010
Olympus Stylus 1030 SW
Samsung i8
Samsung L100
Samsung L210
Samsung NV24HD
Samsung S1060
TECH-COM DSC-520
TECH-COM DSC-524X
PLUS
TECH-COM DSC-601

Printer Test . . . . . . . . .88
Brother HL-2140
Brother HL-2150N
Brother HL-2170W

Canon iP3500
Canon iP4500
Canon LBP 2900B
Canon LBP-1210
Canon LBP-3300
Canon Pixma iP2580
Epson Photo R230
Epson Photo R290
Epson Stylus C110
Epson Stylus T11
HP 1007
HP 1008
HP 910
HP P1505
HP Photosmart D5368
HP Photosmart D7268
Samsung ML-1640
Samsung ML-2245
Samsung ML-2850D
Xerox 3117

Bazaar  . . . . . . . . . . . . .74
ASUS M3N-HT Deluxe
ASUS Xonar U1 Audio
Station
Aten ALTUSCN KE8220
Billion BiGuard S6000
Cooler Master Elite 330
CoolerMaster Hyper 212
CoolerMaster Real Power
M700
Gigabyte GA-EP43-DS3L
HTC Touch Diamond
Nokia 6210 Navigator
Openmoko Neo
FreeRunner
Razer Goliathus Alpha
Speed
Razer Mako 2.1
Sennheiser PXC 450
ViewSonic PJ513DB
ViewSonic VX1962WM

Products Reviewed This Month



5SEPTEMBER 2008 DIGIT

Tech Talk..........................................10
Beat That ........................................16
Stat Attack ......................................18
Buzzword Of The Month ..................18
W5H.................................................20

Agent001 ........................................39
Tips & Tricks ....................................65
Whatever Happened To ..................116
People Who Changed Computing ....117
Bluff Your Way Through..................118

Wild Wild Web ................................118
Blogwatch ......................................119
Tech Quiz........................................120
Inbox ..............................................126
Tabloid Tech ..................................128R

EG
U

LA
R

S

116
The $1000 iPhone
App

116
Bill Gates Predicts
The Future; Or
The Past

117
The Spam King Is
Dead

118
White House
Server Loses 
E-mail

Digital Leisure

Digital Business

Test Center
Printers Test
Laser and inkjet printers tested across two cat-
egories to help you find the right solution for
your business

4 DIGIT SEPTEMBER 2008

10
Now, A Motion-
powered Phone
Charger

10
Intel’s Vision Of
Things To Come

12
Lost Your Laptop?
Here’s Help

12
Cheaper Laptops
For India And
China

14
Microsoft Unveils
Photosynth

16
Pune To Have
Animation
Gurukul

16
HDTV In India By
Year End?

DIGITAL PASSION

DIGITAL TOOLS

Drool Maal

Enter

Escape

98

111

88 Communication Technologies
Around The World In Real Time

Human Resource Training
Revamping The Technical
Education System

Information Security
How Secure Are You?

Disaster Recovery
Better Safe Than Sorry

85 Smart SoHo
Soft Where?
Answer the questions, why, what, where
and how to buy software for your business

Insight
Life in the 
fast lane
Desktop memory has taken
one more step forward,
even as video memory gets
its much awaited shot in the
arm. The next generation is
here. We answer the what
and the why.

21

32
Tomorrow
An OS You Want!
Rather than sit around waiting to see
what a future operating system (OS) will
offer, we’re preparing our own wish list.
Let’s just hope that the powers that be
are listening...

28

Enhance
Must-have Windows

Mobile Apps
Get them now, that’s an order!

Test Centre
Hot Shots
We test 32 of the most
popular digital cameras on
sale in India, to find which
one suits you best

Contents Magazine September 2008

35

42

Agent 001
Light Enough For Flight
Agent001 recounts his laptop buying experiences39

Space Siege
Save humanity by sacrificing
yours – part by part

112
Company of Heroes
Opposing Fronts

114
Devil May Cry 4
Cry he will… cry he must!



7DIGIT SEPTEMBER 2008

Contents Interactive

6 DIGIT SEPTEMBER 2008

Contents Interactive

For any queries regarding the CD or DVD, e-mail help@thinkdigit.com with “CD/DVD” as the subject.
If the subject is not mentioned, your mail might not reach the right person.

GAMES

Mauj Mobile Jockey
5 Super games: Super Cricket, Milk
Riot, Mech A Move, Downtown
Pursuit and Alien Conquest. Also
including a Phone Tool - SMS
Genie: A one stop shop for All SMS
needs. No need to waste time
remembering Keywords and
getting frustrated with wrong
responses. 

n Blockland v9
n Live For Speed S2 Demo (Patch Z)
n Ninja Loves Pirate
n Pro Cycling Manager 2008 Demo
n Space Siege Demo
n WALL-E Demo

TRAILERS
Call of Duty: World at
War Co-op Preview

Call of Duty: World at Warc
ompletely changes the rules of
engagement by redefining WWII
gaming and thrusting players into
the final tension-filled, unforgiving
battles against a new ferocious
enemy in the most dangerous and
suspenseful action ever seen in
WWII.

n Call of Duty: World at War Reveal
Trailer

n Flatout Ultimate Carnage  Trailer
n S.T.A.L.K.E.R.: Clear Sky - Video "The

Zone World"

HD
Beverly Hills Chihuahua

While on vacation in Mexico, Chloe, a
ritzy Beverly Hills chihuahua, finds
herself lost and in need of assistance
in order to get back home.

Bolt
Bolt, a German Shepherd, has lived
his whole life on the set of his action
TV show, where he believes he has
superpowers. When separated from

the studio by
accident, he meets
Mr. Mittens
(actually a female
cat) and a hamster
named Rhino.
Along the way, he

learns that he doesn't have
superpowers and that the show is
not realistic.

Harry Potter and the Half-
Blood Prince
As Harry Potter begins his 6th year

at Hogwarts School of Witchcraft and
Wizardry, he discovers an old book
marked mysteriously "This book is
the property of the Half-Blood
Prince" and begins to learn more
about Lord Voldemort's dark past.

TRAILERS
Australia
Set in northern Australia before
World War II, an English aristocrat
who inherits a sprawling ranch
reluctantly pacts with a stock-man in
order to protect her new property
from a takeover plot. As the pair
drive 2,000 head of cattle over
unforgiving landscape, they
experience the bombing of Darwin,
Australia, by Japanese forces
firsthand.
n Max Payne
n Nick and Norah's Infinite Playlist
n W
n What Just Happened

CREATE
n Microsoft Visual J# 2.0

(x64)
n Microsoft Visual J# 2.0

(x86)
n Adobe Acrobat 9 Pro

Extended
n Adobe Photoshop

Lightroom 2

WEB
n Rank Tracker 4.3.2
n Roden Web Editor X4
n ActiveSWF Professional

2.1.2.0
n AllWebMenus Pro 5.1 
n CoffeeCup Web Form

Builder 7.91
n dbQwikSite 5.3.1.0
n Dynamic HTML Editor

4.2.50
n Easy Website Pro 4.01
n Flash Optimizer 2.0.1.333

n HTMLPad 2008 Pro
9.1.0.98

n OverSite 2.4.6
n Rapid CSS Editor 2008

9.1.0.98
n Sothink SWF Decompiler-

Flash Decompiler 4.3
Build 80806

n SpreadsheetConverter to
HTML/JavaScript 4.2.0

n TOWeb 2.6.2.527
n WeBuilder 2008 9.1.0.98

LINUX
n OpenSolaris 2008.05-x86
n Amarok 2.0 Alpha 2
n aTunes 1.9.0
n Audacious: 1.5.1
n Avidemux 2.4.3 for Linux
n Banshee 1.2.0
n blueMarine

0.9.RC2b.3244 for Linux
n Clonezilla Live 1.1.0-8

n Coccinella 0.96.8 for
Linux

n Earth3D 1.0.5
n Exaile 0.2.13 for Ubuntu
n Flock 1.2.4 for Linux
n F-Spot 0.4.4
n KGuitar 0.5.1
n Meta Tracker 0.6.6
n Picasa 2.7 for Linux

(DEB)
n Picasa 2.7 for Linux

(RPM)
n RawTherapee v2.3 for

Linux
n RawTherapee v2.3 for

Ubuntu
n Revelation 0.4.11
n RSSOwl 2.0 M8a for

Linux
n Sage 3.0.6
n Ultamatix 1.8.0-3
n vMovieDB 0.1.5

Gaming

TRAILERS
High School Musical 3:
Senior Year

As seniors in high
school, Troy and
Gabriella struggle
with the idea of
being separated
from one another
as college
approaches.
Along with the

rest of the Wildcats, they stage a
spring musical to address their
experiences, hopes and fears about
their future.

Punisher:
War Zone
After hunting
down and killing
hundreds of
violent criminals,
Frank Castle, aka
The Punisher,

faces his most deadly foe yet: Jigsaw.

GAMES
ManiaDrive 1.2 for
Windows
ManiaDrive is a free clone of
Trackmania, the great game from
Nadéo studio, and is an arcade car

game on acrobatic tracks, with a
quick and nervous gameplay (tracks
almost never exceed one minute),
and features a network mode, as the
original.

n Mauj Mobile Jockey
n Eternal Daughter
n Pingus 0.7.2 for Linux
n Pingus 0.7.2 for Windows
n Room War
n The Breakdown

MULTIMEDIA
AIMP 2.5 Build 276 RC3

Mediaplayer -
qualitative and
pure playing
multimedia of
files, including
mp3; good
features, small
size and
minimal use of

system resources.

n AviSynth 2.5.8 RC3
n Blender 2.47 RC 2
n Cool Free Audio to AMR Converter 5.1
n Daniusoft MP3 WAV Converter 2.0.24.4
n DVD Flick 1.3.0.0 Build 674 Beta
n FastPictureViewer 1.0.38.0
n FLV Encoder 3.5.8.0
n FotoTagger 2.12
n Free Audio Editor 2008 5.2.2
n Free Sound Recorder 7.1.1
n GNU Solfege 3.11.1 Beta
n GX::Transcoder 5.0.2.844 Beta 10.8
n IrfanView 4.20 ALL plugins
n KoffeePhoto 2.5.126
n Last.fm 1.5.2.38918
n Mixxx 1.6.0
n Music Editor Free 7.2.2
n RightMark Audio Analyzer 6.1.2
n Songbird 0.7.0 RC 1
n Soundbase 2008.08.08.1

INTERNET
amsn 0.97.2
This project is a modified and
multilanguage version of Compu's
Messenger (CCMSN).It's a Tcl/Tk script
as was CCMSN and Tcl/Tk must be
installed to run it. This means it is
multiplatform and can run on any OS
having Tcl/Tk installed (Linux, Windows,
Macintosh).

n Architecture Journal Reader 0.9.2 Beta
n Awasu Personal Edition 2.3.4 Beta
n eMule 0.49b Final
n FileZilla 3.1.1 RC1
n Firefox 3.1 Alpha 1
n Flock 2.0 Beta 2
n GrabIt 1.7.2 Build 988 Beta
n HydraIRC 0.3.164
n IncrediMail 5.85 Build 3718
n Instantbird 0.1.2
n K-Meleon 1.5.0
n Maxthon 2.1.3.2430 Final
n Microsoft Windows Defender 1.1.1593.0
n Miranda IM 0.8.0 Test 20
n Mozilla Thunderbird 3.0 Alpha 1
n OnLine TV Live 6.3.41
n RetroShare 0.4.10a
n SafestMail4Outlook 2.0
n SeaMonkey 1.1.11.2008070216
n Sleipnir 2.8.0 Build 2800400
n VooDoo cIRCle 1.1 Beta 32

SYSTEM
Banana Shrink 0.99
BananaShrink has the ability to create
self-extracting compressed files with
ease. Banana Shrink is a better solution
for any file distribution, avoiding the use
any specific file format
compression/uncompression utility!
BananaShrink uses also a file integrity
checking mechanism (CRC).

n Belarc Advisor 7.2.24.7
n CPU Speed Professional 3.0.2.2
n Find and Run Robot 2.30.01
n Fresh Diagnose 7.88
n GW Core+Proph Mes Icons 1.5
n MyFolder Free 1.0
n PrimaryCons Red
n Shock 4Way 3D 1.29
n Shutdown Scheduler 6.2.0.80
n TyphoonZip 1.02 Build 808080954
n Vnd Hard Disk Scanner And Registry

Scanner 2.65.34
n Vsbenchmark 2007 1.0

Tools

EntertainmentEntertainment

Puppy Linux 4.0
A small, fast operating system
running from CDs, USB sticks and
hard disks

Productivity

n Net Monitor for Employees 2.9.9
n Outlook True Archive 1.0.15
n ParetoLogic Anti-Spyware 5.7.0.10
n PSTSync 2.7.1129
n ScriptFTP 3.0
n SecureFX 6.0.3.311
n SmartFTP 3.0.1021.14
n Spyware Terminator 2.3.0.487
n Supersonic Download Accelerator 2.5.0.0
n Timbuktu Pro 8.6.5 RC 229
n Vuze 3.1.1.1 Beta 22

SYSTEM
n Lightsmark 2008 2.0
n PC Network Clone 1.0
n VirtualBox 1.6.4
n AllSync 3.0.49
n Anti Trojan Elite 4.1.1
n Ashampoo Core Tuner 1.00
n Aston2 Menu 1.2.1
n Auslogics Visual Styler 3.1.15.145
n Backup4all 3.11 Build 309
n Beyond Compare 3.0.1 Build 8602 Beta
n BitDefender Total Security 2009 RC
n Diskeeper 2008 Pro Premier
n Driver Genius Professional 2008 8.0.0.316
n EF Commander 6.62
n EVEREST Ultimate Edition 4.50.1469 Beta
n Falco Icon Studio 3.0
n Genie Backup Manager Pro 8.0.340.510
n IconCool Studio 6.00 Build 80730
n Image for Windows 2.15

n Macrium Reflect
4.2.2020.1

n Paragon Total
Defrag 2009 

n PerfectDisk 2008
Build 61

n Protector Plus
2008 Antivirus
8.0.D01

n SkinStudio 6.2
n The Ultimate Troubleshooter 4.67
n Total Commander 7.04a
n Trojan Remover 6.7.1 Build 2538
n Veeam Backup 2.0
n VideoDesktop Dream Scape 1.7
n Vista Manager 1.5.4

ESSENTIALS
n .net Framework 2.0
n µTorrent 1.7.7
n Avast Home Edition 4.8
n Comodo Firewall Pro 3.0.25.378
n Foxit Reader 2.3
n Free Download Manager 2.5 build 758
n Irfan View 4.20
n Java(TM) 2 Runtime
n K-Lite Mega Codec Pack 4.1.4
n Opera 9.51 Build 10081 Final
n Silverlight
n Spybot Search and Destroy 1.60
n VLC Player 0.8.6i
n WinRAR 3.71

UPDATES AND ADD-ONS
n Adobe Shockwave Player 11.0.0.465
n Avast Antivirus Updates
n AVG Free Edition 8.0 Build 138a.1332
n Java Runtime Environment 6 Update 10 RC
n Kaspersky Antivirus Updates
n McAfee Antivirus SuperDAT Update
n Norton Antivirus 2008 Updates
n WinSCP 4.1.6
n ArcaMicroScan 2008.07.28
n eScan Virus Control Edition 9.0.824.205
n Kaspersky Internet Security 2009

8.0.0.454
n Microworld Anti Virus & Spyware Toolkit

Utility 9.9.9
n Steganos Privacy Suite 2008 10.0.5.0

Revision 5374

MULTIMEDIA
ABest Mobile Video Converter
Free 4.22

ABest Mobile
Video Converter
Free is an easy-
to-use and all-
in-one tool for
video
conversion,

splitting and editing. This application is
able to extract audio tracks from video
as well as to encode video files from one
format to another.

n Any FLV Player 2.2.1
n Canorus 0.5
n Helicon Filter Free 4.88
n K-3D 0.7.8.0
n MediaCoder 0.6.1 Build 4166 Beta
n MPlayer for Windows
n RARPlayer 1.0.0
n SlingPlayer 1.5.1
n A4Desk Music Player 2.03
n AVS Audio Editor 4.1.1.254
n Cinecode 1.2.11
n DivX 6.8.4.5
n DJ Music Mixer 3.8
n e-mix Home Edition 5.0.1.140
n Jaikoz 2.5.1 Build 1048
n MAGIX MP3 Maker deluxe 14 Build 9.03
n Media Center 12.0.529
n MixVibes Pro 7.043
n MP3 Tag Clinic 4.3.7.2
n Pulse Master 5.3
n RawTherapee v2.3 for Windows
n River Past Audio CD Ripper 6.7.12.1748
n River Past Crazi Video for Apple TV

7.7.12.1748
n River Past Crazi Video for PSP 2.7.12.1748
n River Past Ringtone Converter 2.7.12.1748
n Solid AVI/DIVX to DVD Burner 1.2.7
n Sound Editor Deluxe 2008 5.1.1
n Tag and Rename 3.5 Beta 2
n TagTuner 1.9.0.1409
n Total Recorder Editor 11.0.1
n Traktor DJ Studio 3.3.2.060
n Ultrawave Guitar Multi Fx 1.33
n Wave MP3 Editor 15.5
n Winamp 5 Full 5.541 Build 2165

INTERNET

n Collanos Workplace Windows 1.3.0.3
n Evolution for Windows 2.22.2-4
n ADDAX 3.0
n Advanced Net Monitor for Classroom 4.8.1
n AIM 6.8.12.4
n Antispam Marisuite 1.0.6
n Azureus Ultra Accelerator 2.7.1.0
n BearShare 6.2.0.51345
n Check and Get 3.3 Build 484
n Clyton 1.3
n CoffeeCup Live Chat 6.1
n CommFort 4.00
n Download Accelerator Plus 8.6.7.1
n DownloadStudio 5.0.2.0
n Easy RSS Content Generator 3.1
n Email Director .NET 2.3
n Email Responder 2.1
n GFI MailArchiver for Exchange 6
n HiDownload Pro 7.2
n Internet Download Manager 5.14 Build 3
n mailControl 4.2.5.2572
n mIRC 6.34

Tools

BOOTABLE CD

Bootable
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After installing Windows Vista Service Pack 1 you might have
noticed that the free space on the installation drive has reduced
significantly. Where has the free space gone? Well the answer to this
question is that the RTM files (your old system files) were backed up
during installation of SP1 so that the system can be rolled back to
prior state if the user decides to uninstall the SP1.

If you have no plans to un-install the SP1 then you can reclaim the
space by removing the backed up files. To get back your free space
you need to run ‘Vsp1cln.exe’ (without quotes).

Here’s how you can do that:

1. Press [Windows Logo] key + R on your keyboard or click
‘Run’ on the Start menu.
2. Now type Vsp1cln.exe in the run dialog box & click OK.
3. Enter the Administrator credentials & click Continue on UAC
prompt.
4. In the Command Prompt window, press ‘Y’ on the keyboard and

press Enter/Return key.
5. Windows will now cleanup the disk.

Optional switches you may use with Vsp1cln.exe (Without
Quotes):
1. “/? or /h”- Displays this list of Vsp1cln.exe commands.
2. “/o:[Offline_Windows_directory_path]”- Indicates
that the archived RTM files that need to be removed are in an
offline image.
3. “/quiet”- Runs in quiet mode. No console output is provided. If
this option is not used, you will be prompted with a confirmation
message.
4. “/verbose”- Provides additional diagnostics output.

I reclaimed approximately 1 GB of disk space after running the clean
up tool. 

WARNING- You cannot un-install/remove Windows Vista Service
Pack 1 after running this tool.

28-03-2008, 
03:48 PM

Narangz
Tech in my blood

Join Date: May
2005
Location:
Paradise
Posts: 993
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online, and
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available online,
for free!

Quick and easy
registration process
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Choose to download
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software on the Net

Buy and sell tech
products in the Digital
Marketplace

The all new Tech Q&A
Section allows anyone
to ask our panel of
experts questions.
Satisfaction
guaranteed!
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Age Old Hacks
The age old protocols used by the Internet are
coming back to haunt it. A new security hole as big
as the DNS problem was demonstrated by Alex
Pilosov and Tony Kapela. The loophole was in the
routing protocol BGP (Border Gateway Protocol)

IE8’s Porn Mode 
Internet Explorer 8 has a ‘inprivate’ mode that allows
users to surf the Web without leaving any traces. This
means that no temporary files, cookies, cache or history
data will be stored. This feature is infamous now as being
a ‘porn mode’. 

Acompany called M2E
Power has succeeded
in developing tech-

nology that will charge elec-
tronic gadgets with human
motion. The company says
that six hours of cumulative
motion can add 30 to 60
minutes of talk time to a
cell phone.

The charger can be
placed inside a purse or
backpack and the device
will charge in the back-
ground. A fully charged
device-store can recharge a
phone at a speed compara-
ble to an AC outlet.

The device consists of a
lithium-ion battery and a
series of coils and magnets.
An electromagnetic field
forms around the coils to
generate electricity when
the device is in motion.

An AC wall socket can
charge the charger unit as
well. M2E Power is having
discussions with cell phone
manufacturers to build the

generator directly into a
phone.

However, the company
says that it will take at least
two years before a self-pow-
ered cell phone is available
in the market. Also planned
are devices for hybrid and
electric cars. 

FUTURE SCAN

Intel’s Vision
Of Things
To Come

Humans please step
aside. The future is
going to be con-

trolled by robots, rapidly
accelerating technology
and gadgets that morph
into what you want them to
be. Also on Intel’s drawing
boards are the latest devel-
opments in wire-free power
transmission. So coming
soon, you are going to have

a Wireless Resonant Energy
Link (WREL). This is tech-
nology that transmits
power without cords. This
means that simply being in
the vicinity of a transmitter
will charge your laptop or
mobile phone. Intel is work-
ing on transmitting power
wirelessly without losing
too much during transmis-
sion. Within a range of two
meters, they can successful-
ly transfer power with upto
75 per cent efficiency.

Intel has unveiled its
vision of future technolo-
gies at this year’s Intel
Developer Forum (IDF) held
in San Francisco. The com-
pany demonstrated several
technologies that it says
would be part of an evolu-
tion that would bridge the
gap between humans and
machines by 2050. Intel dis-
closed a wireless power
source for recharging
devices and robot proto-
types. These prototypes
could one day lead to more
human-like versions of the
machines.

In fact, the giant chip-
maker expects machines to
overtake humans in reason-
ing ability in the near
future. Intel says that the
rate of technology advance-
ment is accelerating at an
“exponential” rate.

WREL consists of a
source antenna and a device
antenna. The source anten-
na draws power from a regu-
lar electricity outlet. The

Enter
TECH ON THE MOVE

Now, A Motion-powered Phone Charger

n   Aaron Sorkin to make a film on Facebook n IE8 beta 2 up for download n High res images of Dead Sea scrolls uploaded

We met up Mr. Sunil Chandna,
CEO, Stellar Information Systems
Ltd during his short stay in
Mumbai to talk about some of
Stellar’s latest products.

Tell us about your latest data
recovery products and your
target audience.
Our services mostly focus on
larger businesses and companies,
but we have released Black Cat,
which is system backup software
along with an antivirus for a
typical home user. We also
recently released Phoenix Photo
Recovery which allows users to
recover photos of all kinds of
image formats, including
proprietary ones.

We have data recovery
products for all kinds of needs,
but we also have some unique
ones like Disk Wipe which can be
permanently erase data off the
disk so it can’t be recovered. 

Do you provide any kind of
services or are you limited to
just data recovery software?
We have services where
companies can approach us to
recover data from all kinds of
drives. We recover data of all
kinds of file formats and
databases. We have centres
spread all across the country for
this purpose. We have a Class 100
clean room in Gurgaon, with a
refreshed database of drives of
all sizes and formats at our
disposal. We have a skilled team
at work at each one of our
centres and you can get with
touch with us through phone lines
or the Internet.

Are these services available for
the end user consumer?
Data recovery requires a lot of
work and can take any amount of
time depending on the complexity
of the problem. The rates for
these services although aren’t
always feasible for home users.

Is the antivirus developed in-
house, and are there any plans
for firewalls an such?
As of now, we have no such
plans to do so. Our current
product Black Cat comes with an
antivirus component bundled
along which by K7.
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electromagnetic field so gen-
erated is picked up by the
device antenna, which in
turn powers up the gadget to
be charged.

Apart from laptops and
mobiles, this technology can
also be used to power refrig-
erators, lamps and televi-
sions.

Researchers are also
looking into the uses of
micro-robots that can be
used to build shape-shifting
devices. Developed by
researchers at Carnegie
Mellon University, these
robots can be designed to
form large-scale machines.
They can be programmed
from many different devices.
The chipmaker also demon-
strated its work on the next
generation of robots.

Intel displayed technolo-
gy that gives robots the
sense of touch.

The second robot demon-
strated technology that
enabled it to recognise faces
as well as interpret and exe-
cute generic commands
with state-of-the-art motion
planning, manipulations,
perception and artificial
intelligence.

AN OPEN SOURCE TRACKER

Lost Your
Laptop?
Here’s Help

Computer scientists at
the University of
Washington have

developed the first free,
open source laptop tracking
system. What’s more, users
themselves without the
need to call on any external
corporate body can install
the system.

The system has been
called Adeona, after the
Roman goddess of safe
returns.

On the cards is a version
of the tracking system for

the iPhone. The
developers of
Adeona say that
the danger with
commercial laptop
tracking systems is
that it is not possi-
ble to know if some-
one at the tracking
company wouldn’t
exploit the compa-
ny’s possession of per-
sonal information.

Information about data
residing on the laptop is
also vulnerable to exploita-
tion. Further, courts can
also call upon such data in a
subpoena.

A user has to install a
piece of free software on the
laptop. The credential key
that the software provides
can reside on a thumb drive.
The key is required to track
the laptop if it’s stolen.

The software uses several
different methods for laptop
tracking.

It can broadcast the IP
address where the computer
is used. It directs the inbuilt
camera (present in a few lap-
tops) to take pictures every
half a minute of the person
using the stolen device.

DELL INTRODUCES NEW LINE

Cheaper
Laptops For
India And
China

Dell’s market strategy
was focussed on sell-
ing products of the

same quality worldwide. In a
major divergence from this
long standing strategy, Dell
introduced two notebooks
and two desktops manufac-
tured and priced for devel-
oping economies like India,
China and Brazil. The
devices are targeted specifi-
cally at small businessmen,
and hope to exploit a rapidly

expanding Asian, African
and Latin-American market.

This follows the strate-
gies of Dell’s chief competi-
tors, Lenovo, Hewlett-
Packard and Acer—all of
whom have similar strategies
for harvesting profits out of
the same market space. 

Dell posted huge profits
in the first quarter of this
year, with five times as
much as the profits coming
from the BRIC nations
(Brazil, Russia, India and
China) than in it’s home
country, the United States.
Dell’s biggest strength that
worked well in the Trans-
Atlantic Nations, turned
out to be its biggest weak-
ness in the developing
economies. Their direct
model of sales had cus-
tomers order their comput-
ers over the phone and the
Internet, but this business
model turned out to be
unsuitable for the vast rural
markets waiting to expand
in China and India.
Retailers in China are
already stocking Dell
machines, which is not
done anywhere else in the
world as yet. There are 2,700
Dell outlets shared between
the Suning and  Gome
retailers. This option seems
to be feasible for countries
like India too. 

The new Vostro note-
books are being sold for
Rs 20,750 and the new desk-
top PCs are being sold for

Security Watch

Code Piggybacks
On .xls Files

Problem
In the middle of August,
Microsoft released a security
bulletin patching an
important problem in
Microsoft Excel. The problem
effects MS Excel 2000, MS
Excel XP, MS Excel 2003 on
PCs and Excel 2004 for Mac
machines.

The vulnerability does
not effect MS Excel 2007.

The problem can occur
from .xls files downloaded
from Web sites or from e-
mail attachments. A
maliciously written Excel
document can corrupt the
memory used for the Excel
workspace, and execute code
remotely on the computer.
This problem is even more
acute when opening Excel
documents as a system
administrator. 

This problem is flagged
as being critical for MS Excel
2000. Systems that work
with Excel files are at risk,
but servers with access to
the Internet are more
vulnerable. Any malicious
activity using this method
relies on some kind of action
from the user, either opening
the file voluntarily or being
misled to do so. Any attacker
would have the same amount
of control over the system as
the user.

Solution
Microsoft has released a
patch covering this security
hole which is available at
http://tinyurl.com/5j4ay7.
Before installing the update
it is essential that all the
service packs for the
relevant windows OS is
installed. It is always safer to
work without administrative
privileges while working with
downloaded documents.

to the Net   n Steve Jobs mistakenly reported dead by Bloomberg   n Microsoft and Nikkon sign deal to share patents   n
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Rs 19,230. According to Dell,
there are more cheaper
models in the offing.
However, in China, Lenovo is
selling basic PCs in the same
market for as low as
Rs 9,650. These machines
are not available in India. 

3D PHOTO BROWSING

Microsoft
Unveils
Photosynth

Microsoft’s livelabs
were working on
the Photosynth

software from 2006. The
Photosynth software pools
together photos into
synths that generates 3D
panoramas of the same
subject. During the pre-
view phase, synths of the
NASA shuttle Endeavor and
the Piazza building at
Rome could be viewed. On
August 20, Photosynth was
released for the common
public, which allows users

to upload photos and cre-
ate their own synths.

To use the Photosynth
service, it is necessary to
download an installation
file from the Web site
(www.photosynt h.com) .
The installation has two
components, a browser for
viewing synths and a soft-
ware for creating the
synths.

The software works by
identifying common ele-
ments in a bunch of pho-
tos, and creating a virtual
three dimensional view of
the subject, and placing
the photos in the appropri-

ate positions depending on
the angle at which the sub-
ject was photographed.

The 3D content that is
generated is made up of
dots, and looks highly pixe-
lated, and rather grainy
but still manages to give a
clear picture of the subject.
The more number of photo-
graphs a user takes of a
subject, and in various
angles, the more accurate
will be the 3D generation.

The browser arranges
all the photos of a subject
in a 3D space and allows
users to browse through
them from their individual

points-of-view. The soft-
ware works for buildings,
works of sculpture, land-
scapes, small objects and
even people’s rooms. The
service is proving popular
with many synths contain-
ing upwards of a hundred
and fifty photographs
already up.

The software allows any
user to theoretically create
a complete 3D virtual
imprint of anything.
Currently, there is a 20 GB
upload limit for any user,
and the service is free of
charge. 

Once in a 3D environ-
ment, you can glide around
the environment in differ-
ent directions, smoothly
zoom in or zoom out of the
images, observe how the
photos were clicked rela-
tive to one another, and if
there is a large cluster of
photographs from a lot of
different angles, navigate
the 3D scene smoothly
with seeing very little of
the ‘generated’ and grainy
3D content.

A Round-up Of Technology News From Across The GlobeThe Digital World

IRAN
Nanotechnology
breakthrough by
Iranian scientists
reduces the toxicity
of medicine bases

BRAZIL 
The ministry has
adopted open
source Linux
systems for its
operations

CUBA 
Cubans work around
stiffling US embargo by
accessing the Net by
proxy through
Venezuela

UK 
Brit hacker who gained
access to NASA
computers loses appeal
against US extradition

NEW ZEALAND 
Doctors banned from
connecting iPhones to
citywide IT health
networks in Auckland

FRANCE 
Customers are irritated
over bandwidth restrictions
on the iPhone 3G by the
service provider Orange

JAPAN
Panasonic to
release televisions
with youtube
playing capabilities

Mozilla launches Ubiquity Mashup engine for information processing   n Google suggest goes live after four years in limbo

EGYPT
Egypt hopes to overthrow
Banglore as outsourcing
hub with an average of
18000 applications for
every position

CHINA
The iTunes store is banned
because of a song on
Tibet. Access is allowed
after the song leaves the
front page listings
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Photograph Achishek Mishra Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

TRADITIONS MEETS TECH

Pune To Have
Animation
Gurukul

Saurabh Gadgil, a jew-
eller from Pune seems
to be attracted to tech-

nology, and comes up with
ingenious ways to show it.
First came the setting up a
jewellery store in Sunnyvale
for the benefit of all the
Indians living in Silicon
Valley. His other brilliant
idea was to set up the
Seamless Education Academy
or SeamEdu which will con-
tinue the guru-shishya
parampara by teaching sub-
jects like Animation,
Broadcast Journalism and
gaming in a gurukul type
environment.

The students will live
communally, and leading
experts from all around the
world will be giving lectures
to the students. The purpose

of such a system of educa-
tion is to ensure that each
student gets the highest
quality of education at the
individual level. The courses
will be designed according to
the international standards
of the industry. The school
will be operational from
September 30, and the
school has acquired two
major studios in Pune. 

Anand Khandekar, the
chairman of the gaming and
animation wing of the
MCCIA (Mahratta Chamber
of Commerce, Industry and
Agriculture) will be one of
the members on the board of
the school. The school is also
looking to tie up with inter-
national universities, but
won’t be government funded
and will run as a private lim-
ited company. SeamEdu
hopes to capitalise on the
fast growing gaming, anima-
tion and broadcast markets
in the sub-continent and
hopes to enrol 2,000 stu-
dents by next year. While
there are no specific figures

available, the gurudakshina is
bound to be pretty hefty.  

ADAG LUNCHES BIG TV

HDTV In
India By
Year End?

Anil Dirubha Ambani
Group’s Reliance
C o m m u n i c a t i o n s

launched Big TV Direct to

Home television on August
15. There are now three
major players in India’s
DTH market: Zee’s Dish TV,
Tata’s Tata Sky and Anil
Ambani’s Big TV.

By all appearances, Big
TV seems to have a competi-
tive edge, with movie quali-
ty broadcasts using the
MPEG-4 technology, where-
as both Tata sky and Dish
TV are still using the MPEG-
2 formats. While both Tata
sky and Dish TV have 6

Last Month’s Winner!
No Winner!
(Doesn’t anyone like books anymore?)

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Puzzles For 
Programmers 
and Pros
by Dennis E. Shasha

Published by

n Faulty US voting machines have glitch that drops ballots   n FBI catches upto hacker who leaked tracks from the new

Digit Caption

On-demand computing
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exclusive movie channels
each, Big TV has a whop-
ping 32 exclusive movie
channels, but this feature
will not be as big an incen-
tive as it appears, because
the users have to pay for
everything that they watch.
The picture-in-picture view
(PiP) or multichannel views
in Big TV is 12, whereas in
the other two, there’s an
upper limit at 8. The audio
broadcasted across all Big
TV channels is CD quality.
Unlike Dish TV and Tata
Sky, Big TV will be broad-
casting all the sports chan-
nels available in the sub-
continent. Moreover, the
DTH service will have the
backing of Adlabs. 

Big TV matches or bet-
ters the competition in
other small features as well.
There are over 200 channels
available with the subscrip-
tion, 120 movies, and a
promise of a new movies
every fifteen days.

The best offer in terms
of pleasing the customers is
that any one of the avail-
able regional sections are
completely free.

The launch offer for the
service is Rs 1,490, which
includes 10 audio chan-
nels, 20 movie channels
free for 3 months, and one
regional pack.

There are various sub-
scription schemes ranging
from Rs 100 to Rs 475. 

The biggest advantage is
of course the DVD quality
images being broadcast. If
everything goes well,
Reliance plans to put up
eight to ten HDTV (High
Definition Television) chan-
nels by the end of the year.

BIG BLUE BUMPS FLASH
MEMORY

IBM Tests 4
Terabyte
Solid State
Array

IBM tested an array of 120
Fusion-IO supplied SSD
(Steady State Disks) with

a total capacity of 4.1 ter-
abytes. IBM is preparing
these arrays for use in indus-
trial computation, which
will tentatively be ready in a
year’s time. The system has
achieved a high data
read/write rate with a
response time of less than 1
millisecond. IBM has
achieved a data transfer rate
of over 1 million IOPS
(Input/Output per second).
Intel retails its X25E 3.8 TB
SSD array which achieves a
data transfer rate of 4.2 mil-
lion IOPS.

Solid State drives have
been around for some time
now in hand-held devices
like MP3 players and PDAs,
but their application for
industrial or personal com-
puting purposes have been
limited.

This is mostly because
the traditional hard drives
used to cost about one

fourth of the steady state
drives per unit of memory. 

There are however many
advantages of the steady
state drives, which have no
moving parts like a
read/write head or a platter.

This means steady state
drives can start up much
faster than traditional hard
drives, with no RAM or
flash requirements and
faster access to the data. 

There are a lot of limita-
tions of a SSD drive though,
apart from the cost. SSDs
are highly susceptible to
data loss, which can be
caused by power failure,
magnetic fields or stray
electrostatic charges, all of
which are common occur-
rences wherever SSDs are
likely to be used.

IBM is working on these
aspects of solid state stor-
age, and are increasing the
performances to make the
solid state storage solutions
reliable over long periods
of time.

As the higher IOPS
speeds are likely to be used
in places that have to access
large databases, the relia-
bility of the SSDs is critical.
IBM is testing the feasibility
of such operations. 

UNIQUE WEDLOCKS

Matrimonial
Sites Go
Niche

For a long time,
Bharatmatrimony.co
m and Shaadi.com

were the leading matrimo-

The Shiretoko is an early alpha
version of the next Mozilla Firefox

release. It is also known as the Gecko 1.9.1 Alpha, because it is
based on Mozilla’s Gecko layout engine. This version is available
for Linux, Mac and Windows systems for testing purposes only,
and everyone who uses it is expected to run into bugs and
report it to bugzilla. Once installed, Shiretoko looks exactly like

the Firefox browser, only there is a blue world icon without a
fox flying around it. There are some improvements in the
interface, and more control over themes and plugins, but no
drastic and apparent advancement. Although shiretoko
automatically installs all the firefox add-ons, some don’t install
at all, run sluggishly or crash the browser outright”which seems
to be the only major problem with Shiretoko.

Apache is the 
most used web 

server at 48.4% of 
all Web servers.

50% of all mobile
phones stolen are

made by Nokia

In 2007, Korea had 
the highest share
(94%) of households
with access to the Net

Guns n Roses album   n France plans to introduce USB train tickets   n Intel acquires Open Hand, Linux mobile developers

Shiretoko

In 2007, the
speed of Cable

Broadband
increased by 27%

30% of Internet
users in Finland

used the Net for
formal education

62% of UK
citizens have access

to digital
television
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for Atom   n Comcast, ISP in the US, will now set monthly cap on Internet use   n Lindsay Lohan calls father bully on blog

nial sites in India. A niche
market for individuals
with singular needs was
not recognised. While
these Web sites had broad
categories according to
religion or mother tongue,
other distinctions were
ignored.

While it was possible to
look for matches of a par-
ticular profession or how
fat their pay check was,
there were no matrimonial
Web sites that only catered
to people with a particular
need. SimplyMarry.com
was a step towards this
direction, recognising the
fact that marriages in met-
ropolitan areas were differ-
ent, and the country’s first
metrominal site was born.
This was a step in the direc-
tion of things to come.

Now there is a whole
ring of super-specialised
matrimonial sites,
BPOshaadi.com recognises
the needs of individuals
working in call centres and
plays matchmaker for
them.

This is godsend for
those people, especially

needs or abilities, which is
proving to be a big help to
the parents of such people. 

Now there is a space for
profiles to be put up which
would not be possible on
any other matrimonial
site.

If you are looking for a
match in a person who
works for the government,
or for matchmaking
between government
employees, there is
GovtShaadi.com.

While the marriages are
not as voluminous as the
other matrimonial sites,
these Web sites have
brought together a few cou-
ples, and judging from their
testimonials, they seem to
be really happy with the
portals for bringing them
together.

All these matrimonial
sites also make money
from wedding planners,
catering, transportation,
venues, music, lights and
photographers, by charg-
ing them a commission for
advertising their services,
as a convenience, to the
users of the sites.n

women who work night
shifts as this ensures that
their partners also have
the same shift timings. The
work habits are not a prob-
lem to the in-laws, and this
ensures that both the peo-
ple in the marriage are liv-
ing similar lifestyles.

There is also
BPOdating.com, which
caters to BPO employees
who are on the look out
for partners, but don’t
want to marry. Soon to
come is Phirvivah.com” for
people into their second
marriages, as widows,
spinsters and divorcees
will understand each
other’s problems better
and relate to the emotion-
al needs. Mangliks.com is a
site that lists only mang-
liks, which has a huge
market as 40 per cent of
Indians are Mangliks. 

Thirtyplusshaadi.com
is for people between thir-
ty to seventy, and there is a
section of featured brides
and grooms waiting for
marriage. 

SpecialShaadi.com is
for people with special

Cuil.com
What is Cuil?
Cuil is a search engine that
claims to have a database of Web
sites three times larger than
Google, and ten times larger than
MSN. Cuil is Irish for ‘wisdom’ or
strangely enough, ‘hazel’ and is
pronounced as ‘cool’. Cuil uses
relevance and content to sort the
search results instead of
popularity metrics, a large
component of which is based on
the number of inbound links.

Why the hype?
Cuil has positioned itself strongly
against Google, attacking the
search giant at where it is
weakest—the issue of privacy.
Cuil does not keep track of the
searches made by people, or
record their IP addresses. This
plays in with the fear that google
is slowly becoming big brother.
Cuil claims to analyse the Web,
not its users along with the
contradictory  claims of “size
matters” and “organisation is
fundamental”. Cuil has no
evidence to support its claim of
a larger search index.

Where does Cuil stand?
The search index is not really a
big factor in determining the
overall performance of the
search engine. Google has
recently claimed to have
crawled over a trillion Web
pages, although they have not
been indexed yet. Moreover,
Cuil’s column view, and much
longer site summaries are
nowhere close to the
minimalist, clean and simple
approach of Google.  

Who is in charge?
Not surprisingly, Cuil is managed
by many ex-employees of
Google. Anna Patterson, Russel
Power and Louis Monier are all a
part of the Cuil team and ex-
Google employees. The CEO is
Tom Castello—Anna’s husband.

How is the response?
Not too good. Cuil takes twice as
long to show up less than half as
many hits as Google. Moreover,
there are many complaints of
pornography showing up!
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Michael Browne

W e’ve come a long way—from mono-
chrome displays and complex
command line syntaxes to the (then)

revolutionary and simplified Start menu and
Windows Explorer courtesy Windows 95, to MS
Vista’s 3D Aero interface. As the adage
goes—technology changes everything. Today,
news updates are an RSS feed away, and you can
say goodbye to daily logins at www.cnn.com.
Stock, weather, travel, and even calendar
related data is all available as an active task
pane on your desktop and the computer has
become even more newbie friendly with utili-
ties built into the latest OSes and applications.
This so called interactive experience is taken to
the next level with content like 3D games, and
Blu-Ray movies—the new generation of enter-
tainment. The animation and graphics indus-
try, the world of cinema and content encoding
and security and encryption domain all cry out
for the next generation of computing hardware
to accelerate productivity, reduce latency times,
and satisfy our computing demands. The latest
hardware available is quickly brought to its
knees with taxing applications as developers
code their socks off to take advantage of the
extra oomph that a shiny new quad core proces-
sor or an 800 stream processor graphics card

provide. So the cycle of hardware development
continues. The main drivers behind this devel-
opment are games, 3D modelling and anima-
tion, and multimedia and interactive content
in general.

Memory is one of the performance enhanc-
ing components that enjoy a relatively longer
market life, as two or three processor genera-
tions may be based around a single memory
standard. For example DDR2 has been around
since Pentium days. There are two types of
memory in a computing system—main memory
(RAM) and video memory (VRAM), which is
present on graphics cards.

The acronym RAM is currently synonymous
with DDR2, but this wasn’t the case always.
DDR RAM was its predecessor, and DDR RAM
itself preceded by SD RAM. Now facing retire-
ment, DDR2 should soon be put to pasture by
one of our limelight hogs—DDR3. DDR3 is
already available for purchase, but it’s very
costly at the moment, owing to very low market
acceptance. Then there is the cost of a new
motherboard to consider, and DDR3-based
boards aren’t cheap. Other than the odd enthu-
siast, DDR3 at the moment is a largely un-
adopted technology, but that will change.
Industry experts believe DDR3 to become a
norm sometime early next year— when manu-
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facturers of this new technology will do suffi-
cient volumes to drastically reduce prices, and
faster DDR3 memory modules appear—which
will increase the (current) nominal perform-
ance advantage that DDR3 has over DDR2.
Intel’s upcoming Nehalem and their X58
chipsets will be DDR3 only. AMDs Sandtiger,
the successor to their Phenom processor range,
may also go the DDR3 way, but that largely
depends on Intel—the market leader. Intel
made DDR2 the success it was, and it seems
they’re going to lay it to rest soon as well.

The other newcomer we’re spotlighting is an
exciting new VRAM standard—GDDR5, and the
successor for the ageing GDDR3, which has been
around since GeForce 6800 Ultra / Radeon
X800XT days. But wait! Where’s GDDR4?
Defunct, largely, thanks to the industry having
taken a jump from GDDR3 to GDDR5. GDDR4
with its high latencies and comparable-to-
GDDR3-speeds is largely a no-go, and other than
the odd acceptance by AMD/ATi on their
X1950XTX and HD3870, has been largely left
alone. Both NVIDIA and ATI have tried all the
tricks to up memory bandwidth, which include
bumping up clock speeds and/or increasing the
bus width. GDDR3 has hit the MHz threshold at
2.4 GHz, and developing wider-than-256-bit
memory is very costly. Enter GDDR5—a new
standard that vendors like Qimonda (formerly
Infineon) and Samsung claim can easily hit
speeds of 5 GHz, while consuming less power—
no more than 1.5v at whatever speed. Add to
that extra features geared towards reliability
and you’ve got a sure shot recipe for a successor.

DDR3: In Pursuit Of 8 Lane
Expressways
DDR3 is being offered in the same 240 pin
configuration that DDR2 is available with, but
the two are incompatible and the physical
notches on the modules’ PCBs have different
positions to avoid mistakenly slotting of the
modules in incorrect slots. The first thing
that’s radically different about DDR3 is the
improved clock speeds—to the tune of 2000
MHz whereas the fastest DDR2 modules could
do no more than 1200 MHz. Its early days and
the speeds of DDR3 could go as high as 2400
MHz—an exciting prospect. Unfortunately
latency (wasted clock cycles) also increases with
higher clocks, and DDR3 has much higher
latencies than DDR2 which somewhat nullifies
the clock advantage. The increase in clock
frequency is possible because DDR3 has double
the prefetch rate than DDR2. The DDR3 core is
capable of prefetching 8 bits in a clock, while
DDR2 could only manage 4 bits per clock.
Doubling the prefetch is possible by doubling
the number of internal banks between the
DRAM core and the I/O buffer. This speeds up
things and further reduces latency due to paral-

lelism. While the advantages of DDR3 may not
be apparent at 1066 MHz (the current maxi-
mum official frequency for DDR2), at speeds of
1333 MHz and above, the newcomer should
start baring it’s teeth.

From the table above we see that DDR3 has
an improvement in clock speeds, data through-
put and power consumption, which (clock to
clock) should reduce proportionately due to
lower operating voltages. The BGA packaging
remains unchanged although DDR3 chips have
a higher pin count. These extra pins are mainly
for improving signal integrity at faster clock
speeds. Its highly undesirable, (a gross under-
statement), for memory modules to have
corrupt data in their buffers as a result of
signal loss—which itself occurs once clock
speeds are bumped up.

The architecture adopted by DDR3 is called
Fly-by and it features additional goodies like on-
module signal termination, and other flow
stabilisation commands—to aid data integrity.
Unlike DDR2s architecture where signals are
sent simultaneously, DDR3 follows a more
serial approach by sending signals sequen-
tially—one by one to the memory chips.
Therefore the internal working of DDR3
memory in terms of data reading and writing is
totally different from DDR2. This sequential
operation needs some sort of counter or timer
in order to link past, current and future opera-
tions that are based on the same process. The
solution—integrate such a sequencing device
on to the memory controller itself. This gives
the controller the ability to manage capsules of
data and match them to their relevant
processes. The technical term for this is called
Data Levelling. The signal protocols for DDR3
have changed too—as a direct result of the
much higher frequencies. These obvious differ-
ences mean that DDR3 RAM also has an
entirely new set of signal protocols to cope with
the higher memory bus frequency. 

64-bit operating systems mean greater
memory addressing capacities than before. This
combined with more bandwidth intensive appli-
cations dictates that memory density should
increase, and not just its frequency. With DDR2

DDR2 SDRAM DDR3 SDRAM
Data transfer rate 400-800 Mbit/s 800-1600 Mbit/s
Voltage 1.8 V + 0.1 V 1.5 V + 0.075 V
Banks 4/8 8
Prefetch 4 bits 8 bits
Burst Length BL=4,8 BL=4,8
Topology Conventional T Fly-by
CAS Latency 3-5 6-10
Chips packaging 60 BGA for x4/x8 78 BGA for x4/x8

84 BGA for x16 96 BGA for x16
Chips capacity 256 Mbit-4 Gbit 512 Mbit-8 Gbit

DDR2 VS DDR3
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we saw memory modules with up to 2 GB of
memory. Such modules use high density chips of
capacities of up to 128 and even 256 MB (each
memory module has either eight or sixteen such
chips). With DDR2 manufacturers promise as

much as 512 MB on a single chip, meaning a
module with a single bank of chips (chips on a
single side of the module) could have a capacity
of as much as 4 GB! We’ve heard of manufactur-
ers working on chips with capacities of 1024 MB.
Although double bank chips (16 GB on a single
module!) will be prohibitively expensive, and
will be a rarity, the prospect of seeing eight giga-
bytes on a single module is exciting. This would
also drive prices lower. 2009 should see a sharp
decline in DDR3 prices by our estimates—much
like DDR2 saw back in mid 2007. Faster, low
latency modules should also become available at
the price of slower modules, and the ones
already in the market will get cheaper. 2009
should be the time that users should migrate to
DDR3, as of now DDR2 hasn’t relinquished the
throne in terms of market popularity.

In terms of performance things are about
even, with fast, low latency DDR2 modules
competing hard with similar DDR3 modules.
Once 1.6 GHz and 1.8 GHz DDR3 modules become
de facto however, DDR2 will trail behind.

GDDR5—Speed Demon
After a hiatus of nearly 4 years, the world of
video memory is about to receive it’s much
awaited shot in the arm courtesy GDDR5. The
current norm, GDDR3, has done a great job. It’s
gone from a mere 256 bits and 1 GHz in the
GeForce 6800GT back in 2004, to a 512-bit 2.2
GHz part in the GeForce GTX280. However this
industry is all about change, and we’re seeing a
transition of sorts about to commence. We’ve
already seen GDDR5 make an entry in ATI’s

latest Radeon HD4870. The memory on this
card is built on a simple 256-bit bus. As opposed
to NVIDIAs GTX280 which has a massive 512 bit
memory interface. The aim of both vendors is
simple—more bandwidth. However, the
approach is radically different—NVIDIA uses
wider memory buses, ATI has gone with GDDR5
which has higher clocks.

ATI’s move makes sense because increasing
the bus width is no easy or cost effective task.
Each memory chip has to have more pins—this
leads to a larger chip—which leads to fewer such
chips per wafer (yes, memory chips are also cut
from silicon wafers). This drives up the cost,
which is why mainstream and budget graphics
cards usually have 128- or 256-bit memory inter-
faces. Even bumping up clock speeds doesn’t
help, as thermal thresholds are eventually hit.
GDDR5 is all about transmitting more data per
pin, (we’re talking about the pins on a BGA
memory socket), per clock. GDDR5 has the bene-
fit of requiring less power, and also fewer pins
which simplifies the manufacturing process.

So what does GDDR5 do radically different
from GDDR3 and GDDR4? First up, there’s an
exciting new feature called Clock Data Recovery
(CDR hereon) which is all about maintaining
clean signals while transporting data and thus
preserving data integrity. With CDR the data
stream itself generates the memory clock speed,
and not the memory controller. The bus
between the memory chips and the graphics
processor is actually trained or synced. In the
same way the command and address clocks are

also synchronised. For this reason this feature is
also sometimes called Interface Timing, or
Clock Training. The clock speed is actually
picked up and read from the data stream and
data and addresses and commands are adjusted
or de-skewed (the technical term for it) for best
possible data integrity. This is one of the new
features integrated into GDDR5 memory
modules to achieve higher clock speeds.

Traditionally GDDR3 and other memory
technologies have used a single write clock
(designated as WC) which transmits data and
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addresses as well as the read and write opera-
tions. GDDR5 makes use of two write clocks
instead of one. One clock called the differential
command clock (CK) is for data and addressing
and the other is called forwarded differential
write clock (WCK). The CK operates at half the
WCKs frequency, so if the CK is running at 1.5
GHz the WCK would run at 3 GHz. Each of these
two clocks gets a byte of storage each which
allows for alignment and synchronisation of
data to be stored during the initialisation and
training sequences—as explained in the previ-
ous paragraph. The data is synchronised on the
basis of the value stored in the bytes of each
clock. The concept of separating data and oper-
ations helps to minimise noise and jitter
thereby preserving data integrity at the higher
clock speeds that GDDR5 can do.

In conjunction with CDR and dual write
clocks, one of the new protocols introduced by
GDDR5 is error detection for read/write opera-
tions. Note we said detection, and not correction.
Error correction is not supported and a data re-
request occurs if an error is detected. This
boosts reliability except for one caveat—as the
memory is clocked higher, more errors will
occur—and the real world bandwidth may actu-
ally suffer as more and more instructions and
data need to be re-requested from buffers, in
case of an error. However with normal clocks
and moderate overclocking this feature should
help in maintaining signal integrity and there-
fore data integrity and system stability.

Hand-in-hand with performance, GDDR5
also has one noteworthy trick that helps in
power saving. It’s called Address And Data Bus
Inversion, and its main function is to reduce
the number of binary 0s which are transmitted
on both data and address lines. To achieve this,
a couple of extra pins are integrated on to a
GDDR5 chip—these pins are DBI and ABI pins
i.e. data bus inversion and address bus inver-
sion pins, and there are one each of such pins
for every byte (8 bits) of data.

In data and address buses, a binary one (1)
means a high voltage while a zero (0) indicates a
low voltage. In case more than 50 per cent of the
bits in a byte are low voltages (zeroes), this tech-
nology simply sends an instruction stored in the
DBI pin that essentially inverts the binary values
for that byte. So, ones become zeroes and zeroes
become ones. What this does is ensure that in

any given clock cycle, no block of data, instruc-
tions or addresses will ever have more than 50
per cent of its signal containing zeroes. This espe-
cially helps in those clock cycles where very little
data is being passed through memory—zero (0)
values because even in such cases some power
consumption still occurs.

And what makes GDDR5 really fast? Very
simply GDDR5 doubles the number of DQ links
or Data Queue links over predecessors like
GDDR3 and GDDR4, so at the same clock speed
it’s able to (theoretically) get double the band-
width. So while GDDR3 at 1 GHz had the data
effectively clocked at a speed of 2 GHz, GDDR5
runs the same data at and effective speeds of 4
GHz. Note that the core clock speeds of both
GDDR3 and GDDR5 are identical—its only data
transmission speeds that have changed. So at
the same clock speeds 512-bit GDDR3 memory
would yield the same throughput as 256-bit
GDDR5 memory, which is a tremendous cost
saving factor in favour of the newcomer.
GDDR5 is also being developed with higher
memory capacities in mind—so the density of
each memory chip is also higher than
GDDR3—this will further simplify the PCB
designs of graphics cards that use this new
standard as fewer memory data paths need to
be designed as fewer chips will offer the same
amount of memory. As of now GDDR5 will be
expensive to manufacture with only one real
outlet for the chips—ATI’s Radeon HD4870, but
both vendors (NVIDIA and ATI) should skip to
GDDR5 over the coming months. The allure of
reducing costs, better performance scaling,
and lower power consumption will ensure that
GDDR3 dies a natural death. It’s not a race
though—more like a relay, and the baton is
about to change hands.

The Future?
We’re told that DDR5—the RAM equivalent of
GDDR5 is also destined for the desktop some-
time in 2011, and its clock speeds could well
exceed the fastest processor clock speeds.
Obviously quad cores and even hex cores and
octal cores would probably be the norm by
then. One revolutionary product spawns
several others—just like Intel’s Core 2 Duo
made the DDR2 standard a runaway success as
people migrated from their old, slower Athlon
64/DDR systems. Graphics technologies won’t
stagnate as well, and aside from development
on new technologies like GDDR6, we can
expect to see a lot more stream processors on
the next generation of cards, and memory
management techniques will also evolve. The
thing to remember is that all this advance-
ment is very necessary and not just a race—soft-
ware and us, the users, are slowly evolving to
these new horizons. n

michael.browne@thinkdigit.com
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Agent 001

I’ve sort of patented a term here at Digit,
because I have the habit of saying “Ooh, I
want!” when I see a really cool or geeky prod-

uct. Anyway, long story short, the idea for this
article came about when my editor, getting a
little fed up of hearing “I want”, asked me, “So
what is it that you really want?” I was shell-
shocked. Why? You’d understand better if you
thought of my editor as a rich parent, and me as
a kid in a candy or toy store being asked that
same question. “Why, everything of course,”
was my reply.

After shaking his head for a few seconds and
making the dissenting noises only he can, he
reiterated, “No. I mean, what is it that you really
want from technology? For example, suppose
you owned every tech company on Earth; what
is the first product you will get everyone to start
building for you?” 

I just stood there, mouth agape. Obviously I
understood where this was headed, and I knew
exactly what he meant, but I was already far, far
away in fantasy-land, too busy building castles
out of hundred-dollar notes. Well it was his
fault for putting it that way, “owned every tech
company on Earth” indeed!

He snapped his fingers and promptly dragged
me out of fantasy world, “Well?” he asked impa-
tiently. After the cogs in my head were done
whirring, I said, “The perfect OS”. He turned,
walked away, and his voice trailed behind, “Write
it; about 2400 words; deadline next week...”

Why Not The World’s Fastest PC?
A lot of my buddies asked me why I didn’t think
of this. To be honest, I would like to be the first
person on Earth to run an 80-core, 10 GHz, 2 TB
RAM machine, but then again, what would I
run on it? Vista or Ubuntu? Hell no! What would
be the point of all that hardware if it gave me
not much of a difference in experience than
what my quad-core with 4 gigs of RAM and GTX
280 offer me already? 

It’s always been a lot easier for all of us at
Digit to criticise and complain about certain
missing features, or bugs in code. However,
while sitting and thinking of my “FutureOS”, I
realised how hard it is to come up with ideas
for those killer features that would set my OS
apart from everything else out there. Hats off
to all of the software and hardware developers
out there who bring us so many exciting prod-
ucts—if I was having such a tough time coming
up with imaginary features, imagine their
plight of having to not only think them up, but
implement them as well!

Coolness
Let’s face it; everyone seems to be gravitating
towards being cool-looking. Everyone associates
Apple with “cool”, and rightly so. Their MacOS
started the pretty-looking-OS revolution, and Linux
and Vista just seemed to have played follow-the-
leader. So now we have Aero and whatnot offer-
ing us fancy 3D effects for mundane tasks like
Alt-Tabbing—forgive me if I don’t faint like a
young girl at a Michael Jackson concert. 

Now I’m no Vista-hater, because I’m running
it, and without an anti-virus at that, for almost
a year without any problems. It’s quite obvious
to me that Microsoft coders have done an excel-
lent job with the security...well, either that or
virus and worm writers have all fallen asleep...

However, there are just some things I just
cannot seem to get used to. Take for example the
fact that I have to go through 2 or 3 screens just
to change my screen resolution, IP, gateway or
DNS server. All of this was just a click away in XP,
and sometimes you can’t help but want it back.

As for Linux, I’ve seen Beryl and
XGL/Compiz, and they’re just as pretty. Apple
has Aqua, and its animation effects are cute,
and personally, I prefer it to the rest because it’s
not so over-the-top as the others. However, all
this rush to make pretty OSes has me thinking
that we’re certainly headed down the wrong
path here. Personally, if you saw my system, you
would think it runs on XP, because I’ve got Vista
running without all the eye-candy. Does it really
matter to me that windows are not translucent,
or Alt-Tabbing doesn’t bring up cool animated
3D effects? It certainly hasn’t affected my work,
or the fun I have when using my computer.

What irritates me is the fact that some of my
relatives, who might still be using Windows 98 at
home, come over and want to see “Aero in
action”. It’s not the added security, it’s not the
robustness of the kernel...it’s the damn gimmicks
they like. Sadly, that’s the world we live in today,
where bling sells, and reliability doesn’t matter.
Thankfully, Windows 7 promises to not just bring
prettiness to the screen, but a revolution in terms
of interfacing with technology. Even if it isn’t the
best, at least it’s a step in the right direction. 

Interfaces
We’ve all being going ga-ga over the iPhone, and
with good reason too. Without getting into
debates such as whether the iPhone 3G is really
worth its price tag, especially in India—where
we’re sometimes struggling to get 2G services to
work satisfactorily—let’s give it the credit it
deserves for revolutionising mobile interfaces.
Similarly, Windows 7 promises to change the way
we interface with the common PC, by adding

Rather than sit
around waiting
to see what a
future operating
system (OS) will
offer, we’re
preparing our
own wish list.
Let’s just hope
that the powers
that be are
listening...

AN OS YOU WANT!
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multi-touch (the Microsoft Surface type), improving hand-
writing and voice recognition, and generally promising to
reduce your keyboard usage. However, is this enough?

In this space, we’ve previously told you about research
projects that promise to bring thought computing to the
desktop. Though this research is mainly targeted at
improving the lives of paraplegic patients, computers have
paralysed us all in some way or the other. We’re lazier
than we’ve ever been, and nothing is more appealing to
our vivid imaginations than computing at the speed of
thought. Besides, although touch is fun and might be
practical for some applications, speech just isn’t so.

If we were all computing while sitting in a nice serene
and silent corner of the planet, talking to your PC would not
seem as stupid an idea. Reality, however, has us computing
everywhere we are—while walking on the streets, travelling
by car, rail or air, in the loo, on our beds, at work, at play...
with all the noises of city-life about us, voice interfaces just
start seeming idiotic. As if researchers didn’t have it hard
enough, what with trying to compensate for accents and
pronunciations, trying to get a PC to recognise words over
the din of traffic, or the bustle of metropolitan life is just
near impossible. It’s also against human etiquette and sense
to submit to having to say, “Call mom” a few times to your
phone, whilst invading the sonic space of everyone around,
including yourself. For this reason, I personally don’t see a
future for speech recognition technologies in the OSes of the
future. Touch, yes; Thought, yes please; speech, no thanks!

Trends
A year or two ago, there were rumours about “Google OS”,
or basically, plans from Google to launch a complete
Internet-OS for those with always-on broadband access to
the Net. Today, we’re hearing rumours about Microsoft
Research working on a product supposedly called Midori,
which is a server-side OS, and basically will work just like we
thought the rumoured Google OS would. What’s more, it’s
rumoured that Midori aims to do away with platforms
completely, so you can run it on a mobile, a PDA, a
“netbook” (ultra-mobile PCs), desktops, and even as a
process on any existing OS... you get the idea.

Is this the way forward though? Although opinions, as
usual, vary from one extreme to the other, I personally think
that a Midori-like OS is a very vital component in the future
of OSes. Look at the trends, and you will get your answers.
Everyone and his uncle already has a mobile device. By 2012,
it’s estimated that we will have half a billion mobile users in
India alone. With flash memory prices falling, we’re getting
higher memory capacity gadgets and pen-drives. If 2 GB is
the norm today, by 2012, we should have TBs in our systems,
and at least 32 GB on our person at all times. Whether it’s a
flash drive, in your phone or your MP3 player, you will have
a lot of data storage capacity.

It’s already accepted that people in general, use more
than one device or computer. You have your work computer,
your mobile, computers you use in cyber-cafes, or your home
computer/laptop. It makes sense that you would carry your
data with you, and an Internet OS would let you do just that.
With more computing devices than people who use them, it
also makes sense to develop a digital persona, or an ID, so
that you can be you, no matter what device you use. For this,
obviously, you need an OS that’s platform independent. 
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Next is to understand how people use
computers, both at home and at work. If you
have a Net connection, you will find that, today,
the most important software on your system is
your browser. Regardless of whether it’s IE,
Firefox or Opera, which is your personal choice,
Orkut, Gmail, Google, Windows Live, Yahoo!,
Facebook, MySpace, YouTube, et al, are all
online, and you want to get at them. With
push-mail, your work e-mail is location inde-
pendent, and spreadsheets and presentations
are accessible in Google Docs. So what is it that
you really have to use your PC for? 

Gaming
Ah! Here we come to the first and biggest
hurdle in why the future of desktop OSes is not
bleak. With the majority of PC games being
built for Microsoft’s DirectX, it’s not hard to
see a Microsoft OS continuing to dominate.
However, consoles have also started selling like
never before, as people fed up with constant
hardware upgrades have opted for a gaming
experience on the PS3, Xbox or Wii. With more
of us getting hooked on to games, it stands to
reason that the OS we use will have to play the
games we like.

Anywhere Computing
Ambitious projects like the Alky Project
(fallingleafsystems.com), which wanted to make it
possible for DirectX games to run on Linux and
Mac, may have failed, but the effort was made in
the right direction. They’ve even made their code
open source, for people who want to continue
where they left off. After all, games developers
would like nothing more than to have their
games open up to Linux and Mac users. 

However, set aside thoughts of gaming, and
focus on everything else, and it’s really not that
hard to imagine an Internet OS, or even multi-
ple OSes that do only what they’re supposed
to—act as an interface between hardware and
software. Today, it’s not just Windows that tries
to be a one-stop solution for all your needs, as
Linux distros and Apple are also trying to do
exactly that. I’m not so sure that OSes should
try and offer all of that to us. For example, I’m
tired of the ever-bloating sizes of OSes—
Windows 95 shipped on floppies, and now Vista
ships on a DVD! Windows XP is my personal
favourite, because it seemed to offer not just
the right amount of security, but also a good
experience on mid-range hardware. 

A refreshing new concept is SplashTop,
which is a Linux distribution that motherboard
manufacturers are installing to an inbuilt
flash-chip on motherboards. What this means
for us users is that you can have ultra-low
powered systems that require no hard drives to
check mail or surf. ASUS, for example uses
SplashTop on motherboards that they brand as

“Express Gate”. OSes like SplashTop do away
with worrying about hardware requirements,
and instead of trying to be one-stop-solutions,
just let you connect to the Net and get your
work done. It’s also useful for notorious
fiddlers like me, because now I can trouble-
shoot problems in my primary OS installation
and download fixes for whatever I screwed up
in Vista while fiddling with settings.

FutureOS
Anyway, coming back to my quest, I need to list
what I would want from my “FutureOS”, so
here’s my wish-list:

Light and fast: Instead of taking ages to
boot, and hogging memory for services, I’d
rather have an OS that uses the same amount
of (or less than) resources as Windows XP.

Interfaces: Like I mentioned, touch is a
given, but I would love to have thought comput-
ing capability. Not much the OS developers can
do to give us this though, but let’s hope
research in this field is successful.

Portability: This is something that’s really
important, because I’d rather carry a pen
drive with me instead of a laptop, and I also
would want to have a familiar interface on all
my devices.

Server-side: GoogleOS (GooOS?) or Midori, if
they’re actually released would solve a lot of
problems for all of us. I’d love to have the same
Desktop, Documents, Favorites, and more, on
every device I use. This way I could log on,
check my mail, surf and then download stuff to
some virtual drive somewhere, just once, and
be able to access it from anywhere.

Application rentals: I use Adobe Photoshop
for about 2 hours a month when I need to edit
some images. Rather than have me wait to use
a designer’s computer, my company bought me
a license. It’s the same for many of us, with a
long list of applications. Let’s consider a Net-
enabled OS from, say, Google. Just as you have
advertisements in Gmail, I’d settle for adver-
tisements in GoogleOS, or a small subscription
fee, to allow me to use software such as
Photoshop for a few hours a week or month.
Plus, it would mean not having to install / unin-
stall applications, or have my system slow down
because I have too many things installed. 

Remember, this is just what I could come up
with based on my usage patterns—a lot of you
will have many more ideas for what FutureOS
should consist of. Make sure to write in and tell
us some of those ideas, and maybe together we
can convince developers to start working in this
direction. Some of you might even be develop-
ers yourselves, who can, or may already have
formed groups to develop software that will
allow us to experience OS-utopia. You too
should write in and inform us of your efforts. 

agent001@thinkdigit.com
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Maal
Drool

Avid Acutus
Thankfully, there are a few things in the
world that don’t have to be studded with
Swarovski crystals to make them the
dearer. The Acutus turntable from Avid
matches the expectations of the most
demanding audiophiles. The turntable is
available for $10,195 (Rs 4,46,366). The
turntable has been designed from scratch,
keeping in mind the audio quality and
playback without distortion, or interference
at all the time. The turntable is worked by a
powerful, carefully hand crafted motor,
designed to run silently and without
vibrations, driving a ten KG platter. The
whole turntable weighs about 30 KGs and is
available in two finishes, polished chrome
or plated gold. 

The Zombie
The Zombie Arcade gaming machine is a 100 KG of black
finished, chrome edged retro gaming goodness around 30 years
ahead of its time. The machine is designed for two players, with
led-lit microswitch buttons, and 2 sanwa joysticks. The machine
ships with 300 games including dig dug, galaga, mortal kombat,
sonic the hedgehog and the all time favorite—volfied.
Remember the irritating beeps and clicks music of volfied? With
the Zombie Arcade, you can listen to it from two ear level
speakers and a subwoofer at ground level for a “thumping
bass”. The screen is a 24-inch LCD protected with a smoked
glass bezel. If you want to put this thing in the corner of your
room (you’d be crazy not to)—your pockets will be lighter by
$4,400 (Rs 1,90,830).

QSonix Q110
QSonix is a company that deals in complete digital music management
solutions. Their latest offering includes a 17-inch touch-screen controller,
which is either a table-top or a wall mounted monitor. You can rip a CD and
play it at the same time, burn music without restrictions, transfer music from
a USB device or purchase music online using an Internet connection. The best
feature, is however, the massive one and a half terabyte storage space. In
case that did not register, the device has one thousand five hundred
megabytes of storage space. That’s 4,000 albums—if you rip them at highest
quality. If you compress them, you can store 25,000 music CDs.

Videoray Pro3XE
Videoray manufactures submersible
probes for a variety of purposes ranging
from forensics to scientific research. The
Videoray Pro ships with a forward facing
wide-angle color camera, a backward
facing black and white auxiliary camera,
two twenty watt halogen lights, an LED
array, two 60 mm propellers, sonar
capability and probe arms for handling
objects. The submersible weights 40 KGs,
can go upto 500 feet underwater and costs
$2300 (Rs 1,00,830). Strictly speaking this
is not a toy, but the recreation section on

their Web site has a few articles and
videos involving rich yachters

entertaining guests and kids with this
submarine contraption.

Archos 7
The Archos 7 Internet tablet is powered by a Arm Cortex
superscalar microprocessor, has a large 7-inch high resolution
(800x480 pixels) touchscreen and 160/320 GB of storage space.
The tablet supports most video, image and audio formats, as well as
the fully features Opera browser and a few games thrown in for
good measure. The tablet is basically meant for accessing
multimedia content on the Web, like YouTube, but can as easily be
used on Twitter or Orkut. There is also an e-mail application and a
bunch of customisable widgets. There are two inbuilt speakers and
a leg stand. The Archos 7 320 GB costs $550 (Rs 24,160).
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Must-
have 

Windows 
Mobile 

Apps
Get them now,

that's an order!

Aditya Madanapalle

Enhance

Data Backup
PIM backup is a free backup 
software from www.dotfred.
net. Contacts, call logs, 
messages, speed dials, tasks 
and other files can be backed 
up. It is possible to backup 
information from one device 
and restore it in another. The 
data is backed up in a .pib 
file, which is just a .zip file 
so some data can be edited 
on a computer. There are a 
number of data restoration options, like updating the 
data, adding only new data, deleting all existing data 
and making duplicates of the data. There are two format 
options for backing up the data, binary and text-based. 
The binary format is faster, but the text based format is 
easier to edit on a computer. There is also a setting that 
allows the data to be compressed, and a scheduler feature 
which backs up data automatically when scheduled.

PDF Viewer
The official pdf viewer for the windows mobile plat-
form is available for free from www.adobe.com/products/
acrobat/readerforppc.html. The viewer is a 13 MB down-
load. The reader optimises high quality PDF content 
for viewing on a Windows mobile device, with both a 
portrait and a landscape mode available. A full screen 
mode and a reflow toggle is included. There are two 
preset zoom options, the 
fit width and the default 
zoom, and a custom 
zoom option. The hand 
and the text selection tool 
are included. The various 
options available while 
creating PDF content are 
preserved when viewed on 
a windows mobile device—
for example any page tran-
sitions show up as well as 
attached slideshows.

Task Manager
vBar is a task manager for windows mobile devices 
available as a free download from http://vieka.com/
vbar.htm. The vBar icon locates itself neatly in the 
title bar, and has two basic options for closing appli-
cations—close all, and 
close all but active. 
The software itself is 
very small (21 KB) and 
has a small memory 
footprint as well. You 
can change the color 
settings, as well as the 
order in which the 
buttons in the menu 
appears. Another 
excellent feature is an 
option to show tiny 
bars indicating the 
memory and battery 
usage instead of the 
drop down icon.
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Web Browser
Opera has two browser options for windows mobile devices—Opera Mini, which 
works on most phones, and Opera Mobile, which is more feature-rich and meant 
for the windows mobile platform. The latest edition is the 9.5 beta version available 
as a free download from http://www.opera.com/products/mobile. However the previ-
ous stable version, v8.65 is also available from the site for US$24 (Rs 1,040). A user 
can save pages for offline view, save images into folders and upload data from the 
device onto blogs or e-mail. The menu bar is very simple, but feature rich—tabbed 
browsing, history and bookmarks are available. There are panning and zooming 
options, as well as a landscape mode. What makes Opera lightning fast is the auto-
complete feature, and an option to exclude images from being rendered.

Video Player
TCPMP or The Core Pocket 
Media Player is a free and 
open source media player 
for pocket PC that supports 
a wide range of formats. 
Think of it as the VLC for 
windows mobile devices. 

TCPMP can play audio, video and image files in 
even the more exoteric formats. The development 
of TCPMP was discontinued in 2007, but the installa-
tion file is still available on the Internet. The file is 
a 1.3 MB download, and can be obtained from http://
picard.exceed.hu/tcpmp/test. The video player is good 
as it is, but the optional plugins only make it better, 
and compatible with even more video formats. The 
plugins are available on the same page. Some of the 
advanced functionality of this player include chang-
ing the aspect ratio, and playback speed settings for 
changing the rate at which the video plays.

Cleaner
SpeedClean is a utility to 
clean up temporary files, 
temporary Internet files 
and cookies from your 
pocket PC. This freeware 
is from some people in 
France, and the develop-
er’s Web site seems to be 
down, but the software is 
available on www.tucows.com and a couple of other 
PocketPC download sites. This software purges files 
that are no longer in use from the system. For users 
who surf the Internet a lot from their windows 
mobile devices, this software can be configured to 
automatically detect and delete such unused files 
every time the device is started up.

Screen Capture
CECapture is a free screen capturing tool. It is a 
small file, only 54KB and can be downloaded from 
either http://freewareppc.com or http://classic.pock-
etgear.com. The utility works by placing an ‘E’ key 
on the task bar. Tapping it at any point will take a 
screenshot and save it as an uncompressed .bmp file 
in the My Documents folder. Another good screen 
capture software for windows mobile is called 
ScreenCap and is available 
from http://www.geocities.
com/nozomisoft/ScreenCap.
html. It is even smaller than 
CECapture at a modest 11 
KB. This software too saves 
captured images in the 
My Documents folder as 
uncompressed bitmap files.

Feed Reader
Stay updated with the latest news, blog posts and 
podcasts with ScreenyX RSS reader, available for 
download from www.freewarepocketpc.net or www.
mobiletopsoft.com. You can add as many feeds 
as you want, and most major feed formats are 
supported—including podcasts and vidcasts. The 
feeds are viewable either in a tree view or a ticker 
list. There is a 
portrait and land-
scape mode avail-
able. Splashnews 
from www.splash-
d a t a .c o m /s p l a s h -
news is another 
good feedreader, 
but is supported 
by tracked ads.
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Unzip Utility
EzyUnZip from http://www.
cnetx.com/ezyunzip is a 
461KB free download that 
can handle all the zip files 
on your Windows Mobile 
device. The interface has 
two styles, the soft-key 
menu for single-handed 

operation, and the classic menu for use with a stylus. 
It is possible to view the files in a zip archive without 
extraction, as well as selecting individual files for extrac-
tion. The general options include a check to attach all 
zip files to the program, which allows for a single 
key unzipping function. The more advanced options 
include Verifying integrity of the zip archive before 
unzipping, encryption support, displaying comments, 
and showing the compression ratio.

Activity Simulator
It is sometimes necessary to keep the device 
active and functional for long periods of 
time—while reading a tricky and in-depth 
document, or using the screen light to look 
for something. It is irritating if the back-
light goes off in the middle of something. 
Keepalive from http://www.scottandmichelle.
net/scott/cestuff.html or http://pocketpcfree-
wares.com is a 15KB download that simulates 
keyboard activity, and thus keeping the 
device ‘alive’. There is an ‘Application always 
enabled’ toggle, an option to turn it on or 
off depending on how much battery life is 
left, and a scheduler to turn it on at certain 
times of certain days. There is also a timer 
option to 
turn it on 
or off auto-
m a t i c a l ly 
after a set 
amount of 
time.

Notepad
MADE is a powerful text editor for the windows 
mobile platform. It is a 100 odd KB file avail-
able from www.freewarepocketpc.net or handheld.
softpedia.com. MADE can handle multiple files 
at a time, open really large files, and can 
handle a number of different formats. It is 
possible to edit HTML, CSS or XML files using 
MADE. There are also the usual cut/copy/paste 
features, with support of a large amount of 
data. The foreground colour, the background 

colour and the 
font are all 
customisable. 
The number 
of undos and 
redos can be 
c o n f i g u r e d 
m a n u a l l y . 
MADE can 
also load and 
save files in 
various 8-bit 
encodings.

Image Viewer
PocketCM Image Viewer from www.pocketcm.
com is an image viewer for windows mobile 
that uses the touchscreen functionality to its 
full potential. The software is designed to be 
used with the fingers instead of the stylus. The 
image occupies the entire screen, and all the 
options such as screen rotate, browsing, zoom-
ing and closing are available according to differ-
ent actions with the finger. The experience is 
similar to the image viewer on an iPhone. The 
entire interface has a very liquid feel, with a 

few bells and whis-
tles thrown in like a 
carrousel view with 
reflections. Also it is 
possible to entirely 
customize it, as it 
supports skins.
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In the last two years the personal tech-
nology space has seen tremendous 
growth both in terms of demand and 

in terms of variety. It pleases me greatly 
to see folks actually taking the time 
and patience to learn about the prod-
uct they want to purchase, instead of 
blindly making an uninformed purchase 
decision. Besides cell phones, PDAs and 
PMPs, if I were to pick one product cat-
egory that is hot, it’d have to be laptops. 
Many queries directed to me are from 
readers who wish to buy a notebook for 
a certain purpose, or based on a particu-
lar configuration. Students want some-
thing on a frugal budget that allows 
them to complete their assignments, 
surf the Internet, and take notes during 
lectures. Engineers want a configura-
tion that will allow them to run Visual 
Studio, or Java, and surf the Internet, 
or even play the odd game. Others may 
have specific requirements—like a good 
integrated webcamera to chat with loved 
ones abroad, or a notebook that plays 
3D games with most of the bells and 
whistles enabled. A large bunch of users 
are confused as to whether to even buy a 
notebook or opt for a desktop PC instead. 
Their confusion is understandable—a 
decent desktop PC can be assembled for 
Rs 25,000 or thereabouts, which is the 
same price at which you can pick up and 
entry level notebook. Users are even will-
ing to up their budgets and pay more for 
a notebook, their reason, notebooks are 

more of a lifestyle symbol (if not a status 
symbol), and they’re portable. It’s cool to 
be seen with a notebook, and the whole 
image of notebooks being expensive, 
drool-worthy devices takes your status 
to a whole new high. Even though lap-
tops are common nowadays they’re still 
viewed as a novelty by most people and 
this is one of the main factors behind 
their speedy adoption. Of course it’s a 
much needed tool for the business and 
executive cadre of user.

Regarding the whole desktop vs. 
notebook argument, I’m a firm believer 
in both devices. For me a notebook is a 
necessity when computing on the move, 
or attending a press conference to take 
down notes, or to communicate with 
office folk and access mails and such 
when a PC in unavailable. But when I 
have my desktop PC in front of me—my 
notebook is forgotten. Both devices are 
meant to co-exist peacefully, and home 
users should actually see whether they 
really need the portability of a notebook 
before buying one. In terms of perfor-
mance and ergonomics, a desktop is at 
least two times the performance of a 
notebook, my suggestion is to buy a note-
book only if you need portable comput-
ing. For someone who intends to use his 
computer on his desk every night after 

coming home from office, a notebook PC 
is a total waste—a desktop is much better 
suited for such tasks. I also recommend 
you skip the notion of buying a notebook 
just to be cool—it’s ludicrous.

A so called gaming notebook needs 
a fast graphics card, and implement-
ing such a graphics solutions into a 
notebook, where heat dissipation and 
product size are significant factors, is 
expensive—Rs 75,000 at least. I do not 
consider Dell’s XPS 1530 to be a gaming 
notebook—for one, the NVIDIA GeForce 
8600GT video solution in this notebook 
is strictly a low-end solution.

There’s a lot of confusion when it 
comes to notebook components, and vis-
its around the various electronics malls 
around Mumbai left me with one impres-
sion—a lot has to be done to educate 
consumers. Posing as a newbie I was 
surprised to see some misleading tactics 
used by even large vendors. For example a 
notebook with an NVIDIA GeForce moth-
erboard (GeForce 6150 chipset) had a bold 
sticker saying “NVIDIA graphics”. True, 
but to most users “NVIDIA graphics” or 
“Graphics by ATI” means an additional 
graphics card—whereas this notebook 
had just an integrated graphics chip. 
This was an issue with notebooks with 
ATI onboard solutions as well, and users 
wanting a graphics card should look for 
a sticker with the name of the graphics 
solution mentioned on it like GeForce 
8400GS or Radeon X2400 Pro. Most of the 
sales reps cannot help you either—and 
they’ll expound on the hard disk size, and 
choice of OS bundled when asked about 

differences between two similar 
looking notebooks, instead of 

talking about processors and 
memory. A notebook is a 

solution, not some-
thing you build 
like a PC, and 
considering that 
even I got misled 
at one point, its 

imaginable how 
first time buyers often get duped—wheth-
er intentionally or unintentionally on the 
part of the vendor. When looking at mod-
els, it’s important to get a hands-on feel, 
after all you need to use the device regu-

Shrikrishna Patkar

Agent 001
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My budget is under Rs 60,000, and I need a PC 
primarily for gaming and also 3D rendering, and 

multimedia usage. I already have a good UPS, LCD 
monitor and speakers. Please suggest a good PC. I also 
want a good DVD writer, power supply and cabinet. A 
CPU cooler is a must for me as I will overclock my CPU. I 
need at least 500 GB of HDD space. 

Yantesh Dhir

Dear Yantesh, a fast dual-core benefits 
gaming more, and a slower quad core will 

yield faster results in 3D rendering. I’m giving you 
two suggestions—one based on a Core 2 Duo, and 
the other on a Core 2 Quad. Here you go:

You’ll also need a good 90-mm fan for your 
CPU cooler. I suggest an NMB or a Panaflo medi-
um-speed fan, which will cost another Rs 600. Buy 
Artic Silver MX2. It’s a superior thermal paste to 
use when adding the heatsink to your CPU. Just 
clean both the CPU heat spreader and the contact 
area of the heatsink and put some of this thermal 
paste on both surfaces—ensure a thin layer.

I want to buy a DSLR, as photography is my hobby. I 
would like your advice on a suitable DSLR with a 

10-12 MP sensor, 1/4000 shutter speed and lithium bat-
tery. My budget is about Rs 15,000 to 20,000.

Pariza

Street prices of DSLR cameras are much 
lower than what prices are advertised by 

online stores. A Nikon D40x could well be avail-
able for under the Rs 20,000 mark in your locality, 
since I’ve seen the street price of this camera as 
low as Rs 17,000 (without a bill). The D40 would be 
lower in price, but availability might be an issue. 
These are the only two DSLRs within that price 
range. The Canon EOS 400D is priced at around 
Rs 26,000, and therefore out of your budget.

I want to buy a cellphone. My basic need is music 
with a good camera. It should also have proper 

functionality. My budget is Rs 10,000. Could you also 
suggest a suitable set of earplugs within my budget?

Shubham Mitra

I’d point you towards a Sony Ericsson 
K810i. It’s got a 3.2-megapixel camera, 

crisp screen, and great music quality. This phone 
is an older model now, but should be available for 
as low as Rs 8,000 (street price). For its price, it’s a 

Want a tech product, but 
don’t know how to go 

about buying it? E-mail 
agent001@thinkdigit.

com with your complete  
contact details, and 

he might answer them 
here! Please note that 

Agent001 only answers 
purchase-related 

questions in this space.

 Ask Away!

Ask Agent 001

beauty and excellent value for money. For ear-
plugs, look at the Creative EP630 for Rs 800 or so.

I have purchased an Intel E8400 processor, 
Cooler Master CM690 case and 500 W PSU, 

Corsair XMS 2 PC6400 RAM, WD 5000AAKS HDD, 
ViewSonic G90fB CRT monitor. However, I am unable 
to decide on the motherboard. I need the PC for basic 
tasking and such. However, at a later stage, I want to 
buy an 8800GT graphics card. Should I buy an 
onboard-solution based motherboard or a non-inte-
grated chipset with an add-on graphics card?

Ram Mohan

Firstly, why do you want to wait for the 
GeForce 8800GT? It’s already within reach 

at around Rs 10,000. The 9800GTX is available for 
Rs 12,000. Regarding your query, I recommend 
you invest in an Intel G33-based chipset solution, 
which will allow you to use integrated graphics 
till you get a discrete video solution. Look at 
Gigabyte, MSI or ASUS for brands. I don’t recom-
mend buying a cheap graphics card for now and 
then ditching it in favour of a faster card a few 
months later on. It’s a waste of money.

I’m going to buy a graphics card on a budget of up 
to Rs 13,000. Is ATI Radeon 4850 a good choice? 

It’s priced almost the same as the GeForce 8800GT. 
Which one is better, and which company should I look 
at? Is there a cooling solution for this card? Should 
I wait till such a cooling solution arrives?

Vishal Deepak

I recommend neither the GeForce 
8800GT nor the Radeon HD4850. The 

former is a slower card, and the latter, though 
faster, is a hot solution that can run up to 85 
degrees on load, and even more, if it’s not ven-
tilated properly, which makes me fear for the 
life of the card. NVIDIA’s GeForce 9800GTX is a 
solution that is more powerful than the 8800GT 
and cooler than the HD4850 by around 10-15 
degrees. Look for brands like Gigabyte, ZOTAC, 
EVGA, ASUS and XFX. Expect prices to be 
around Rs 12,000.

I plan to buy a desktop PC. My choices are either 
Compaq 3470 1L or Lenovo 5313 1BQ.  Are either 

of these is a good buy?
Jaswinder Kaur

Why not look at an assembled PC? 
You’ll get a better configuration for the 

same price. Among the options you men-
tioned, I suggest the Lenovo 5313 1BQ. The 
E7200 Core 2 Duo processor that this desktop 
has, is rather new and should get your job 
done, which by the way you’ve not mentioned 
(usage patterns). Please opt for 2 GB of system 
memory, and go with a single 250-GB HDD. I 
also recommend a 19-inch LCD.  

PC Config
Component My Suggestion(s) Price (Rs)
Processor Core 2 Duo E8500 / Core 2 Quad Q6600 9,000 / 9,600
Motherboard ASUS P5Q Pro (Intel P45 based) 9,000
RAM Kingston 4 GB (2 x 2 GB DDR2 800 MHz) 4,000
Graphics Card EVGA / ZOTAC 9800GTX 12,500
HDD Seagate 7200.11 500 GB SATA 3,900
PSU Corsair HX620W 6,300
Cabinet CoolerMaster CM690 3,900
CPU cooler Thermalright Ultima 90i 2,500
DVD Writer LG H55n 1,100
Total Rs 52,200 / 52,800

larly. For example a tiny keypad may be a 
hindrance for those with large hands, or 
maybe the keypad feedback may not be to 
your liking. The layout of the keys them-
selves is also important.

 Intel’s Core 2 Duo processor is the 
most widespread and 80 per cent of all 
the notebooks I saw had this family of 
processor. With falling CPU prices even 
entry level notebooks have given up 
the cheaper Celeron and Pentium Dual 
Core processors for the faster Core 2 
Duo. A few of the smaller notebook 
have also started featuring Intel’s Atom 
processor which is a highly power effi-
cient solution, and powers most tiny 
notebooks. AMDs Turion X2 (dual core) 
processors are also available, but in 
a very limited notebook models. The 
Core 2 Duo family is very large—the 
T5xxx series are suitable for regular 
office and Internet use PCs. The faster 
T7xxx series are suitable for multime-
dia PCs, although the newer T8xxx and 
T9xxx processors are faster and run 
cooler owing to the smaller 45nm fab-
rication process opposed to the 65nm 
fabrication for the 7xxx series. Unless 
you want to game or do audio/video 
encoding the T8xxx and T9xxx proces-
sors are overkill. The L7xxx are low 
power consumption processors at par 
with the T5xxx series for performance, 
and the U7xxx (ultra low power con-
sumption) are for those who want less 
processing power but more battery life. 
For memory, I recommend at least 2 GB 
for all users—notebook memory is dirt 
cheap. Gamers should look for around 
3 GB. Keep in mind that Windows 
Vista is memory hog. Also upgrading 
a notebooks memory isn’t as simple as 
upgrading a PC, so beware. Upgrading 
a CPU is even more tedious. 

In terms of usability, some note-
books offer tablet PC features. This basi-
cally means a touchscreen that can 
pivot and swivel. 

Most of the tablet notebooks are 
really compact i.e. 12.1 inch screen 
size—a plus, if size is a factor for you. 
If you’re looking for something really 
compact, there are a whole new bunch 
of notebooks from ASUS, MSI, HP and 
Acer which offer Intel Atom proces-
sors, one or two gigabytes of RAM, 80 
to 160 GB hard drives with exception-
ally small screens—eight to ten inches. 
These are very compact and lightweight 
as a result. However, if you type a lot, 
the keyboards on such compact note-
books may be somewhat cramped. For 
those looking for compact powerhouses 
with spacious keypads the 12.1 and 13.3 
inch categories are worth looking at, 
although Sony does have an 11.1 inch 
model which is also very compact. 

A 15.4 inch notebook is usually con-
sidered de facto for anyone looking 
at a notebook, although for me these 
notebooks seem bulky. I’d prefer a 14.1 
inch screen, which offers the same 
components at no added cost, but is 
lighter and smaller. For those looking 
at a large screen notebook (desktop 
replacement) and they don’t intend to 
cart it around, 17-inch laptops are also 
available, although most of these are 
quite pricey, simply because they have 
high-end configurations. Acer does have 
some non-standard screen sizes—their 
Aspire 6920 and 8920G (16 inches and 
18.4 inches respectively). 

You must remember that a note-
book is a consumer product, much like 
a plasma TV, or a home theatre system, 
and warranties play an important role. 
All brands offer warranties but you 
have to consider things like availabil-
ity of service centres, time taken to 
respond, the nature of the warranty 
and its duration, and even the quality 
of service. The latter point is something 
that existing consumers of that brand 
can share with you. All information is 
helpful in some way or another. 

Among the brands available I came 
across Sony, HP/Compaq, Lenovo, Acer, 
LG, Toshiba, Fujitsu and Dell. Dell 
is unique in certain aspects as they 
allow you to configure the laptop with 
your choice of components as well as 
buy preconfigured notebooks. If you 
know what you’re doing, configuring 
your own notebook is very beneficial, 
as you can opt for the correct combi-
nation of components.

HPs DV series and Sony’s Vaio are 
some of the most attractive looking 
notebooks around, although I felt HPs 
DV2000 and DV6000 series, (their mul-
timedia notebook series), are the most 
attractive with their satin smooth fin-
ishes and the great-looking artwork on 
the lids. The Compaq notebooks are 
priced lower than the HPs (in general) 
and the higher models sport the same 
slick finishes. These make good buys 
for someone on a budget. 

Some Sony Vaio’s are really beautiful, 
some are mediocre looking. Dell’s 
Inspiron series are available on display, 
but their XPS series, which offer high-end 
performance parts, aren’t. You’ll have to 
contact Dell India if you want an XPS 
notebook, and you can configure these 
on Dell’s Web site for their pricing. 
Lenovo’s ThinkPad series are very light, 
very well built, and targeted at business-
men, while their Y series are for home 
users. Fujitsu offers mostly business note-
books with charcoal grey finishes that 
may not attract—however, for the corpo-
rate fraternity, these are light and rug-
ged. LG has some nice looking notebooks, 
mostly finished in variations of white. 
ASUS is a surprise entrant for me, because 
they’re mostly renowned for their moth-
erboards and graphics cards. Nonetheless 
they have some really attractive, albeit 
highly-priced models. The table below 
lists the models I came across with their 
prices and basic specifications: 

agent001@thinkdigit.com

Notebooks At Malls
Brand Model No Screen Size Geared Towards CPU RAM HDD Price
Acer Aspire 1 8.9 inches Ultra Portability N270 (Atom) 1 GB 80 GB 22999
Acer Aspire 6920 16 inches Entertainment / Home T7300 3 GB 320 GB 49,999
Acer Aspire 8920G 18.4 inches Entertainment T7500 3 GB 320 GB 79999
ASUS U6SG 12.1 inches Portable T8300 2 GB 250 GB 92999
Dell Inspiron 1525 15.4 inches Workhorse / Home T7250 2 GB 160 GB 40900
Fujitsu S6510 14.1 inches Corporate T7500 2 GB 160 GB 80000
HP DV 6704 TU 15.4 inches Entertainment / Home T5450 2 GB 160 GB 39990
HP DV 2701TX 14.1 inches Business T5450 2 GB 160 GB 45999
Lenovo X300 15.4 inches Corporate U7100 2 GB 60 GB (solid state) 135000
Lenovo Y510 7758 52Q 15.4 inches Entertainment T2330 1 GB 120 GB 37999
Lenovo Y510 7758 53Q 15.4 inches Entertainment T5450 2 GB 160 GB 44999
Sony Vaio VGN-TZ37GN/R 11.1 inches Ultra Compact U7700 2 GB 120 GB 114900
Sony Vaio VGN-FZ35GN 15.4 inches Entertainment / Home T8100 2 GB 200 GB 59990

Agent 001
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Rossi Fernandes

No one would have ever 
thought that capturing 
memories forever would 

ever be this easy, and as cheap 
as this. Digital cameras have 
really come a long way, have 
taken photography from being 
an expensive hobby for some, to 
something that’s just a whole lot 
of fun. For that, they are in their 
own way a marvel. We receive 
cameras to test off and on, for 
our Bazaar section. Now it’s time 
to get cameras from all across the 
country for a showdown.

This year we have an excel-
lent selection of cameras that 
were sent by a large number of 
manufacturers—some of which 
we haven’t seen for a while. The 
cameras are of all shapes and 
sizes, with prices suitable for all 
kinds of soon-to-be buyers.

A lot has changed over the 
years. The shift of users from 
film to digital cameras has taken 
place smoothly, but a few still 
opt for film cameras. Today, cam-
eras are moving towards being 
simple and easy to use devices 
that need no prior knowledge 
or experience of using even a 
film camera. Then there are the 
caeras that have There are also 
cameras that stand out of the 
crowd by offering features that 
were considered “expensive”. 

Under Rs 10,000
Samsung S1060

The Samsung S1060 is an 
affordable camera under the 

Rs 10,000 price bracket. The cam-
era’s key features are the 10.2 
MP sensor and a 5x optical zoom 
lens. It comes with a 2.7-inch 
screen and the refresh rate on it 
is pretty good. The body and the 
buttons don’t feel right some-
how.  The user interface has no 
such issues and is attractive and 
practical.

Like some of the Samsung 
cameras we received, the S1060 
too has a guide feature to help 
rookie photographers through 
the features of the camera. All the 
other mandatory features expect-
ed by users are present as well.

In performance, it leads the 
pack of Under Rs 10,000 cameras 

by a fair margin. The quality in 
general is great, but the best 
impression one gets is by the 
zoom lens. A 5x optical zoom on 
a camera priced this low isn’t too 
common an occurence. What’s 
even more shocking is the qual-
ity of the lens. The camera gets 
some really impressive zoom 
shots with the lens. It’s so good 
at times that it puts some of 
the cameras from the higher cat-
egory to shame. It must be said 
that some of the colours turn 
out a little too saturated for most 
people’s liking, the flash can be 
too powerful and that isn’t neces-
sarily a good thing as it wipes out 
all detail.

Although camera resolution 
isn’t everything, a 10.2 MP cam-
era at less than Rs 10,000 was 
unheard of a year ago. If you can 
ignore the few quality and design 
glitches of the camera, and just 
want performance, you can’t go 
wrong with the Samsung S1060.

Samsung L100

The other Samsung in the 
Under Rs 10,000 category also 

comes in a rather boring shape 
and design. The trigger is pretty 
flat, and pressing it requires a 
little effort. The L100 is an 8.2 
MP camera, as compared to the 
S series 1060 model. The L100 is 
a very light camera considering 

We test 32 
of the most 

popular 
digital 

cameras 
on sale in 
India, to 

find which 
one suits 
you best

Samsung S1060

HOT
Shots

Photo: Jiten Gandhi
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that it uses Lithium-ion batteries 
instead of AAs.

The 2.5-inch screen has a lot 
of delay, and seems to run a 
very low frame rate. The interface 
menus are rather confusing as 
well. The guide mode for new 
users is available.

Like the S1060, the L100 also 
is equally impressive in the zoom 
test shots. Details of the ruler, 

the cloth and the watch are all 
pretty crisp. Macro shots too are 
average.

Canon PowerShot A470

The only Canon under Rs 10,000 
we received was the Power Shot 

A470. The shape of the A470 is a 
lot different from its other series 
of cameras, and this makes it look 
like a really ancient camera.

Its long and broad shape 
makes it a difficult camera to 

carry around, so a pouch or a bag 
is needed. The AA batteries also 
make it the heaviest of all the 
cameras in the category. There 
are no separate buttons for the 
zoom function, and it has to be 
operated by two of the direction 
buttons that are normally used 
to navigate the on-screen menus.

Accessing the playback mode 
requires turning a dial every sin-
gle time, which is really annoy-
ing. The user interface is a little 
boring, and it hasn’t changed 
a lot from previous versions. 
Features like face detection have 
been added, but others like image 
stabilisation would be a better 
addition to this camera.

Photos taken of outdoors look 
great. Although detail isn’t the 
best, the colours are very natural 
and one can depend on the Auto 
mode to do its job well. In the 
studio light shots, the colours 
look good, but the clarity isn’t 

as good as expected.  The camera 
is good for taking macro shots. 
Video performance isn’t great 
either. At 640 x 480, it can only 
capture videos at 20 fps which 
isn’t very attractive either.

Nikon COOLPIX L18 and 
Nikon COOLPIX L16

The Nikon COOLPIX L18 and 
L16 are identical cameras in 

many aspects. They were also 
very similar to the L10 and L11 
cameras we tested last year. The 
only prominent features separat-
ing the two are the resolutions 
of the sensor. The L16 is a 7.1 MP 
sensor where as the L18 is an 8 
MP one. The L18 and L16 both 
offer the minimum 3x optical 
zoom found on all cameras.

Most of the buttons are flat 
and have little travel in them. 
The trigger is a lot better in that 
aspect. The interface used also 
seems outdated. There are some 
other features like panorama 
assist which allow you to take 
panorama shots, and use the pre-
vious image as a reference point 
when shooting the next image.

With the rest of the hardware 
being the same, there is little 

or no performance difference 
between the two. The colours 
presented by the two cameras 
are pretty identical, and there 
is a bit of a yellowish-creamish 
colour tone to the test images. 
Both cameras produce even clos-
er results in the flash shot.

Olympus FE-330

The FE-330 is one of the entry-
level cameras from Olympus, 

but it still comes with a 5x opti-
cal zoom and an 8 MP sensor. 
Although it tries to look stylish 
with a metallic look, it still looks 
like an entry level camera overall. 
You get the same feeling when 
you operate the dials and buttons 
on the camera—which don’t feel 
anywhere near top quality.

The user interface is similar 
to other Olympus cameras, but 
this one feels a lot slower than 
the rest. The screen is decent for 
its price, but the preview images 
look like they lack quality. It 
could be because of the slow 
processor onboard this camera. 
The focusing on the camera is 
also noticeably slow. The camera 
isn’t short of any features and 
Olympus has still implemented 

the guide feature 
even on its entry 
level cameras.

A yellow 
tint could be 
observed in the 
studio lights 
setup shots, 
and the colours 
generally seem 
washed out. At 
maximum zoom, 
the details show 
up well, but 

there is still is some smudginess 
and grain visible. The flash is too 
strong as well.

Videos can only be recorded at 
15 fps at 640 x 480, which doesn’t 
do a lot for users who would like 
to shoot videos of special occa-
sions every now and then.

Fujifilm FinePix J10

The FinePix J10 from Fujifilm 
is a good looking camera for 

its price. The front, in fact, looks 
like one of the stylish compact 
cameras that are up later. The 
bezel around the screen is big. 
Instead, a larger screen would 
have added a nice touch to the 
camera. The software interface 
on the camera looks dated. 

With no zoom, photos exhib-
it average quality, and with the 
zoom, details are better distin-
guished, but the images still have 
a lot of grain in it. Outdoor pho-
tos are much nicer, but colours 
are a little saturated.

The Rest Of The Entry 
Level Candidates

Kodak also had their entry 
level candidate the Easyshare 
C713 sent across to us. It wasn’t 
impressive in any of the tests. The 
design was also rather boring, 
and it felt like a cheap camera. 
For someone wanting a really 
cheap camera, the C713 could 
be something to keep in mind. 
The biggest issue was the yellow 
colour tone seen in most of the 
images. The zoomed shots had a 
lot of grain in them too. 

A sole camera from Mustek 
was the MDC 530 which too 

Our primary test consisted of a well 
lit up test scene. The scene would 

have objects of all kinds on it. They 
would be items with many colours 
and shades, finely printed text and 
all kinds of patterns and textures. 
All these details and characteristics 
would later help in giving scores for 
the cameras. All the shots for all the 
cameras were captured under the 
same settings. A room was darkened 
for the purpose and the cameras were 
placed on a tripod so that the position 
of the camera wouldn’t vary a lot. The 
tripod along with the timed shots 
would mean there would be no shake 
in the camera while the scene was 
shot. All the test shots were taken on 
Auto as that would be the most used 
setting by majority of the users buy-
ing these cameras. A wide angle shot 
was taken with the studio lights put 
on and another with the maximum 
zoom used to test quality of the lens. 
Lights were turned off also to take a 
shot with the flash turned on to see 
how powerful the flash was. A macro 
shot was also taken with the lit setup 
to see how close we could get to the 

object and still be able to focus per-
fectly fine. 

The test shots from the test scene 
would be compared side by side at 
the 100% zoom level. Reference shots 
would be taken on a Nikon D200 which 
would be used to compare the photos 
taken by the cameras in the test.

The cameras were taken out of the 
test area to be used in everyday situ-
ations without the perfect lightning 
and the perfect scenario. Shots were 
taken outdoors, macros were used 
and some of the custom profiles were 
used.  As always, performance wasn’t 
everything. There are many other 
components that go into a camera 
other than just the sensor, the pro-
cessor and the lens. A lot of thought 
goes into designing the shape, the 
buttons, the mechanisms, software 
for the interface. For that reason, we 
also rated the cameras for the fea-
tures, build quality, ergonomics and 
ease of use.

The categorization of the lot
We received cameras of all possible 
kinds and obviously, they all couldn’t 

be compared to each other. Some of 
the cameras we received were as cheap 
as Rs. 3,000 and went up to as high as 
Rs 25,000. Cameras had to be sorted 
by prices as majority of the users are 
also most likely to buy a camera based 
primarily on their budget. We split 
them into three categories – Under 
Rs 10,000, cameras priced between Rs 
10,001 and Rs 16,000 and finally the 
cameras with no price limits – every-
thing beyond Rs 16,000. 

All the tests were done exactly 
the same manner but the final scores 
for each of the categories – features, 
design and performance were given 
different weightages depending on 
the group of the cameras. An entry 
level camera for example wouldn’t 
need to be the best performer, instead 
added features would be also of more 
importance to the user. On the cost-
lier cameras, performance is usually 
found so design and quality of the 
camera itself would be more impor-
tant. The mid-ranged cameras priced 
between Rs 10,000 and Rs 16,000 
would have to be a good mix of both 
features as well as performance.

  How We Tested

Samsung L100

Canon PowerShot A470

Fujifilm 
FinePix J10

Nikon COOLPIX L18 Nikon COOLPIX L16

Olympus FE-330
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was tested last year. The MDC 
530 was a 5 MP camera with the 
same features.

Although it lagged behind 
in quality in a majority of the 
tests, the zoomed photo test 
showed good quality. The reds 
in the shots weren’t reproduced 

well—in the test shots, red items 
looked more orange than red. 
There were some issues with 
the MDC 530. It only had an 
ISO range between 50 and 200, 
whereas most cameras had a 
higher range—64 to 3200 in 
some. A low range ISO range 
means a camera won’t have 

enough intermediate steps to 
switch to get the right balance 
between exposure and grain in 
a photo.

TECH-COM sent us a few of 
their cameras from last year’s 
test—the DSC-524X PLUS, the 
DSC-520 and the DSC-601.

The DSC-601 lacked an optical 
zoom altogether and the macro 
shots and zoom shots were 
appalling when used with the 
only zoom available – digital.

The other TECH-COM’s were 
a lot better. Although they were 
around 5 MP each, they per-
formed alright. 

In the DSC-524X PLUS, there 
was massive purple fringing 
visible on the bright shots. 
Both the cameras were easy to 
take macro shots with, but the 
details were smudgy.

The design and body wasn’t 
as sporty and interesting as the 
other contenders in the group. 
The same was the case with the 
DSC-520.

The photos taken on it had 
jagged edges and the photos 
seem to be sharpened by the 
camera. Zoomed outdoor pho-
tos show details being blended 
together to create patching pat-
terns—which is certainly not 
acceptable. 

Rs 10,001 to Rs 16,000

Canon PowerShot SX100 IS

Canon’s PowerShot SX100 IS 
looked like a compact cam-

era on steroids because of its 
form. It looks like any other 
camera, but larger. The SX100, 
as we’ve seen on previous occa-
sions, has a mighty 10X zoom, 
and tries to go head-to-head with 
ultra zoom cameras. 

The button layout is differ-
ent, as is the  design. They are 
larger, well labelled and all these 
details make using the interface 
very easy. A scrolling dial is used 
to browse through the controls 
instead of directional buttons. 
There is also a playback button—
previewing images is easier than 
on a camera where you have to 
use a dial or a knob.

Although the unique design 
is great, the quality isn’t as top 
notch as the IXUS series, for 
example. The scroll wheel men-
tioned earlier, as well as the but-
tons seemed a little wobbly and 
loose. Despite its size, it lacks 
an eyepiece and the flash won’t 
pop open by itself. Manual focus-
sing is a great feature to have in 
a camera like this, and the dial 
used to control it is accurate.

The detail and 
clarity in wide-
angle shots and in 
the lit scene test 
shots is a tiny bit 
better than the 
other good Canon 
in this category—
the A720 IS. The 
powerful lens on 
the SX100 shows 
better detail in tele-
photo shots. The 
SX100 is also bet-
ter at taking macro 
shots. Focussing is 
instantaneous and 
you can get unbe-
lievably close to the 
objects. Video qual-
ity is decent too 
but the colours are 
a bit too saturated.

A larger screen 
in place of the 2.5-

inch one provided 
would be better suited to some-
thing this large. It is clearly the 
best of the lot, but there are a few 
things to keep in mind with the 
SX100. Its massive zoom means 
that there are larger mechanisms 
involved, and because of this the 
size of the camera has gone up. It 
isn’t very comfortable to hold in 
your hand and cannot be shoved 
into a pocket. At 265 grams, it’s 
not exactly light either. 

Canon PowerShot A720 IS

The Canon PowerShot A720 IS 
is geared towards users who 

want an easy to use camera, 
which can on occasions be used 
for more advanced photography. 
The A720 IS is an upgrade from 
the previous A710, which we 
know was a great camera.

There have been a few 
upgrades since then, but the 
6x zoom isn’t one of them. It 
now sports an 8 MP sensor, and 
there are a few changes in the 
ISO ratings supported by the 
camera at the higher end. This 
should mean improved flexibil-
ity in low light scenarios.

Unlike the 
SX100, the A720 
IS is a little more 
m a n a g e a b l e 
when it comes to 
its bulk. The body 
is better built 
and holding it is 
a lot easier. The 
body is shaped 
and design to 
look a lot more 
casual and users 
are bound to love 

the A720 design over the SX100. 
The use of a slider to switch 
to playback mode is annoying. 
The A720 has the manual focus 
feature found on the SX100 and 
some other Canon cameras.

In terms of quality, it is equal-
ly behind the SX100 as it is ahead 
of the A590 IS. Last year the 
A570 IS was one of the lead-
ing performers in the test. The 
A590 IS which is supposedly an 
upgrade to the A570 IS is not as 
impressive as expected. The A720 
is pretty close to the SX100 in 
quality all throughout, but lags 
a bit behind in the zoomed test. 
Images turn out a little too soft 
losing some detail, whereas the 
SX100 stays sharp all throughout 
its 10x zoom.

For a lot less, Rs 12,995 to 
be precise, users can still get a 
very good 6x optical zoom while 
not having to sacrifice on a com-
pact design and build quality. 
The A720 isn’t lacking anything 
much other than the zoom on 
the SX100 though.

Canon Digital IXUS 80 IS

The Canon 
Digital IXUS 

80 IS is a cam-
era very similar 
to the slightly 
superior IXUS 85 
IS. It brings along 
a decently built 
design for people 
on the move. 
There aren’t too 
many settings 
and controls to 
play around with 
on this camera.

It is made for users who want 
a camera that’s really compact 
to carry around—like a mobile 
phone of sorts.

One of the first issues is the 
battery door: as is the case with 
the IXUS 85 IS, the battery door 
here too feels weak and flimsy. 
Most of the interface design as 
well as the  frame design is iden-
tical. The big change is in the 
Megapixel rating—the 80 IS is an 
8 MP camera.

All the other Canon cam-
eras in this price bracket run 
on AA batteries, but the IXUS 
80 IS has a Lithium-ion bat-
tery . This, coupled with its 
compact design makes it a lot 
lighter than the rest. However, 
the shrunken size means it’s no 
longer chunky enough to hold 
in your hand as easily as the 
PowerShot series cameras.

Its overall performance isn’t 
bad at all. In just plain image and 
video quality tests, it lags behinds 
all the Canon cameras, but not 
the others. Macro shots aren’t as 
easy to take as with the SX100 IS 

or the A720 IS. In video quality, 
once again, colours are a little 
too prominent, but the exposure 
meter helps change the intensity 
of light instantly, and there’s not 
a lot of lag in lighting correction 
while moving from bright areas 
to dimmer ones. Overall, it’s a 
very good camera if you aren’t 
particular about pristine quality 
and manual controls.

Samsung i8

The Samsung i8 is a little larg-
er than the compact cameras 

from the other camera makers. 

Kodak Easyshare 
C713

Mustek MDC530

TECH-COM DSC-520

TECH-COM  DSC-524X PLUS

TECH-COM  DSC-601 

Canon PowerShot SX100 IS

Canon PowerShot A720 IS

Canon Digital 
IXUS 80 IS
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The detail in the design of the 
user interface and the body itself 
make it stand apart from the 
rest. We received a jet black one 
with a smooth glossy finish. This 
fancy looking camera is one of 
the lightest cameras in the cat-
egory. The i8 has a lens houses 
in its already compact shell, but 
still manages to contain a 3x 
optical zoom in it.

The outer body is plastic 
and it traps a lot of heat inside, 
which can get a little irritating 
especially when used for long 
durations. The menu on the i8 
is a lot better than some of the 
cheaper Samsung cameras we’ve 
seen. The icons and artwork used 
in the menus aren’t of the best 
quality. The camera tries to be as 
friendly as possible by giving you 
a few lessons, and helping via the 
camera’s interface. In some ways, 
it tries to be more than just a 
digital camera, and it is!

The i8 has a pretty decent 
PMP feature built into it, which 
allows users to read text files on 
it, view videos and play music 
on its 2.7-inch screen. Earplugs 
are provided with the camera 
for that purpose. There is even 
a tour guide feature which gives 
you a list of cultural sites from 
all around the world. A nice little 
fitting velvet-like pouch is sup-
plied along.

Features and freebies aside, 
we now focus on the perfor-
mance of the camera. It is bet-
ter than most cameras, but lags 
behind the cameras leading the 
mid-ranged segment. There is 
some unnatural colouration in 
the photos, and macro photos 
aren’t so easy to capture. Detail 
is maintained through the 

zoom levels. Video quality isn’t 
all that impressive. For just the 
design, quality of the body and 
ease of using the camera, the i8 
does well.

PowerShot A590 IS

The A590 IS is somewhat simi-
lar in design to the A720 IS. 

The A590 IS is an 8 MP cam-
era that comes with a 4x opti-
cal zoom and is also one of the 
cheapest cameras in the category 
at Rs 10,995. 

Build quality seems to have 
taken a hit too. The battery door 
seems a little wobbly and loose. 
The rest of the body looks and 
feels great. The mode selection is 
done using a really rigid dial. The 
user interface hasn’t seen a lot of 
change either.

The quality in general is 
decent and a little sharp. There 
is some grain all through the 
photos. There is no kind of colou-
ration in the images though. The 
video frame rate at 640 x 480 has 
been dropped to 20 fps which 
means you won’t get the smooth-
est possible video. For 30 fps you 
need to drop your video resolu-
tion to 320 x 240. If you wish to 
use the camera for video shoot-
ing purposes as well, then this 
is something to keep in mind 
before buying this camera.

Some of the old features are 
still there like the manual focus. 
It works great, is fun to use and 
is one of the cheapest cameras 
to feature this. There is also an 
Easy mode that lets you forget all 
about the settings you can use 

with the camera. Like many other 
manufacturers, features like face 
detection have been added to the 
list of features. 

Overall, it scores very close to 
the Samsung i8. It is kind of dis-
appointing to see a camera such 
as the A590 IS which should 
have been as good as its prede-
cessor the A570 IS. Fortunately 
for you, the prices for the A590 
IS are much lower too. If optical 
zoom holds no interest, then the 
A590 IS is a great photo taking 
camera to own.

Olympus Stylus 1010

The first impression that 
you get from looking at the 

Olympus Stylus 1010 is that it 
should be impressive. The hard-
ware specifications also seem 
impressive. A 10.1 MP sensor and 
a 7x optical zoom lens make up 
the 1010.

The camera is solidly built. 
The shape tapers from one side 
to the other. Right hand users 
will find the broad end makes 
this otherwise slim camera 
pretty comfortable to hold.  The 
buttons also feel great. In terms 
of build quality, it is the best in 
its category.

Olympus has put in some 
of the most impressive features 
that would be very attractive 
to a new camera user. It has a 
guide feature which gives you 
a list of things that you would 
like to do with the camera. 
Selecting it engages all the 
right modes and settings for 
you. There are even features 
that give the user a real-time 
preview of all the settings. This 
means you already get an idea 
of the kind of end result you are 
about to get—even before you 
click the photo. 

The interface is impressive 
too. All the menus are depicted 
and explained well. The opera-
tion of the menu is more like a 
phone in which you choose from 
menus going left and right. The 
screen is large and vibrant as 
well. The playback mode pres-
ents the photos in a very attract-
ing sliding manner.

All the features are great, but 
the same can’t be said about the 
quality of the photos it takes. It 
is an average performance by this 
sturdy camera through all the tests. 
In the test scene photos, there’s a 
little bit of colouration, and details 
seem a little blurred out. The flash 
was pretty overpowering as well.

It’s just one of more unique 
cameras that we’ve seen this year 
and if (and only if) it were equally 
good in performance, this could 
be one of the best cameras to 
own this year. 

Samsung L210

Samsung’s L210 is a 10.2 cam-
era with a rather uninspired 

design. It has a simple box design 
with buttons with little detail, 
feel and look to them. The cam-
era gives the impression that it 
is a cheap entry level camera. 
Zooming is done using an up-
down trigger on this Samsung 
instead of the left-right one used 
by most camera makers.

The screen looks OK but the 
refresh rates are poor. The user 

interface is sim-
ple with menus 
well spaced out 
and simple to 
use. The cam-
era can also be 
charged through 
the USB cable. 

There is a 
guide mode to 
help users to take 
advanced photos 
easily with the 
help provided. 

The camera can capture videos 
at resolutions of 800 x 592 but at 
20 fps. At 640 x 480, it takes 30 
fps videos. Videos are recorded as 
AVI’s using the XviD codec which 
makes the eventual file size 
smaller. The quality of the video 
and audio are both pretty good. 
Colours in the outdoors shots 
are also pretty sober. The quality 
of zoom shots in the studio light 
setup is good too. Details are all 
present. Flash photos turn out 
too saturated and there are some 
odd colours in the lit-scene shot.

Kodak Easyshare M1033

The M1033 is a 10.1 MP Kodak 
camera priced at around 

Rs 12,000. The camera has an 
auto feature that changes modes 
for the user. So if you get too 
close to an object, it switches to 
macro mode accordingly. This 
can be really useful for new 
users and for those who do not 
wish to keep changing settings 
modes manually. All the menus 
and options are kept as simple 
as possible. The interface is also 

designed with 
that in mind 
and the mini-
mal amount of 
buttons are put 
on the camera. 

The camera 
itself is compact 
and solid. The 
joystick planted 
on the camera 
is robust and 
a little hard to 
use. The camera 
supports 720p 
video recording 

at 30 fps, which is excellent for 
a camera. There seems to be no 
image stabilisation during the 
video recording mode which is a 
little bit annoying. The video is 
still very crisp. 

Kodak continues to add many 
scene modes to choose from. 
The M1033 is no different. It too 
comes with countless number of 
scenario modes. Overall, it seems 
like a better camera than the 
M1063. It is just Rs 1,000 more 
than the M1063, but it does a lot 
more...and it does it better.

The Nikon Group

The four Nikon’s from the 
Rs 10,000 to Rs 16,000 to be 

reviewed in this test were the 
COOLPIX S520, S52, S210 and 
S550. Each of the cameras other 
than the S52 was very similar to 
each other.

The COOLPIX S520 has a 
slightly noisy motor while it 
focuses. In many aspects, the 
S520 is very similar to the S550. 
It has a feature where favou-
rite photos can be selected for 
later use. The user interface is 
slow as well. Once photos are 
shot, the saving process takes a 
while too. The camera got aver-
age scores throughout the test 
but it still leads the rest of the 
Nikon cameras. 

The difference in quality 
wasn’t a lot different in all of 
the Nikon cameras. The S52 was 
next in line in performance 
behind the S520. The S52 has a 
sturdier body and is more styl-
ish and also built well. It is one 
of the best built cameras of the 

Samsung i8

PowerShot 
A590 IS

Olympus Stylus 1010

Samsung L210

Kodak Easyshare 
M1033
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class. The S52 also has a very 
impressive screen.

The COOLPIX S210 is a com-
pact camera with the propor-
tions as cell phone. It too is a 
little noisy like the S520. This 
is another solidly build camera 
much like the S52. In the zoomed 

shots, quality is 
fine. Colours too 
are fine except 
a few colours 
which seem paler 
than expected. 
There is little 
grain, but the 
exposure isn’t 
accurate either.

The Nikon 
COOLPIX S550 
– the last of the 
Nikon’s in the group has the 
largest optical zoom of 5x. There 
was a lot of noise in all of the test 
images. The S550 has a feature 
that keeps track of faces and has 
a database. That’s something not 
seen very often in cameras. The 
quality of the screen in general 
is average and the camera itself 
looks like a mix of the L series 
and S series from Nikon.

Fujifilm FinePix S5700

The Fujifilm FinePix S5700 is 
something like an ultra zoom 

camera, but it comes with 10x 
optical zoom. The camera has a 
deep handgrip for one-handed 
operation. It is far lighter than the 
ultra zoom or pseudo-SLR we got 
in this test—the Olympus SP-570 
UZ. The optical lens has a protec-
tive barrel around it, so the lens 
never protrudes out of the camera. 
The dials on the camera are made 
of plastic. Although the body itself 
feels light-weight, it uses 4 batter-
ies which make it heavier.

The screen is rather dull 
to look at. Like in some SLR’s, 
some of the functions have to be 
accessed by button combinations. 
This is something a new user 
won’t necessarily discover easily. 

Images from all the tests turn 
out grainy. Video recording works 
nice even though it records at 
640 x 480. Zooming works well 
while recording videos. The flash 
is extremely harsh.

The S5700 is approaching the 
end of its life, and is currently 
one of the cheapest cameras with 
a 10x optical zoom to buy at a 
price of Rs 12,999. A replacement 
is already on sale in some coun-
tries—the S5800.

Fujifilm FinePix Z100fd

The FinePix Z100fd from 
Fujifilm is a compact little 

camera with some serious style. 
The camera, for example, turns on 
by sliding the protection panel in 
front of the lens. It has a brushed 
metal finish to it and the illumi-
nated logo in the front adds to 
its elegance. It is compact and 
built well without compromising 
on style. The 5x optical zoom is 
impressive for a camera this com-
pact and that makes it more than 
just another device to show-off.

The clarity of the shots taken 
outdoors is average and lags 
behind the other cameras in its 
category. There is a little grain in 
the photos, but the colours seem 
a little too prominent and empha-
sised. There isn’t a whole lot of 
detail in the shots too. The zoom 
shots are pretty decent. Although 
the quality isn’t a lot better, there 
isn’t the same amount of dis-
tortion and smudginess seen in 
zoom shots in most other cam-
eras. The ruler in our scene was 
pretty crisp and the text was well 
defined in the zoom shot. 

There are nice little features in 
it as well. One of the more useful 
ones is where you can have the 
camera click two photos—with and 
without flash. That way you won’t 
ruin a photo if you have a low light 
scene. The image stabilisation fea-
ture works well. Buttons are small, 
but are designed well, and have a 
chrome-like feel and look to them.

The camera allows wireless 
image transfers, and there is an 
infrared port on the side for that 
purpose. Images can be sent to 
printers and even other cameras 

through infrared. The trimming 
can be done straight from the 
camera itself without to having 
to transfer images to a PC and 
then edit it there.

Kodak Easyshare M1063

The Kodak Easyshare M1063 
sports a compact design. The 

camera comes with a 3x optical 
zoom and a 10.3 MP MegaPixel. 
The quality of the design and 
feel isn’t up to the mark and this 
camera fails to impress. The user 

interface looks good and is simple 
to use. Videos can be recorded at a 
maximum of 15 fps which makes 
it not very practical. Overall, it’s 
an OK camera with a low price.

Wallets Unleashed! 
Cameras Over 
Rs 16,001

Samsung NV24HD

The Samsung is another 
unique camera that we got. 

Much can’t be said about its per-
formance, but what it does have 

Nikon S520

Nikon S52

Nikon S210

Nikon S550

Fujifilm FinePix S5700

is features. The 
biggest impres-
sive features are 
the touch sensi-
tive buttons lin-
ing the sides of 
the screen. They 
make operat-
ing the menus 
and all the set-
tings extremely 
simple.

The NV24HD 
not only sup-
ports HDMI 

but also HD video recording. It 
records videos at resolutions of 
1280 x 720 at 30fps. Videos are 
recorded using H.264 so a good 
amount of video can be stored as 
compared to some of the uncom-
pressed video formats used in 
other cameras. We shot a 1280 x 
720 resolution video tat was 25 
seconds long, and it took up only  
20 MB of space. The HDMI sup-
port means images can be viewed 
on large screens without a lot of 
quality loss.

As usual, there is one dial 
for selecting 
the modes and 
there’s another 
one that changes 
the coloration for 
the images. We 
fired test shots 
with all settings 
turned to Auto. 
It was clear that 
the quality was 
above average. In 
a category where 
all the cameras 

were so closely matched, the 
performance and a little bit of 
design was to blame for its low-
ered overall score. We awarded 
it one of the best scores for the 
video quality. With its great com-
pression, it also makes a good 
video recorder, and not just a 
digital camera.

For a camera with so many 
features, the design could be a 
lot better. The flash for example 
is just a simple cube that pops 
out from the top of the camera. 
The build however is solid and 
great. Sharp edges could leave 
scratches to its finish though.

A camera such as this is ideal 
for someone who wants to shoot, 
but doesn’t know how to get all 
the settings. The touch buttons 
definitely help in making things 
accessible.

Olympus Stylus 1030 SW

The Olympus Stylus 1030 SW 
has to be the toughest camera 

of the lot. Olympus claims the 
camera is all of the following—
shockproof, crushproof, water-
proof and even freeze-proof! It 
doesn’t look like they’re bluffing. 
The camera sports huge screws 
along its solid metal body while 
still maintaining its look and 
aesthetics. It does look a bit dif-
ferent from other cameras and 
also weighs a lot for its fairly 
compact size.

As compared to the other 
Olympus cameras, it is just next 
to the SP-570 UZ ultra zoom 
camera but is also cheaper by 
Rs 2,000. The performance as 
compared to the rest in its cat-
egory is a little lacking, but not 
by a lot. There was a tad bit of 
colouration in the test shots.

The camera isn’t all about 
its sturdiness. It also comes 
with the features found on the 
latest Olympus cameras. With 
shooting underwater in mind, 
there’s a small LED light that 
can be activated while using 
the macro function. Typically, a 
camera’s flash is too harsh and 
using it in such close proximity 
to an object ends up in terrible 
images. Another unheard of fea-
ture is the manometer on the 
camera to measure height and 
depth of the camera.

Fujifilm FinePix Z100fd

Kodak Easyshare M1063

Samsung NV24HD
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Olympus has some nice pre-
sentation while showing the 
slideshows and image previews. 
Even the Stylus 1030 SW comes 
with it. The user interface also 
is very similar to the MU 1010 
model. The camera, like a mobile 
phone, can be left on and used 
as a clock. The panorama feature 
that allows you to shoot and 
stitch multiple images together 
also works rather well. 

Although the whole camera 
is built like a brick, there are 
small design issues—the USB 
port door is a little dicey while 
opening, and clicks open sud-
denly. There is no better way to 
sum up this camera but to say 
that this would be the ideal cam-
era if you are the type of person 
who drops expensive gadgets 
from time to time into water or 
have them run over. 

Canon Digital IXUS 85 IS

The Canon Digital IXUS 85 
IS is the cheapest of all the 

cameras in the above Rs 16,000 
category. A part of the IXUS 
family of Canon cameras, the 
85 IS is compact like its other 
sibling the IXUS 80 IS. A light, 
but well-built camera, it has a 
rather plain design. It is com-
pact and something that will 

easily fit into a shirt pocket. It 
is also the lightest of the cam-
eras in its category. The door 
bay for the battery and memory 
card are a little flimsy and held 
together by a simple and some-
what weak mechanism.

Selecting modes is done by 
using a slider on the back. In terms 
of performance, it matches the 
Canon IXUS 960 IS, but manages 
to beat the Olympus Stylus 1030 
SW and the Samsung NV24HD by 
a decent margin. Although there 
is grain in the photos, detail is 
maintained all throughout. The 
zoom quality also is good, but 
the camera doesn’t quite judge 
the exposure accurately, which 
results in slightly underexposed 
photos. This is something seen 
in most other Canon’s. The flash 
shot is quite impressive. It is pow-
erful but not overpowering. This 
means the photos are well lit up, 
but without losing a lot of detail. 
Colour also isn’t affected a lot.

For those who want as many 
megapixels as they can, you will 
be happy to know that the IXUS 
85 IS is a 10 MP camera. The but-

tons on the rear 
are large and 

flat, so using 

them is no problem despite the 
camera’s small form. The user 
interface menus are also simi-
lar to most of the other Canon 
cameras. 

A little more zoom would have 
been nicer but as it is, it is already 
a very good camera in all aspects. 
A user who wants manual focus 
in a camera will be disappointed, 
and should look for one of the 
cameras in the Rs 10,001 to Rs 
16,000 category.  With a price of 
just Rs 16,995 it still manages to 
impress in all departments. 

Canon Digital IXUS 960 IS

If you thought the Rs 16,000 and 
above category was reserved 

for ultra-compact cameras, then 
you’ve guessed wrong. The Canon 
IXUS 960 IS is a slightly bulkier 
yet pocketable camera. The cam-
era has been moulded better than 
the 85 IS with a smooth finished 
metal body. This camera unlike 
the 85 IS a 12.1 MP one.

Like the IXUS 85 IS, the IXUS 
960 too showed up darker mages 
while zooming into the scene. 
The larger megapixel shoot also 
meant more grain. Image clarity 
also suffered a bit in all other 
test shots as compared to the 
IXUS 85 IS.

The 960 IS has touch sensitive 
keys on the rear for easy control. 
The screen is a little tiny with a 
thick bezel around it. The battery 
door is sturdier than the IXUS 
85 IS. The body, because of the 
material, also heats up a bit over 
time. Like the slider on the IXUS 
85 IS, the modes on the IXUS 960 
IS are changed using a small dial, 
and playback of the images can 
be done using a button instead 
of using the dial to switch to the 
playback mode.

This 12.1 MP camera with 
its quality comes at a price. It is 
also the costliest camera of the 
test at Rs 24,995. Like the IXUS 
85 IS, this too lacks a few man-
ual controls. Even though the 
overall scores in performance 
are pretty much the same as 
the IXUS 85 IS, and the features 
scores no different, the IXUS 960 
IS is dearer by Rs 8,000.

The Only Ultrazoom 
Olympus SP-570 UZ

While most buyers look for 
compact and fashionable 

cameras, there are the other few 
who want as much performance 
and features as they can get from 
a camera. These are the people 
who would look for a good D-SLR. 
The few irritating things that 

tag along with 
D-SLR’s, and the 
higher costs stop 
people from opt-
ing for one. 

This is where 
cameras like the 
10 MP Olympus 
SP-570 UZ come in 
to bridge the gap 
between compact 
point and shoot 
cameras, and D-
SLR’s. We’ve seen 
many such cam-

eras in the past. The Olympus SP-
570 UZ is one of the newer ones 
to hit the market. This is an ultra 
zoom camera that comes with 
an inbuilt 20X optical zoom. 
Olympus has tried to make this 
look and function as much as a 
D-SLR as possible. The body is the 
heaviest of all the cameras that 
we received, and is also one of 
the sturdiest. It is a little smaller 
than most D-SLR’s though, and 
uses 4 AA batteries to operate. Its 
bulk also makes it a little uncom-
fortable to hold.

Zooming is done using a ring, 
but it only acts as a controller 
for the motor moving the lens. 
The zooming is not as smooth 
as a D-SLR, and it can get a little 
annoying because of the delay 
and inaccuracy. Zooming into 
photos has to be done with one 
of the clicking-rotating dials. The 
eyepiece is a poor quality LCD 
screen. Everything else seems 

Olympus 
Stylus 1030 SW

Canon Digital IXUS 960 IS

 Contact Sheet                   Digital Cameras
Brand Company Phone No Email Website
Canon Canon India Private Limited 1800-180-33-66 info@canon.co.in www.canon.co.in 
Fujifilm Fujifilm India Pvt Ltd 0124-4325500 contact@fujifilmindia.com www.fujifilm.in
Kodak Digicom Technologies Pvt Ltd 9820510322 digicom@mtnl.net.in www.kodak.com
Mustek SHREE SAGARMATHA DIST. PVT LTD 011-26428541 techcom@airtelmail.in www.techcomindia.com
Nikon Nikon India Pvt Ltd 0124-4688500 nindsupport@nikonoa.net www.nikon.co.in
Olympus Olympus Imaging Corp 022-22854495/96 dsouza_anand@ot.olympus.co.jp http://asia.olympus-global.

com/imsg/digital_imaging
Samsung Samsung India Electronics Pvt. Ltd  011-41511234  jitender.c@samsung.com www.samsung.com/in
TECH-COM SHREE SAGARMATHA DIST. PVT LTD 011-26428541 techcom@airtelmail.in www.techcomindia.com

Canon Digital 
IXUS 85 IS
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Digicams - Above Rs 16,001

BRAND
MODEL NO

Canon
Digital IXUS 85 IS

Canon
Digital IXUS 
960 IS

Olympus
Stylus 1030 SW

Samsung
NV24HD

Price (Rs) 16,995 24,995 20,995 19,990

Plus (+) Excellent value for 
money

Good performance Tough build 720p video 
capturing

Minus (-) No manual focus Expensive Average looks Average 
performance

Grand Total (Out of 100) 61.27 61.10 57.05 58.83

Features (Out of 25) 16.21 15.84 15.76 16.85

Design (Out of 10) 5.25 5.45 7.00 5.90

Performance (Out of 65) 39.81 39.81 34.29 36.08

Features

CCD Sensor (Megapixels) 10 12.1 10.1 10.2

Maximum Image Resolution 3648 x 2736 4000 x 3000 3648 x 2736 3648 x 2736

Sensor Size 1/2.3” 1/1.7” 1/2.35” 1/2.3”

Optical Zoom 3x 3.7x 3.6x 3.6x

Digital Zoom 4x 4x 5x 5x

Autofocus 4 4 4 4

Manual Focus 6 6 6 6

Macro Focus Range (cm) 3 5 2 5

LCD Viewfinder Size (Inches) 2.5 2.5 2.7 2.5

LCD Viewfinder Resolution (pixels) 230000 230000 230000 230000

Dimensions (w x h x d) cms 8.6 x 5.4 x 2.0 9.59 x 5.99 x 2.76 9.36 x 6.09 x 2.13 9.85 x 6.1 x 1.89

Weight (gm) 130 165 170 145.5

ISO Setting 80 - 1600 80 - 1600 80 - 1600 80 - 3200

White Balance Settings (4/6)/ No of 
settings/Custom white balance

4, 5 4, 5 4, 6 4, 5

Shutter Speed Range (Min - Manual, 
Max - Auto)

15 - 1/1500 15 - 1/1600 4 to 1/1000 16 - 1/2000

Metering Modes 3 3 2 3

Self-Timer (If Yes time in sec) 4, 2, 10 4, 2, 10 4, 12 4, 2,10

Integrated Flash/ Ext Flash support 
(4/6)

4/6 4/6 4/6 4/6

Memory Types Supported SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

XD, microSD SD/MMC/SDHC

In-built Memory (MB) 32 (card) 32 (card) 14.7 16

Audio/Video-out 4 4 4 4, HDMI?

PC Interface USB USB USB USB

Best Video Capture Resolution 640 x 480, 30 1024x768, 15 640x480, 30 1280x720, 30

Battery Form Factor (If applicable) Li-ion Li-ion Li-ion Li-ion

Battery Charger Included 4 4 4 4

Face Detection 4 4 4 4

Image Stabilization 4 4 4 4

Design (Out of 10)

Comfortable To Hold 5.5 5.5 7 6

Menu Navigation Ease 5.5 5.5 7 6

Button Ergonomicity 5 5 7 6.5

Build Quality Of body 5.5 6 7 5.5

Build Quality Of movable parts (Memory 
& battery mechanism, Lens/USB Door) 

4.5 5 7 5

Performance (Out of 10)

Test Scene (Lights) 6.3 6.1 5.6 4.9

Test Scene (Zoomed) 6 6 5.5 5.5

Flash Shot Quality 6 6 5 4.5

Macro Performance 6 6 5 5

Video Quality 6 6.5 5 8

done well. All the buttons have 
the same chunky feel as a D-SLR. 
It even comes with a mount for 
attaching external flash units. 
Another unique feature that 
makes this camera special is the 
ability to dump images as RAW 
and RAW JPEG.

As far as performance goes, it’s 
not as extraordinary as we might 
expect—considering it’s a feature-
filled performance oriented cam-
era with a mighty 20x optical 
zoom. The test scene showed a fair 
amount of grain, but there was 
still a good amount of detail with-
out a lot of distortion. Colours were 
pretty neutral as well. The zoom is 
also very powerful and manages 
the exposure settings pretty well. 
Video quality is decent, but high-
definition resolution should be a 
necessity in a camera such as this.

Features such as face recogni-
tion, a calendar feature that sorts 
photos shot by the dates on the 
calendar. The expected priority 
modes for shutter speed, aperture 
as well as complete manual focus-
ing are also present. There is a good 
amount of flexibility in the ISO 
range as well—50 to 3200 at maxi-
mum resolution. Image stability is 
extremely important in an ultra-
zoom and the SP-570 UZ sports 
this for its humongous 20x optical 
zoom. It does a fair job too.

All these features and options 
don’t make the camera extremely 
complicated, but they are definite-
ly a little more advanced than 
most simple point and shoot ones. 
This makes a good stop-gap solu-
tion before a full-fledged D-SLR.  

rossi.fernandes@thinkdigit.com

Olympus SP-570 UZ

The Ultimate Performer
The Canon PowerShot SX100 IS 
is camera that is good at every-
thing. It comes with a large 10x 
optical zoom and can handle 
macro shots rather well. The 
camera also has great colors and 

maintains detail in photos at all zoom levels. Other than 
its bulk, there isn’t anything major to complain about.

If you are looking for something 
a little cheaper and a little small-
er, the Canon PowerShot A720 IS 
makes very good sense as well. At 
around Rs 3,000 less, the 6x per-
forms equally well in quality and 
the camera has the similar set of 
manual controls as the SX100 IS.

Ultra Compact Portable 
Camera
The Canon IXUS 85 IS is a camera 
worthy of being in your pocket all 
the time. It is also one of the cam-
eras that gives very good results 
without compromising on size. It is 

only a little bit more bulky than the Nikon COOLPIX S210 
which is one of most compact cameras around. The Nikon 
S210 is also a little cheaper and can be your second choice if 
image detail and quality don’t mean everything to you.

Video Shooting
For video shooting, it’s best to have a 
camera that shoots HD resolutions. 
The Samsung NV24HD is the perfect 
camera for HD video shooting. With 
H.264 compression support, it saves 
tremendous space. The camera also 

supports SDHC cards, so you should be able to use large 
capacity cards for long periods of video recording. Along with 
the HD video recording capabilities, you also get an easy-to-
use interface using the touch sensitive buttons. The price for 
the NV24HD is Rs 19,990. 

If the NV24HD’s high price is a 
little too much, then the Kodak 
M1330 could be an option to con-
sider. It is priced at Rs 11,999. The 
video quality isn’t as top notch 
as the NV24HD, but it gets the 
job done.

A Camera With The Largest optical zoom
If you have no interest in the size 
of the camera itself, then the 
Olympus SP-570 UZ is the camera 
for you. The 20x optical zoom will 
be more than enough for most 
of your needs. The price is also 
extremely low, as compared to buy-
ing a professional D-SLR, and then 
buying a large zoom lens for it.

The other option available, if you 
want a large optical zoom lens 
camera, is the Canon PowerShot 
SX100. It only has 10x optical 
zoom, but is does a good job. It 
is a much simpler camera to use, 
and can act as an all purpose cam-
era as well.

A Camera That Is Good value 
For Money
If your budget is around Rs 11,000, 
then the Canon Power Shot A590 IS 
makes excellent value for money. 
The camera is a lot cheaper than 
the Canon Power Shot SX100 and 
the A720 IS. At close to a third 

cheaper than the SX 100 IS, it still manages to give you 
most of the features, and almost the same performance.

If you are planning on spending more 
than Rs 16,000, then the choice is 
rather simple. The best performer of 
the class—the Canon IXUS 85 IS is also 
the best option for good value for 
money. It is the cheapest of the four 
cameras in its class.

The Cheapest Camera For 
Under Rs 10,000
The TECH-COM DSC-520 is a camera 
priced at just Rs 3,200. Although 
a little outdated and not as fancy 
or exotic as the more expensive 
cameras, it can still do a lot of what 
cameras priced close to Rs 10,000 

can. We’ve also had to award the DSC-520 a Best Buy award 
for the under Rs 10,000 bracket, for this reason. If you have 
a budget of around Rs 8,000, then you should skip this cam-
era and get the Canon PowerShot A470.

What Should You Buy?
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Digicams - Below Rs 10,000

BRAND
MODEL NO

Canon
PowerShot A470

Fujifilm
FinePix J10

Kodak
Easyshare C713

Mustek
MDC 530

Nikon
COOLPIX L16

Nikon
COOLPIX L18

Olympus
FE-330

Samsung
L100

Samsung
S1060

TECH-COM
DSC-520

TECH-COM
DSC-524X PLUS

TECH-COM
DSC-601

Price (Rs) 7,995 8,499 5,499 3,000 7,950 9,950 9,995 8,990 9,450 3,200 3,700 3,200

Plus (+) Good overall 
performance

Fairly stylish Inexpensive 7 MP 
camera

Inexpensive Well priced Cheap look and feel Decent build 
quality

Good zoom lens Great performance Inexpensive Average performer Lightweight

Minus (-) Outdated design Below average 
performance

Poor video record-
ing frame rate

Low ISO range Below average 
performance

Expensive Poor video 
framerate

Cheap body 
material

Blocky design No optical zoom Outdated interface Poor build quality

Grand Total (Out of 100) 45.57 41.75 39.45 36.45 43.88 44.73 43.77 46.58 47.30 37.67 38.27 33.12

Features (Out of 30) 18.74 20.67 17.87 16.80 20.28 20.63 20.21 22.10 22.49 16.66 17.99 16.56

Design (Out of 15) 6.83 6.83 7.20 6.15 7.35 7.35 8.18 6.98 7.43 5.63 5.40 5.18

Performance (Out of 50) 20.00 14.25 14.38 13.50 16.25 16.75 15.38 17.50 17.38 15.38 14.88 11.38

Features

CCD Sensor (Megapixels) 7.1 8.2 7 5 7.1 8 8 8.2 10.2 5 5.3 6.18

Maximum Image Resolution 3072 x 2304 3264 x 2448 3056 × 2292 2560 x 1920 3072 x 2304 3264 x 2448 3264 x 2448 3264 x 2448 3648 x 2736 2576 x 1932 2560 x 1920 2864 x 2160

Sensor Size 1/2.5” 1/2.5” 1/2.5” NA 1/2.5” 1/2.5” 1/2.35” 1/2.5” 1/2.33” NA 1/2.5” NA

Optical Zoom 3.4x 3x 3x 3x 3x 3x 5x 3x 5x 3x 3x N

Digital Zoom 4x 5.1x 5x 4x 4x 4x 4x 3x 5x 4x 5x 5x

Autofocus 4 4 4 4 4 4 4 4 4 4 4 4

Manual Focus 6 6 6 6 6 6 6 6 6 6 6 6

Macro Focus Range (cm) 1 15 13 6 15 15 3 5 1 NA 10 20

LCD Viewfinder Size (Inches) 2.5 2.5 2.4 2.5 2.8 3 2.7 2.5 2.7 2 2.4 2

LCD Viewfinder Resolution (pixels) 115000 153000 115000 115000 230000 230000 NA 230000 230000 NA 110000 115000

Dimensions (w x h x d) cms 10.48 x 5.51 x 4.07 9.1 x 5.5 x 2.2 9.10 × 6.57 × 3.73 9.1 x 6.19 x 2.7 9.5 x 6.1 x 2.95 9.5 x 6.1 x 2.95 9.77 x 5.77 x 2.33 8.77 x 5.63 x 2.0 9.88 x 6.3 x 2.56 9.6 x 6.2 x 2.75 9.99 x 5.54 x 3.52 9.55 x 5.22 x 2.97

Weight (gm) 165 110 137 140 125 125 123 114 160 90 140 90

ISO Setting 80 - 1600 64 - 1600 80 - 1250 50 - 200 64 - 1600 64 - 1600 64 - 640 80 - 1600 50 - 1600 80 - 400 100-400 100-400

White Balance Settings (Y/N)/ No of settings/
Custom white balance

4, 5 4, 6 4, 4 4, 5 4, 5 4, 5 4, 6 4, 5 4, 5 4, 4 4, 6 4, 6

Shutter Speed Range (Min - Manual, Max 
- Auto)

15 - 1/2000 8 to 1/2000 1/2  - 1/1400 1/2 - 1/1000 NA NA 4 to 1/2000 8 - 1/1500 15 - 1/2000 NA 8 - 1/1000 8 - 1/1000

Metering Modes 3 1 2 2 3 3 1 3 3 2 2 2

Self-Timer (If Yes time in sec) 4, 2, 10 4, 2, 10 4, 2, 10 4, 2, 10 4, 10 4, 10 4 4, 2,10 4, 2,10 4, 2, 10 4, 2, 10 4, 2, 10

Integrated Flash/ Ext Flash support (Y/ N) 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6

Memory Types Supported SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

XD/SD/SDHC SD/MMC SD SD SD XD SD/MMC/SDHC SD/MMC/SDHC SD/MMC SD/MMC SD/MMC

In-built Memory (MB) 32 (card) 8 16 12 21 21 20.5 10 17 32 32 32

Audio/Video-out 4 4 4 4 4 4 4 4 4 4 4 4

PC Interface USB USB USB USB USB USB USB USB USB USB USB USB

Best Video Capture Resolution/fps 640x480, 20 640x480, 30 640x480, 15 320x240, 20 640x480, 30 640x480, 30 640x480, 15 640x480 640x480 640x480 640x480, 24 640x480

Battery Form Factor (If applicable) AA x2 Li-ion AA x2 AA x2 AA x2 AA x2 Li-ion Li-ion AA x2 AA x2 AA x2 AA x2

Battery Charger Included 6 4 6 6 6 6 4 4 6 6 6 6

Face Detection 4 6 6 6 4 4 6 4 4 6 6 6

Image Stabilization 6 4 4 6 4 4 4 4 4 6 6 6

Design (Out of 10)

Comfortable To Hold 4.5 4.5 5 4 5 5 6 5 5 4 4 4

Menu Navigation Ease 5 4.5 5 5 5.5 5.5 7 4.5 4.5 4 4 4

Button Ergonomicity 4.5 4 5 4 5 5 5 5 5 4 3.5 3

Build Quality Of body 4.5 5 4.5 4 4.5 4.5 5 4 5 3.5 3.5 3.5

Build Quality Of movable parts (Memory & 
battery mechanism, Lens/USB Door) 

4.5 5 4.5 4 5 5 5.5 5 5 3 3 3

Performance (Out of 10)

Test Scene (Lights) 4.25 3.31 3.06 3.13 3.00 3.25 3.19 3.44 3.38 3.69 3.44 3.38

Test Scene (Zoomed) 4 3 3 4.5 3 3 3 4 3 3 3 1

Flash Shot Quality 3.5 2.5 2.5 2 4.5 4.5 2 3.5 3.5 3.5 3.5 2

Macro Performance 4.5 3 2.5 2 2.5 2.5 4 4 4 2.5 2.5 1.5

Video Quality 3.5 2 3 2 3.5 3.5 3 3 3.5 2 2 1.5

Digital Tools l Digital Camera Test
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Digicams - Rs 10,001 - Rs 16,000

BRAND
MODEL NO

Canon
Digital IXUS 

80 IS

Canon
PowerShot 

A590 IS

Canon
PowerShot 

A720 IS

Canon
PowerShot 
SX100 IS

Fujifilm
FinePix S5700 

Fujifilm
FinePix Z100fd

Kodak
Easyshare 

M1033

Kodak
Easyshare 
M1063

Nikon
COOLPIX S210

Nikon
COOLPIX S52

Nikon
COOLPIX S520

Nikon
COOLPIX S550

Olympus
Stylus 1010

Samsung
i8

Samsung
L210

Price (Rs) 13,995 10,995 12,995 15,995 12,999 12,499 11,999 10,999 11,950 14,950 14,450 15,950 13,995 13,990 11,990

Plus (+) Decent perfor-
mance and com-
pact design

Great value for 
money

Good value for 
money

Powerful zoom Good optical 
zoom

Attractive 
design

720p video 
capturing

Fairly large  
screen

Compact design Large screen Smooth framer-
ate on recording 
video

Fairly powerful 
zoom lens

Great build 
quality

Built-in PMP 
function

Good quality 
optical zoom

Minus (-) Average macro 
performance

Poor video 
recording 
frame-rate

Slightly heavy Bulky and aver-
age build quality

Heavy Below average 
performance

Average macro 
performance

Poor  
performance

Shabby macro 
performance

Slightly slow 
interface

Slow focussing Average screen Below average 
video quality

Heating issues Poor design

Grand Total (Out of 100) 52.31 51.82 56.67 59.22 47.31 45.15 49.32 44.64 48.11 48.45 48.96 47.06 50.76 51.93 49.83

Features (Out of 30) 18.56 17.42 18.32 18.17 16.91 18.20 19.32 17.79 18.36 18.60 17.46 18.21 19.31 19.53 19.73

Design (Out of 10) 5.25 5.45 5.65 5.35 5.50 5.05 5.10 4.80 5.90 5.70 5.10 5.45 7.15 5.25 4.15

Performance (Out of 60) 28.50 28.95 32.70 35.70 24.90 21.90 24.90 22.05 23.85 24.15 26.40 23.40 24.30 27.15 25.95

Features

CCD Sensor (Megapixels) 8 8 8 8 7.1 8 10.1 10.3 8 9 8 10 10.1 8.2 10.2

Maximum Image Resolution 3264 x 2448 3264 x 2448 3264 x 2448 3264 x 2448 3072 x 2304 3264 x 2448 3672 × 2748 3664 × 2748 3264 x 2448 3456 x 2592 3264 x 2448 3648 x 2736 3648 x 2736 3264 x 2448 3648 x 2736

Sensor Size 1/2.5” 1/2.5” 1/2.5” 1/2.5” 1/2.5” 1/2.5” 1/2.3” 1/2.33” 1/2.5” 1/2.5” 1/2.5” 1/2.3” 1/2.33” 1/2.5” 1/2.33”

Optical Zoom 3x 4x 6x 10x 10x 5x 3x 3x 3x 3x 3x 5x 7x 3x 3x

Digital Zoom 4x 4x 4x 4x 4.8x 5.1x 5x 5x 4x 4x 4x 4x 5x 5x 5x

Autofocus 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

Manual Focus 6 4 4 4 4 6 6 6 6 6 6 6 6 6 6

Macro Focus Range (cm) 3 5 1 1 1 9 7 10 10 4 15 10 2 1 5

LCD Viewfinder Size (Inches) 2.5 2.5 2.5 2.5 2.5 2.7 3 2.7 2.5 3 2.5 2.5 2.7 2.7 2.5

LCD Viewfinder Resolution (pixels) 230000 115000 115000 172000 230000 230000 230000 230000 230000 230000 153000 230000 230000 230000 230000

Dimensions (w x h x d) cms 8.68 x 5.48 x 2.2 9.43 x 6.47 x 
4.08

9.73 x 6.70 x 
4.19

10.87 x 7.14 x 
4.67

10.61 x 7.57 x 
8.07

9.2 x 5.57 x 1.98 9.37 × 5.78 × 
2.07

9.1 x 5.7 x 2.1 9.0 x 5.55 x 1.8 9.75 x 5.9 x 2.1 9.4 x 5.3 x 2.25 9.0 x 5.35 x 2.2 9.9 x 5.63 x 2.52 9.07 x 5.8 x 1.99 8.77 x 5.63 x 2.0

Weight (gm) 125 175 200 265 306 138 126 125 100 125 115 120 135 116 114

ISO Setting 80 - 1600 80 - 1600 80 - 1600 80 - 1600 64 - 1600 64 - 1600 64 - 3200 64 - 1000 64 - 2000 100 - 3200 64 - 2000 64 - 2000 80 - 1600 80 - 3200 80 - 1600

White Balance Settings (Y/N)/ No of settings/
Custom white balance

4, 5 4, 5 4, 6 4, 5 4, 6 4, 6 4, 4 4, 4 4, 5 4, 5 4, 5 4, 5 4, 6 4, 5 4, 5

Shutter Speed Range (Min - Manual, Max 
- Auto)

15 - 1/1500 15 - 1/2000 15 - 1/2000 15 - 1/2500 4 to 1/1000 4 to 1/1000 8 - 1/1448 4 - 1/1400 NA NA NA NA 4 to 1/2000 16 - 1/2000 8 - 1/1500

Metering Modes 3 3 3 3 3 1 3 4 3 2 3 3 2 3 3

Self-Timer (If Yes time in sec) 4, 2,10 4, 2, 10 4, 2, 10 4, 2, 10 4, 2, 10 4, 2, 10 4,2,10 4, 2, 10 4, 2,10 4, 2,10 4, 2,10 4, 2,10 4 4, 2,10 4, 2,10

Integrated Flash/ Ext Flash support (Y/N) 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6 4/6

Memory Types Supported SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

SD/SDHC/MMC/
MMCPlus/HC 
MMCPlus

XD/SD XD/SD/SDHC SD/SDHC SD/SDHC SD SD SD SD XD SD/SDHC/MMC 
Plus

SD/MMC 
plus/SDHC

In-built Memory (MB) 32 (card) 32 (card) 16 (card) 32 (card) 27 54 32 16 52 38 23 50 14.7 190 10

Audio/Video-out 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

PC Interface USB USB USB USB USB USB USB USB USB USB USB USB USB USB USB

Best Video Capture Resolution 640x480, 30 640x480, 20 640x480, 30fps 640x480, 30 640x480, 30 640x480, 30 1280x720, 30 640x480, 15 640x480, 30 640x480, 30 640x480, 30 640x480, 30 640x480, 30 800x592, 20 800x592, 20

Battery Form Factor (If applicable) Li-ion AA x2 AA x2 AA x2 AA x4 Li-ion Li-ion Li-ion Li-ion Li-ion Li-ion Li-ion Li-ion Li-ion Li-ion

Battery Charger Included 4 6 6 6 6 4 4 4 4 4 4 4 4 4 4

Face Detection 4 4 4 4 6 4 4 6 4 4 4 4 6 4 4

Image Stabilization 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

Design (Out of 10)

Comfortable To Hold 5.5 6.5 6.5 6 5.5 4.5 4.5 5 6 5 5 6 6.5 5.5 4.5

Menu Navigation Ease 5.5 5.5 5.5 5.5 5 4 5.5 4.5 6 6 5 6 7 5 4

Button Ergonomicity 5 5.5 5.5 5.5 5.5 5 5 4.5 5.5 5 5 5 7 5 4

Build Quality Of body 5.5 5 5.5 5 5.5 5.5 5.5 5 6.5 6.5 5.5 5.5 8 5.5 4

Build Quality Of movable parts (Memory & 
battery mechanism, Lens/USB Door) 

4.5 4.5 5 4.5 6 6 5 5 5 6.5 4.5 5 6.5 5 4.5

Performance (Out of 10)

Test Scene (Lights) 5.3 5.5 5.9 6.0 4.1 4.0 4.0 4.1 3.9 4.4 4.1 3.9 4.4 4.5 4.5

Test Scene (Zoomed) 4 4 4 5.5 3 3.5 3.5 3.5 4 3.5 6 4 4.5 4 4.5

Flash Shot Quality 4 4.5 5 5.5 3 3 3 3 4 4.5 5.5 3.5 3.5 5 3.5

Macro Performance 3.5 5 5.5 6.5 5 3 3 3 3.5 3 3.5 3.5 4 4.5 3

Video Quality 5.5 4 5.5 6 5 4 6.5 4 4.5 4 4 4.5 3.5 4.5 5.5
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Windows Rebooting With A Second 
Long Blue Screen

I have an an Intel motherboard (D101GGC) with 
an Intel Pentium 4 processor running at 3.06 

GHz, 1 GB DDR400 RAM, an XFX GeForce 8500 GT, a 
40-GB Seagate IDE hard drive and a 160-GB SATA 
Western Digital hard drive. I use Windows XP SP3, a 
Frontech 450 W SMPS and a Sony DVD writer. I have 
installed Windows in C: drive (25 GB) on the newer 
hard drive. I use an older drive as a complete 
isolated partition for saving my music collection. 
Problem is when I start my computer after Windows’ 
welcome screen, a blue screen flashes for a second 
with an error and then the computer restarts. The 
second time, it correctly starts and every thing is 
normal. I reinstalled XP, completely formatted my 
HDD, and also ran “sfc /scannow”.

But the problem continues. Please help me. I 
have Avast Home edition, Unhack me along with 
Windows Defender.

Anunay Sinha

The problem of rebooting with a quick 
blue screen is most likely a faulty Windows 

installation. Some Windows files may be 
corrupted. If reinstalling doesn’t help, back up 
your data to your other drives or partitions, 
format and then install Windows again. The 
blue screen would also occur if you installed 
any other new hardware such as a graphic card, 
and if there are conflicting issues with the driv-
ers. It could also be a faulty power supply.

Hard Disk Corruption Problems
I am facing problem with my hard drive. My 
system configuration is a 2.66-GHz Pentium 4, 

1.25 GB RAM, an Intel D101GGC motherboard with ATI 
Radeon Xpress graphics solution having 128 MB of 
VRAM, 80-GB Seagate Barracuda 7200 RPM and a 

Samsung DVD Writer. I have been running Windows 
Vista. My system has been off for around 30 days and 
I had kept it on sleep mode. After that, it ran well for a 
day. The other day, when I started Windows, it showed 
a problem with the Windows Sidebar. A message 
popped up saying Windows Sidebar is restarting. 
Immediately, the system restarted. Next, a black 
screen was visible with a message saying Unable to 
load winload.exe. A recent hardware or software might 
have caused the problem, insert Windows installation 
disk and repair. 

I tried the same, but while repairing, it was taking 
extremely long—around 1hr 45 min. At that time, it 
was searching for Windows on the system drive. I 
forced a restart and since then, it has been showing 
errors of boot failure insert disk. I tried to format the 
HDD with XP, but it showed an error saying unable to 
format, the volume might be corrupted. It had four 
partitions and shows C, D, E drives as empty with 
only F drive in use. Has my HDD crashed? Give me 
a solution. How much does a new drive cost, prefer-
ably an 80 GB or a 160 GB one?  

Shahnawaz Haque

It could be a hard drive crash. You should 
try connecting your hard drive to another 

system and see if you can recover the data. If 
nothing works, eventually try and use a parti-
tion manager and try removing all the parti-
tions from the drive and create new ones. The 
norm currently is a 250-GB or a 320-GB hard 
drive. Their prices start at Rs 2,500.

Slowdown After Uninstalling 
Software

I have a system with an Intel Core 2 Duo proces-
sor, 512 MB RAM, 160-GB hard drive with Windows 

XP running on it. A couple of months, I installed Vista 
Transformation Pack 6.0 on my PC. After a month or 
so, I uninstalled it through Add/Remove programs in 
the Control Panel. Since then, my computer’s perfor-
mance has decreased drastically. I doubt that the pack 
hasn’t been removed completely. How can I remove 
without formatting my PC? Please help!      

Mayank Nandwani 

The slowdown could be from some soft-
ware or drivers as well. If you think it’s 

E-mail us your comput-
ing problems along with 
your contact details and 
complete system  
configuration to 
sos@thinkdigit.com, 
and we might answer 
them here! Since we get 
many more mails per 
day than we can handle, 
it may take some time 
for your query to be 
answered. Rest assured, 
we are listening!

            Get Help Now!

All your computing niggles and nags 
are dealt with here!

Your Questions, Our Answers

CCleaner and Revo Uninstaller are standalone registry 
cleaners and software uninstallers.

the Vista transformation pack, try a stand-
alone application uninstaller such as Revo 
Uninstaller (www.revouninstaller.com) or the one 
in CCleaner (www.ccleaner.com)

Vista Crashing Periodically
I have an HP laptop running Windows Vista 
Home Premium. It runs on an Intel Core 2 Duo 

T5450 CPU, with 1 GB RAM and a 160-GB HDD.
Whenever I close a window, I receive a 

message “Explorer has stopped work-
ing”. After a minute, the explorer restarts and 
the desktop, sidebar and the Taskbar reloads. 
Please help me as computing has become very 
difficult for me with this problem. 

Jainesh Patel

It could be a problem with Windows itself. 
A Vista repair should be done to try and fix 

that problem. If nothing works, a reinstall with-
out formatting is worth trying.

Pen Drive Disconnecting Too Often!
There is a problem with my pen drive. 
Whenever I copy a file, it shows an error and 

gets disconnected and then reconnects. I can’t 
delete or even format. Is there hope? Help!

Deepak 

The problem could be with the hardware 
failing. It could be a loose connection 

with the USB connector as well. Make sure 
there are no files whatsoever on the drive. 
Use an application called Unlocker (http://
ccollomb.free.fr/unlocker/) to unlock any files 
on the drive.

Corrupted Outlook PST File
My PC Configuration is a 3-GHz Intel Pentium 
4, 1-GB RAM and 80-GB HDD. I use Windows 

XP Pro SP2 along with MS Office 2003.
 While using Outlook, it crashed. Now I’m 

unable to restore the Outlook.pst file and it gives 
me an error that the .pst file is damaged and it 
prompts me to repair the .pst file. 

I tried the SCANPST utility in Office 2003 
located in C:\Program Files\Microsoft Office\
Office12\Scanpst. While processing it, it gives an 
error message—Microsoft Office Outlook 2003 
Inbox Repair Tool. An Error has occurred, which 
caused the scan to be stopped. No changes have 
been made to the scanned file.

I have reinstalled Office 2003, but the prob-
lem persists. The Outlook.pst file is 1.96 GB. I 
have tried to restore this .pst file in another PC. 
Even there, I’m unable to restore. The same prob-
lem occurs.

Avinash Salian
Mumbai

The Outlook file was corrupted when 
Outlook crashed. The SCANPST file scans 

the file for any corruption. If the file cannot 
be fixed or accessed, use a third party appli-
cation such as Stellar Phoenix Outlook PST 
Repair (www.stellarinfo.com) or Advanced 
Outlook Repair (www.repair-outlook.com).

Power Supply Causing Crashes
I have a BFG Tech 9600 GT OC graphics card. The problem 
is that the power requirement is a minimum of 550 W. I 

have a 440-W power supply that results in random crashes. I 
would like to buy a better power supply. Should I settle for a 
650-watt supply? Please recommend a brand and the price.
My PC configuration is:
  Intel Core 2 Duo E6600
  1 GB RAM
  250-GB HDD
  Gigabyte D946DZis Motherboard.

Also, I would like to know of a TFT monitor with great view-
ing angle, below Rs 10,000 and a good joystick option, both 
wireless and wired.

Sarvesh Lad

If the power supply isn’t of a good make, then the 
440W PSU might actually underperform which could 

be causing all your instability problems. A Corsair VX450 
costs around Rs 3,600 and should be easily able to run your 

system configuration. If you plan on upgrading or adding 
more components, then there is also a HX520 and a HX620 
available, but these are priced considerably higher. Usually, 
19-inch widescreen monitors are all TN-based and they 
aren’t best known for viewing angles.

If you want a controller for racing games, a gamepad 
such as the Xbox 360 wired controller makes good sense. You 
can find it in the market at between Rs 1,400 to Rs 1,800.

A good 450W system is both a reliable and fairly inexpensive purchase

USB drives can throw up errors due to hardware or virus problems or 
even physical loose connections
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Checking e-mail has become a part 
of everyone’s daily routine. Gmail 

came as blessing for many giving users 
a free no-nonsense e-mail service with 
loads of free mailbox space. There have 
many innovative features that have been 
built around the e-mail service itself. 
One of the last few improvements was 
the inclusion of IMAP which seemed to 
have gone somewhat unnoticed.
 
What is IMAP? 
We’re all used to POP3 and Google 
has already given us that for free 
as well, so why should anyone now 
move to IMAP? IMAP does many 
things that POP3 doesn’t, and a lot 
of these features  make management 
of mailboxes much simpler. IMAP 
allows mails and their statuses to be 
synchronised with the server all the 
time. This means you can have multi-
ple clients from different locations 
getting an update of the mails. 

Enabling the IMAP feature on GMail 
Before you start with setting up 
Gmail’s IMAP on any of your devices, 
you need a Gmail ID if you don’t 
already have one. Login to your 
account and click on the Settings 
link on the top. Click on the Forwarding 
and POP/IMAP tab to change the 
settings. Click on the Enable IMAP 
checkbox on the bottom and click on 

the Save Changes button. With this 
done, Gmail is ready to provide you 
with its IMAP service.

Enabling IMAP on Outlook  
Now it’s time to setup an account on 
Microsoft Outlook for IMAP. We are 
using Microsoft Outlook 2003 for this 
purpose. It works the same on any client 
that supports IMAP, which includes even 
mobile device applications like Outlook 
for Windows Mobile. 

First click on Tools > E-Mail 
Accounts. Click on the Add a new e-
mail account radio button and click 
Next. Click on the IMAP radio button. 
Enter all the necessary information such 
as your name and Gmail e-mail address. 
You will need to enter the IMAP server 
address and the SMTP server for the 
outgoing mail. If you are using some 
other IMAP service or one provided by 
your ISP, enter that information here.

For Gmail users, enter the IMAP 
incoming server address as imap.gmail.

com and the outgoing server as smtp.
gmail.com. Enter the username for the 
account as your Gmail address in its 
complete form—yourgmailid@gmail.com. 

In the case of Gmail, additional 
security features need to be 
enabled and set. Click on the 
More Settings button for that. 
Click on the Outgoing Server 
tab and enable and checkbox 
for My outgoing server (SMTP) 
requires authentication. Set it 
to use the same settings as 
your incoming mail server.

Next, click on the Advanced 
tab. Gmail’s IMAP incoming server runs 
on port 993 so set it to that and the 
Outgoing SMTP server’s port to 465. 
Click the checkboxes of both the servers 
to enable SSL. Click OK when done.

Downloading and accessing the mails
When the settings have been put in 
place, Outlook or the mail client you 
are using will download the mail struc-
ture used on the server. In the case of 
Gmail, there are not any folders but just 

labels. New folders with the exact 
same labels on Gmail will be 
created in your mail client. You 
will notice that IMAP is initially 
slow as it needs to download 
mail folders and the topics in 
each one of them. Unlike POP3, 
all the mail isn’t downloaded 
together for offline use. It is 
continuously synchronised with 
the Gmail server.

Every change that you make 
in any client anywhere will be 
affected on all the clients simul-
taneously. This means, you can 
actually compose a draft on your 
local client and save it to the 

Gmail drafts folder, and you can send 
it anytime from any other computer 
or device. 

Folders in Gmail 
Gmail doesn’t use folders but it uses 
labels which are somewhat the equiva-
lent of folders in your mail client. New 
labels can be created through Gmail’s 
settings option. You can also create labels 
in Gmail by creating new folders within 
the IMAP folder on your local client. To 
dump mails into a folder on Gmail, set a 
label for the mail. Do this by clicking on 
the checkbox of a mail and clicking on 
the More Actions dropdown menu and 
selecting a label from there.

Gmail has loads of free space and 
this can also be used to backup all of 
your previous mails online. IMAP acts 
as an easy gateway to this. Simply drag 
and drop the folder from your mail 
client to the IMAP folder. Mails will be 
automatically uploaded to your Gmail 
account. You will never have to worry 
about losing your e-mail ever again.

rossi.fernandes@thinkdigit.com

Your Gmail everywhere and anytime….

How to – Setup IMAP for Gmail
Errors While Logging On To Windows

I use Windows SP2 on my system, but there 
seems to be a logon problem. Whenever I try 

to boot into Windows, it gives me an error “Could 
not load or run ‘c:\windows\inf\other.exe’ speci-
fied in the registry. Make sure the file exist on your 
computer. Please help me out with this.

Akhil Suryawanshi

The error is caused due to some kind of 
malware. Install an antivirus or spyware 

cleaner on your system. Temporarily, you can click 
on Start > Run and enter msconfig. Click 
Enter to launch the utility. Click on the Startup 
tab and select the entry for c:\windows\inf\
other.exe and uncheck it. Click OK.

New Folder.exe Virus Problems
I have a virus problem with my PC. A new 
folder.exe is created after I have plugged in a 

MicroSD card. How can I solve this problem?
Sourabh Singh

Your PC has been infected by a virus. The 
simplest way is to run an online virus 

scanner such as the one on Trend Micro’s site 
(http://housecall.trendmicro.com). If that does not 
work, download and run http://downloads.
andymanchesta.com/RemovalTools/
SDFix.exe. 

How Do I Install Windows On The 
ASUS EeePC?

I bought a new ASUS EeePC 4G. The configu-
ration is 512 MB RAM, 4 GB HDD, Intel (R) 

processor with Linux KDE operating system. How 
do I install Windows XP on it? Please guide me.

Ricky

The ASUS EeePC does not come with an 
optical drive, so the only way to install 

Windows on it, is through an external optical 
drive. You can also create an installer for a USB 
flash drive or a memory card and install 
Windows on the internal drive. 

Inbound Policy Violation
I use a Dell laptop with Windows XP SP2 and 
Comodo Firewall Pro. I connect to the Internet 

using a BSNL broadband connection. Often, Comodo 
Firewall blocks Net access due to Inbound policy 
violation. Here are the details:
Protocol: TCP incoming
Source: 192.168.1.1: 20329
Destination: 192.168.1.4: 2869
TCP flags: SYN

I don’t know if I’m right but I always thought that 
192.168.1.* is our own network. What do the port: 
20329 and port: 2869 mean? Why is this violation 
occurring and what does it signify? My Net connec-
tion has been down since three days due to this. Even 
if I manage to connect, Comodo Firewall blocks it in 
few minutes. Please give some information on this.

Sridhar Rao

There are all kinds of services and applica-
tions on Windows that open ports and 

send request to other computers on the Internet 
all the time. If this connection attempt is being 
blocked by the firewall and if the Internet 
connection suffers, then disable the firewall.

Remove Recovery Partition
I’m currently using a Compaq notebook. The 
system works fine. Hard drives are parti-

tioned as C: and U:. Although C: is fine, when I try 
to open U: drive, this notice pops up: “Recovery 
Partition Warning!

This area of your hard disk (or 
partition) contains files used for 
your system recovery.

Do not delete or alter these files. 
Any change to this partition could 
prevent any recovery later.”

Should I delete these files? It is taking precious 10 
GB of my laptop. Please suggest an alternate idea.

Ujjwal Tiwari

Do not change, add or remove any data from 
that partition. Like most other manufactur-

ers, the isolated partition stores a backup of all 
the system files and drivers should there be any 
problems with your Windows installation.

Choosing A Gaming Laptop
I want to buy a gaming laptop, but I have 
a budget of Rs 58,000. I’m planning to buy 

a Dell XPS 1530 laptop with a 2.4 GHz proces-
sor, 4 GB RAM, 250 GB hard drive and 256 MB 
NVIDIA GeForce 8600m GT graphic card, but I 
don’t know whether all the games like Call of 
Duty: Modern Warfare, Crysis, Far Cry 2, etc 
will run on it properly. Please guide with me 
this, and if these games won’t run, then please 
give me an alternative choice. I am eagerly 
waiting for your reply.

Mohd. Yasir

While the processor and the memory are 
sufficient enough to run the latest games, 

the 8600m GT might not be sufficient for play-
ing Crysis and Call of Duty at the highest quality 
and resolution. Laptops in general aren’t the 
best place to play games on either with the 
cramped keyboard and small screen. A budget 
of Rs 58,000 will buy a much better perform-
ing gaming desktop with a 22-inch screen. If 
you want a laptop, then the XPS M1530 with 
some upgrades is still worth looking at. 

Typical errors in a 
virus infected Windows 
installation
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Enable IMAP in Gmail

Set Outlook to use the right settings

Enabling SSL and selecting the ports
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USB Drive 
Problems

I have a Transcend 
v20 pen drive. The 

file system on it has 
changed to RAW and 
the capacity now is 0 
MB. I cannot access the 
drive or format it using 
the DOS application. 

This software can’t detect the pen drive, but the OS 
detects the pen drive and displays it as an USB 
device but it can’t format.

I have tried formatting it, but it doesn’t work. 
It could be detected in Windows, but it can’t be 
accessed. In Linux, it can’t even be detected. What 
should I do?

By looking at the description you have 
provided, I see that you can see the pen 

drive in the Device Manager, without a drive 
letter assigned, so you are unable to format it. 
After connecting the drive to the USB port, 
right-click on My Computer > Manage > Disk 
Management. Find the USB disk under disk 
management. Assign a drive letter by right-
clicking on it. After that, format it from 
there itself.

Radhakrishnan (TECH QNA Expert)

I am not sure of any other methods since 
you have already tried most of the steps 

like using different operating systems and 
formats. If it is under warranty please get it 
replaced as the pen drive might be damaged.

Gopi (TECH QNA Expert)

Startup Problems
I have a Compaq laptop with Centrino proces-
sor, 2 GB RAM, 160 GB hard drive. My problem 

is that whenever I start my laptop, it does not start 

instantaneously. However after two or three 
attempts, it starts. My operating system is Vista 
Home Basic.

It could be due to many reasons. Check 
if the BIOS screen itself comes up or 

whether there is a delay. If BIOS screen 
comes up instantly but OS screen takes time, 
it could be due to a boot loader issue if you 
had multiple operating systems. Take backup 
of all your data and try an OS repair with 
the OS DVD.

Gopi (TECH QNA Expert)

Turbo C++ Crashes!	
Recently I have assembled a PC with a 
Pentium D 3 GHz processor, a Zebronics 

NVIDIA 7150 chipset based motherboard, and 1 GB 
RAM. I have installed Window XP SP2, and all 
required software. Everything is running smoothly. 
When I installed Turbo C++, it is does not open. 
When I double-click the TC.exe from bin folder, a 
blank window opens for a fraction of a second and 
disappears, and an error message is displayed—
16 bit MS-DOS Subsystem
Turbo C++ IDE
The NTVDM CPU has encountered an ille-
gal instruction. CS: dooo IP: 03e3 OP: 
ffeb05ea80
Choose ‘Close’ to terminate the appli-
cation.

This is the problem and is there any solution 
for this? Please tell me what this message means. 
I am waiting for your suggestion.

I am assuming that your Turbo C++ instal-
lation is not corrupt. The problem is due 

to a compatibility issue. Go to C:\tc\bin and 
right click on tc.exe and click on Properties. 
After the properties window is displayed, click 
on Compatibility and Check the checkbox 
for Run this program in compatibility 
mode and select “Windows 98”. This will solve 
the problem. If that doesn’t work, your installa-
tion is most likely corrupt.

Danish (TECH QNA Expert)

Can I Make My Drive Portable?
My question is that I have an 80GB 7200 RPM 
SATA Seagate hard disk. I want to use it as a 

portable USB HDD, please tell me how I can do this. 
Please also tell me what I need to do this. 

Yes of course you can do it. You should buy 
USB HDD case that is suitable for it. Power 

and SATA connectors will be supplied with that 
case. You have to place your SATA hard disk in 
it and connect the cables and you’re done. It 
can be easily available in computer shops at 
major cities. The price for such cases starts 
from Rs 400 to Rs 900 only.

N.Vinay Kumar (TECH QNA Expert)

Drive  letters for USB 
drives can also be changed 
through the Computer 
Manage application

Thinkdigit’s 

Tech 
Q&A 

Experts



ADOBE PREMIERE
PRO CS3

Rotoscoping
Rotoscoping is adding effects to a

movie frame by frame—basically painting
stuff onto a movie. This was the technique
used to make the lightsabres in the Star
Wars films. To rotoscope using premiere,
you have to export the file as a filmstrip,
and then edit the frames using photoshop
or an equivalent software. First select the
part of the movie you want to export into
filmstrip. The work area bar is just below
the timescale in the timeline sequence
window. Ideally, select durations less than
five seconds, as anything larger than that
is liable to crash the image editing soft-
ware. Go to File > Export > Movie,
the export movie window will pop up. By
default, premier exports the movie as an
AVI file. Go to Settings > General >
File Type and select FilmStrip in the
drop down box. Then select the Range as
Work Area Bar instead of Entire
Sequence, else premiere will crash. You
now have a grid of frames you can edit
frame by frame. The filmstrip is saved as a
.flm file.

Scaling The Video
While handling videos imported

from camcorders, digital cameras or
mobile phone clips, a common problem is
that the videos are too small and there is
an empty black space on the screen. This
persists as a large black frame around the
movie even when the project is rendered.

To solve this problem, select the clip, go to
Effect Controls > Motion >
Scale. The scale slider slides from only 0
to 100. Click on the number 100, and you
can enter a numerical value for the scale
here. Put in 250, or 200 depending on how
much you want to resize the clip.

Alternatively, you can click once on the
video, and resize it using the mouse. To
make premiere automatically take care of
this problem every time you import a clip,
go to Edit > Preferences >
General and then check Default
scale to frame size. 

Autosave
Most Adobe applications automati-

cally save the file after five minutes. For
some reason, in premiere, the default is
twenty minutes. To change this, go to
Edit > Preferences > Autosave.
Change the Automatically save
every value from 20 to 5. Then click OK. 

Re-establish Media Links
If you are working on a large project

for a long time, and during the course of
the work, if you change the names of the

base files or place them in a different
folder, then the project in premiere will
retain the edits you have made, but lose
the link to the file. If there are a lot of
cuts or edits, this may seem like the end
of the world. Simply right-click on the file
in the bin, select Link Media then look
up the file in the browser and click OK. 

Leader
A counting leader is often used at

the start of a clip to allow minor adjust-
ments on a projector, check if everything
is working normally, and to leave some
buffer time before the video starts. To
include one in your file, right-click on
the bin, select New Item > Universal
Counting Leader. You can change the
wipe, background, line, target and
numeral colors according you your
choice. Then drag and drop the leader on
to the beginning of your timeline. 

Panel Full Screen Toggle
It is sometimes necessary to make

very minor adjustments in the timeline
panel, or adjusting the keyframes in the
effects panel. To make these slight
adjustments, it is possible to put any
panel on fullscreen mode. To do this,

select the panel,
then press the [`]
key (it’s just before
the [1] key). Press
the same key again
to get out of the full
screen mode.
Watching the pro-
gram sequence or a

monitor on full screen without ren-
dering the project first will however
make for a very jerky viewing. 

Saving Workspaces
As and when you work with pre-

miere, you will learn to retain the most
used panels and toolbars, along with a cus-
tomized layout. Premiere automatically
loads the last used layout every time you
start up. If there is a particular layout that
you are most at ease with, then save it by
going to Windows > Workspace >
New Workspace. Enter a name for your
workspace in the pop up and click OK.
Now the workspace name should appear
in the Windows > Workspace menu
itself. Additionally, a shortcut key for the
workspace is automatically assigned. If you
are doing this for the first time, it should
be [Alt] + [Shift] + [5]. This
simple measure also prevents other users
from messing up your workspace. 

SECRETS THAT KEEP YOU AHEAD IN THE RACE
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Blank Video
To add blank video to the

project, right-click in the bin, go
to New Item > Black Video
and select OK. This is basically a
black matte that can be used at
the beginning or at the end of
the film, and by default it lasts
for six seconds. To use a matte in
any other color, right-click in the
bin, go to New Item > Color Matte.
A color picker will appear, choose a color
or enter the values and click OK. This
too, by default lasts for six seconds. To
change this default setting, go to Edit
> Preferences > General and
change the ‘still image duration’ value.
150 frames is equal to six seconds, so if
you want twelve seconds, change the
value to 300.  

Change Playback Speed
There are many ways to change the

speed at which a clip plays back. To change
the speed consistently across all the edits
in the timeline, right-click on the video in
the bin, select Speed / Duration in the
context menu, and change the speed value
from 100% to whatever you want.
Alternatively, you can change the duration

value and make the clip last exactly so
many seconds. If however, you want to
change the speed of only a small portion
of the clip in the timeline, use the razor
tool to cut out that part of the clip, and
right-click to bring up the context menu,
then select Speed / Duration.
Checking the Reverse Speed option
will play the clip backwards.

A-V Links
Whenever a clip is added to the

sequence, it gets split into two parts. The
audio part shows up in an audio track,
and the video part shows up in the video

track. When you move them, or cut them,
the changes that affect one also affect the
other. This occurs because the two are
linked to each other. You can find out if
media is linked by looking at their title. If
they are linked, the title will be under-
lined followed by a [A] annotation for
audio and a [V] annotation for video. To
perform any operations on them sepa-
rately, right-click on the clip and select
‘Unlink’. It is possible to synchronize oper-
ations on an audio and video sequence
that you want to link up together. To do
this, align the audio and video sequence
together on the timeline, select both of
them, right-click and click Link. If either
the audio or the video track is askew at
this point—they will remain so through
further edits unless you correct them.
Moreover, premiere keeps track of
unlinked audio and video components of
the same file, so you can relink them if
there is any need. Select the unlinked
components, right-click, and select link. If
they are askew, Premiere shows up the
duration by which the synchronization is
off in red numbers on a white box to the
left of the title. Right-click on this box and
‘select move into sync’ to rectify the syn-
chronization error automatically.

Docking Panels
You can move most of the panels

around the workplace. The default editing
view has a number of tabbed panels
arranged in 6 areas. When you move
around a panel from one place to another,
just before you dock it, a purple highlight
indicates the position where it is going to
be docked. Whenever you move a panel to
another position, if the highlight is on
the middle of the panel, then it will be
added as a tab. If the top, bottom, left or
right one-third of the panel gets high-
lighted, then the two panels will share
the space, and dock next to each other in
the positions indicated. If the highlight
appears on the title bar, then the panel is
going to be docked as a tab. 

Tool shortcuts

Track Select tool [A]

Ripple Edit tool [B]

Razor tool [C]

Hand tool [H]

Rolling Edit tool [N]

Slide tool [U]

Selection tool [V]

Rate stretch tool [X]

Slip tool [Y]

Zoom tool [Z]

Panel shortcuts

Project panel [SHIFT]+[1]

Source Monitor [SHIFT]+[2]

Timeline panel [SHIFT]+[3]

Program Monitor [SHIFT]+[4]

Effects controls [SHIFT]+[5]

Audio Mixer [SHIFT]+[6]

Effects panel [SHIFT]+[7]

Timeline shortcuts

Nudge 5 frames right [ALT]+[SHIFT]+[.]

Nudge 5 frames left [ALT]+[SHIFT]+[,]

Nudge 1 frame right [ALT]+[.]

Nudge 1 frame left [ALT]+[,]

Toggle play/stop [SPACEBAR]

Play forward slowly [K]+[L]

Play backward slowly [K]+[J]

Shuttle left [J]

Shuttle right [L]

Ripple delete [ALT]+
[BACKSPACE]

Set in point [I]

Set out point [O]

Trim [T]

Capture shortcuts

Record [G]

Stop [S]

Go to in point [Q]

Go to out point [W]

Premiere Shortcuts

Changing the speed/duration in premiere

Syncing unlinked Audio and Video components
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ADOBE ACROBAT
Set initial view
It is possible to completely define the

way in which a PDF document is seen
when it is opened. This extends to the nav-
igation options available, the zoom level,
the page number, the layout, the window
and interface options available. Go to
File > Properties > Initial
View. Tweak the options according to
your preferences and click OK. 

Password Protection
Password protection of your PDF file

ensures that the PDF can only be opened
by the intended recipient of the file.
Password protection
can also be used to
prevent users from
printing or editing
the document. These
settings can be fur-
ther tweaked to allow
only low resolution
printing, and varying
degrees of editing. To
password protect
your document, go to
Advanced >
Security >
Encrypt With
Password. A prompt
will appear asking if you are sure you
want to change the security settings.
Click on Yes. Select Encrypt all
document contents, check Require
password to open document, and
enter the password in the “document
open password” field. If you want control
on the permissions to print and edit the
document, check Restrict editing
and printing. Provide the password
for changing these settings. Make sure
Enable copying of text,

images, and other
content is
unchecked. Click on
OK. A prompt will
appear asking you to
confirm the passwords
you have entered.
Another prompt states
clearly that not all
third-party programs
respect the security
settings in the PDF file.
Third party software
for bypassing these
security settings are
easily available. 

Viewing History
Acrobat keeps a record of which

pages the user has viewed. This is helpful
if you are skimming through a large
report, lots of data, or viewing documents
like a dictionary or encyclopedia. It is pos-
sible to head back to a particular page you
want to go through again. To do this, go
to View > Previous View or Next
View. To add the previous view and next
view buttons on the toolbar, right-click on
the toolbar. A context menu will appear.
Select More Tools. Scroll down till you
see the options for Page Navigation
Toolbar. Check the 
Previous View and Next View
check boxes. 

RSS To PDF
Acrobat has a feedreader that you

can use to convert RSS feeds into PDF doc-
uments. This option is available by default
in Acrobat 8, but strangely enough dis-
abled by default in Acrobat 9. To change
this, go to Edit > Preferences scroll
down to the Tracker category and under
RSS, check Enable RSS Feed In
Tracker. Now copy the URL of the feed
onto your clipboard. Then go to
Comments > Track Reviews > RSS.
Click on ‘Subscribe to RSS feeds’. A
prompt will open where the feed URL will
already be pasted. If not paste the URL in
this field, and click OK. A number of
entries will appear, choose which ones
you want to save into a PDF and click OK.

Clipboard To PDF
Acrobat has a simple option to con-

vert data in the clipboard to a PDF file.
Content like images and hyperlinks will
be preserved. To do this, first copy the
data then, go to File > Create PDF
> From Clipboard. Go to File >
Save As and save the file.

UI Brightness
Go to Edit > Preferences >

User Interface and you will come
across one of the oddest sliders to be
put in any software. It is a slider for
adjusting the brightness of the user
interface, without affect ing windows
settings, or the menu bar. The panels
and everything inside them vary in
brightness according to the slider.  

Export To Device
To export the video sequence in a

format that is playable on a PMP, go to
File > Export > Adobe Media
Encoder. Under Export Settings,
in the Format drop down box, select
the H.264 format. Change the range to
‘work area’ or ‘entire sequence’ as per
preference, and then select a preset.
There are a bunch of Apple iPod, 3gp,
google video, youtube and sony PSP pre-
sets. For most s60 phones, choose 3GPP
320x240 15FPS preset. Click on OK. 

Custom Transition
The gradient wipe transition

allows you to use an image to effect a
transition. This allows for a number of
possibilities—like using the company
logo as a transition in a corporate film.
The image has to be a grayscale, it is
reduced to one by premiere if it is not.
The blackest part of the picture is
replaced first and the image works
upwards through all the shades of grey,
and white is replaced last of all. Once
the clips are aligned next to each other,
in the effects panel, go to Video
Transitions > Wipe > Gradient
Wipe. Then go to the effects controls
panel, and click on Custom. Choose an
image from there, and your custom
transition is ready.

Using a custom image as a transition

The feedreader in Acrobat
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Pictomio
Just a better way to view pictures!

Aditya Madanapalle

Pictomio is a free image browsing
software that offers a great viewing

and organising experience. It uses a lot
of system resources, and you need a
graphics card with ShaderModel 2.0 and
128 MB video RAM just to run it!
Pictomio has a slick interface, and
concentrates on working with a large
archive of images, but can handle videos
and music too. However, the only kind
of image editing the software can
handle is rotating the image—no
cropping or color correction. It makes
up by offering extensive organisation
and searching options. The animations
and the transitions are fluid—the
smoothest we’ve seen.

Image Browsing
To browse the images, either the file
system or the internal library can be
used. The file system scans for images,
and adds them to the library at
lightning speed. There are four basic
image viewing options—thumbnails,
filmstrip, single image and carrousel.

The thumbnails view is packed with
features, it is possible to rotate the
image, rate it (on a scale of 1 to 5) and
view some basic file information like
name, dimensions, file size and colour
depth from the thumbnails itself. A
slider at the bottom can be used to
adjust the size of the thumbnails.

The filmstrip view has a tagger for
both particular pixels and the entire
image, a field to add annotations, a
colour picker, a ruler and a histogram. 

The single image view has the same
features as the filmstrip, with an odd
‘play’ button, which when pressed,
‘plays’ the image like a video for about
five seconds. The carrousel view is
probably the feature which uses the
graphic capabilities the most—there is a
slight reflection below each image in
the forefront—this reflection is smooth
even when playing videos!

Metadata
All the views have a filter, a group by
and a sort by toggle. Once the images
are rated, the filter can show images

equal to, greater than, or lesser than
a particular rating. It is possible to
see only the best photos in the
collection, or the worst. Additionally,
each image can be tagged with a
colour—from a choice of five colours.
It’s possible to filter images of more
than one colour at once, and you
have a ‘flag’ option to shortlist
images—somewhat like the star in
Gmail. The ‘group by’ function
arranges the images in groups,
according to rating, colour, year,
month, day, file type, orientation
(portrait or landscape) and pixel
count. The ‘sort’ function can
arrange the images in order of the
name, date, file size or rating.

Image Organisation
The library has extensive
organisational capabilities. The
Albums are custom collections of
images, and they can be nested
(albums within albums). They serve as
a virtual directory of images, and it is
possible for the same image to be put
in different albums. Additionally, the
library automatically sorts the images
by the date taken, rating, colour
mark, and medium (CD, Drive, Stick
etc). The most useful organisation is
probably that of the sorting according
to the EXIF information, where it is
possible to view images taken from
the same camera, the same aperture
settings, shutter speed, focal length,
ISO rating, etc. 

Slideshow
The slideshow is probably the best
feature of the program, and is totally
customisable—the duration for which
each image is to be displayed, the length
of the transition, the effect of the
transition, etc.

Transitions are a pleasure to watch,
and transitions can be tweaked to add
more variety. There are up to five
distinct properties for most transitions
that can be changed. The interface
looks somewhat like moviemaker,
unfortunately the slideshow can only
be saved as a pictomio file.

What really makes the software
stand out a mile is the eye candy
included in the smallest of things. For
example, if you roll the mouse over a
thumbnail of a folder full of images, all
the images of the folder cycle three at a
time—in the thumbnail itself. If you
scroll up, the images start cycling
backwards. Similarly, the pages in the
album flip over one at a time, and it
looks as if the photos really are pasted
and arranged carefully in a real album.
The categories are animated boxes of
images that turn into view.

It feels a little strange to handle
videos and audio in an application so
obviously made for images, but videos
can be rotated and zoomed into with
the same speed as images. However,
make sure your system has the relevant
codecs before you use this software for
videos. Overall, a must use for those
with a large collection of photos. ■

aditya.madanapalle@thinkdigit.com

A slideshow in Pictomio
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Scan Documents
To scan documents and then convert

them into a PDF file, go to File >
Create PDF > From Scanner >
Custom Scan. There are some other
options available here, like a colour scan
and grayscale scan. Select the scanner con-
nected to your computer in the Scanner
drop down box. In the window that opens,
check the Prompt For Scanning
More Pages option. Select the Output
option as New PDF Document. Check
Make Searchable (Run OCR). OCR
stands for Optical Character Recognition,
and this allows the text in the scanned
documents to be manipulated like text
although it is an image. Press the Scan
button. After the scanning is done, there
will be a prompt asking you if there are
more pages you wish to scan. Choose Scan
More Pages or Scan Is Complete. 

Split Document
Acrobat has a nifty little feature

that allows you to break up a large doc-
ument into several smaller documents.
Go to Document > Split Document.
From here, you can split the document
into pieces of a certain number of
pages, a certain file size, or according to
top level bookmarks. Tweak the Output
options according to your convenience
and click OK.  

Combining Files Into A PDF
It is possible to combine many files

into a single PDF in Acrobat. These files
can include files in various formats, like
.doc, .rtf and .pdf files. To do this, go to
File > Combine > Merge Files
Into A Single PDF. Choose the
Single PDF option as against the PDF
Portfolio. Go to Add Files > Add
Files or drag and drop files from
explorer into the box. It is possible to add
entire folders by choosing Add Files >
Add Folder. Click on individual files
and move them up or down the list to

establish a suitable order. The file size set-
tings allows for three compression presets.
The size of the file will affect the quality.
Choose a low file size to distribute by e-
mail if you are combining a lot of files
together. Click on Combine Files.

Transitions
Acrobat has a feature that allows for

a transition between pages. This feature
can be useful to make a PowerPoint like
presentation from your PDF document.
There are no animation options for text or
objects however. To use this feature, go to
Advanced > Document Processing

> Page Transitions.
Select the transition from the
drop down box. There are thir-
teen transitions available, and
a random transition. Next
select the direction of the
transition. There are various
options available depending
on the type of transition. Next
select the speed of the transi-
tion. There are three speeds;
fast, slow and medium. Check
AutoFlip if you want the
page to turn automatically,

you can specify the period in seconds if
you choose this option. If AutoFlip is
left unchecked, the transition will occur
when the user changes the page. Apply to
All Pages In Document.
Alternatively, you can specify a page
range. Click on OK.

More Recently Used Documents
Acrobat shows a default of five doc-

uments in its history. If you are working
with a lot of documents, and want to
quickly access them from the file menu,
it is necessary to have more recent docu-

Menu shortcuts

Check Spelling [F7]

Show/Hide Menu Bar [F9]

Open document [CTRL]+[O]

Save document [CTRL]+[S]

Save document as [SHIFT]+[CTRL]+[S]

Close document [CTRL]+[W]

Document properties [CTRL]+[D]

Find [CTRL]+[F]

Search [SHIFT]+[CTRL]+[F]

Preferences [CTRL]+[K]

Rotate page [SHIFT]+[CTRL]+[R]

Zoom to actual size [CTRL]+[1]

Zoom to fit page [CTRL]+[0]

Zoom to fit width [CTRL]+[2]

Zoom to fit visible [CTRL]+[3]

Full screen mode [CTRL]+[L]

Show grid [CTRL]+[U]

Snap to grid [SHIFT]+[CTRL]+[U]

Show rulers [CTRL]+[R]

Automatic scroll [SHIFT]+[CTRL]+[H]

Tool Shortcuts

Hand tool [H]

Temporary Hand tool [SPACEBAR]

Select tool [V]

Snapshot tool [G]

Zoom tool [Z]

Select object tool [R]

Object Data tool [O]

Article tool [A]

Measuring tool [B]

Navigation

Shift focus to menu [F10]

Close current document [CTRL]+[F4]

Previous screen [SHIFT]+[ENTER]

Next screen [ENTER]

First page [SHIFT]+[CTRL]+
[PAGE UP]

Last page [SHIFT]+[CTRL]+
[PAGE DOWN]

Previous page [CTRL]+[PAGE UP]

Next page [CTRL]+
[PAGE DOWN]

Zoom in [CTRL]+[=]

Zoom out [CTRL]+[-]

Acrobat Shortcuts

Using Acrobat to set page transitions

Automatically split a document into smaller files
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SystemRescueCD
Call for help no more, rescue is at hand!

Aditya Madanapalle

SystemRescueCD is a small linux
system that boots from a CD drive.

There are a bunch of system administra-
tion tools that can change the partitions
on the disk, rescue data, backup entire
partitions for later use, or securely
delete data amongst other things.
SystemRescueCD is basically meant to
backup your system or to repair it after
it crashes. The .iso file is available for
free from www.sysresccd.org and is a
200 MB download. Once the .iso file is
downloaded, it has to be burnt on to a
CD using any burning software. Once
burnt, restart the computer, enter the
BIOS setup and change the settings so
that the CD drive is booted first. Once
this is done, the SystemRescueCD splash
screen will appear. At this point, it is
possible to specify boot options, but
unless you are an advanced Linux user,
press [Enter] to boot the system with
the default settings. Press [Enter]
again when the keymap screen appears.
A command prompt will appear, and
the system is ready. To start up the GUI,
type wizard and then press [Enter].
There are two GUIs available, XORG and
XVESA. Select XORG, and then the GUI
will appear. 

GParted
GParted stands for the Gnome Partition
Editor. Like many other tools in
SystemRescueCD, it is independently
available. GParted is a powerful parti-
tion organisation tool, and can be used
for a variety of purposes. When started,
GParted first scans all devices. To per-
form any operations on a disk, you have
to select it first either in the GParted
menu or from the top right corner of

the window. Once a drive is selected,
you can delete the partitions, shrink or
expand the partitions, create a partition
table (which will erase all the data), change
the label, change the file system format
of the partition, or check and repair
errors. The view window offers basic
information about a device, like the
model, size and path. Another useful
feature in GParted is the ability to copy
an entire partition and paste it into
another partition or removable media.

Testdisk
If your computer crashes because of a
virus, or some files are deleted by mis-
take, testdisk is a very powerful tool to
recover your data and get your system
up and running again. Testdisk looks
deceptively simple when started up.
Navigation through the program is
done by using the arrow keys and the
enter key. At any point, to go to a pre-
vious screen, press the [Q] key. Choose
no log in the start screen, then
choose the file system, which is usually
Intel. The Analyse option can look
for lost or missing partitions, in case of
a system crash. It can also restore these
partitions. Under Advanced, Testdisk
can recover files from corrupted sectors
of a hard disk. First select Quick
Search, and a summary of available
partitions will appear, then select
Deeper Search to recognise missing
partitions. Locate the missing partition
and press [P] to list the files in the
partition. If all the missing files are
recognised, select Write to recover the
data. You can also save the image of an
entire partition. It is possible to change
the partition type from here. The
Delete option lets you delete all the
data in a partition table. 

Partimage
Partimage helps you save an entire parti-
tion of a disk as an image. Scroll down
on the main screen to choose a parti-
tion, press [Tab] and enter the name of
the partition. Then press [F5] to go to
the next screen. If you are saving a very
large partition, you can split the image
file into smaller parts for better porta-
bility. Press [F5] to continue again,
uncheck the simulation option, and
then continue again. The partition can
be stored in a CD/DVD or a USB storage
device. In case of a system crash, you can
restore the entire partition, along with
system files with this tool. Make sure
that the partition and the image are of
the same size, which is very important
for partimage to work properly. 

Midnight Commander
Midnight commander is a powerful file
manager. Some of the better features
include batch-renaming files, copying a
bunch of files into another directory
and renaming them at the same time,
and comparing two directories, and it
can open compressed files as directories.

Other tools
The Lshw viewer is an advanced hard-
ware information viewer which gives an
overview of all the hardware installed
on your machine with details about the
bus info, version, vendor, clock, capabili-
ties etc. There are two text editors, GVim
editor and Leafpad. There are two Web
browsers—firefox and dillo . You will
have to configure the Internet settings
to get online though. There is also a PDF
viewer, epdview, bundled. There are also
CD/DVD burning tools, network tools
and the clam anti-virus. ■

aditya.madanapalle@thinkdigit.com

The SystemRescueCD startup screen

Shrink or expand partitions with GParted

Save a partition as an image
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ments to show up in the history. Go to
Edit > Preferences. Head over to
Documents category. Under Open
Settings, there will be an option next
to Documents In Recently Used
List. Change it to 10 or 15, as per your
convenience.  

Watermark Documents
A watermark can be a useful iden-

tification marker. While there are many
ways to bypass this measure, a water-
mark identifies the origin of the docu-
ment to at least a limited extent.
Additionally, a watermark can be used
to simply label a file, say ‘incomplete’
or ‘confidential’. It is also useful for

putting the logo of an organization in
the background. Go to Document >
Watermark > Add. A window will
appear with
many options.
Choose either a
Text or a
Document water-
mark. Acrobat
supports only
JPG, PDF and BMP
files for the watermark option. Adjust
the appearance and position options as
necessary. The opacity option changes
the transparency of the watermark,
which is useful if you have the water-
mark appear on top of the page. 

Secret Watermark
It is possible to change the water-

mark settings so that the watermark
appears only when the document is
printed, and not when it is viewed on
screen. Go to Document > Watermark
> Add. Click on Appearance Options.
Check Show When Printing, and
uncheck Show When Displaying On
Screen. Click on OK. 

Export All Images
There is an easy way to extract all

the images in a pdf document. Go to
Advanced > Document Processing
> Export All Images. You will be
prompted to give a file name for the
images. Click OK. By default, this feature
excludes very small images. To change
this, go to Advanced > Document
Processing > Export All Images,
then click Settings. Under
Extraction, change the ‘Exclude
images smaller than’ drop down box to
‘No limit’. Then click OK. 

Measuring Tool
The measuring tool can be very

helpful when working with
maps, scale blueprints or design
drawings. It can also be useful to
process a document before it is
sent for printing. Go to Tools >
Analysis > Measuring
Tool. A small toolbox for the
measuring tool will appear. Click
on any point, drag to another
point, and by default the dis-
tance will be measured. To
change the scale, right-click
while using the measuring tool,
and click on Change Scale
Ratio. From here, set 1 inch = 1

meter, or any scale you prefer. By
default, Measurement Markup is
enabled. This leaves the marks of your
measurements on the pdf. To disable

this, right-click and select Disable
Measurement Markup. On the meas-
urement tool toolbox, there is also a
perimeter measurement tool and an
area measurement tool. 

Snapshot And Loupe
Acrobat has a snapshot tool to copy

content onto the clipboard. Go to Tools
> Select And Zoom > Snapshot
Tool. To copy the entire page, just click
once anywhere on the page. To copy a
portion of the page, or an image, click
and drag a rectangle around the area
you want to capture.  To examine details
of a picture or a drawing, there is a very
useful Loupe tool under Tools >

Select And Zoom > Loupe Tool.
This tool is equivalent to holding a mag-
nifying glass over the PDF document.
The zoom settings and the size of the
magnified display can be tweaked
according to needs.

WAVEPAD

Wavepad sound editor is a powerful
audio editing software available

from www.nch.com.au.

Working in Batches
Wavepad can process files in large

batches. Go to Tools > Batch
Convert Files. Add files using either
the Add Files button or the Add
Folder button. If you add one folder, a
list of audio files in that folder appears,
if you add a number of folders, just a list
of folders appear. Click on Next. Under
Command List select ADD and add a
suitable effect or effects. For every effect
you add, change the settings. For
example, if you add ‘Insert silence at the
start’, the default setting is for ‘0’ sec-
onds, change it to ‘5’ or ‘2’ as per your
convenience. Some effect changes, like
pitch change, are handled with per-
centage values. If you put on a lot of
effects, then it makes sense to save the
commands list as a batch script file just
in case something goes wrong. Click on
Save As and enter a file name. Click on
Next. Under Output File Format
specify a different format or use the
same format that the file was loaded in.
The Output Folder has two options,
to replace the files in the same folder, or
to save in a different folder. Pick one of
these options and click Finish.

Using WavePad As A Transcoder
You can transcode MP3 files to a

lower bitrate for use in your mobile
phones or PMPs to save memory space.
This technique can also be used to send
audio files over e-mail. First save all the
MP3 files you want to work with in one
folder, then go to Tools > Batch
Convert Files and add files using the
Add Folder Option. Click on Next,
ignore the commands window and click
on Next again. Under Output File
Format click on Format Options.
Change the Constant Bit Rate drop
down box to 96 Kbps, and uncheck ‘high
quality encoding’. Click OK, select an
output folder and click Finish. 

The length, perimeter and area measuring tools in Acrobat

Applying a watermark to a document
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Advanced Noise Reduction
For high quality audio recordings,

it is essential to reduce noise for clarity.
There are two automatic noise reduction
options available, but wavepad also
allows a manual approach. Select a sec-
tion of the audio file that has only noise,
the larger this selection, the better the
noise reduction will be. Once the selec-
tion is made, go to Effects > Noise
Reduction > Grab Noise Sample
From Selected Area. Then go to
Effects > Noise Reduction >
Apply Spectral Subtraction
Based On Noise Sample. 

Record Audio
Make sure a microphone or an

AUX wire is providing input to your
computer. Then go to Control >
Record. Select a sample rate—a sample
rate is the number of permanent
records made from the signal per
second, the default is 44100 hz, which
is the same quality of an audio CD. The
higher the sample rate, the higher the
quality, and the more the disk space
used to store the media. Click on the
Stereo radio button and click on OK.
A bar showing audio activity should
appear. If more than one audio input
device is connected to the computer,
select the relevant input device in the

device drop down box. If you
want wavepad to start recording
automatically every time noise
is detected, click on Advanced
Recording Options and
check Auto start recording.
Press the circular red button to
start recording. 

Text To speech
Go to Tools > Text To

Speech, select a sample rate if
prompted, and then type text

out in the window and click on OK.
Wavepad uses Microsoft’s text to
speech engine, so this feature will not
work if you do not have this engine.
Every time this is done, a new file with
the speech is created. The default is the
Microsoft Sam voice, but a few alterna-
tives are available for download from
the NCH Web site. 

Tone Generator
Go to Tools > Tone

Generator, which is an install-on-
demand module for wavepad. It is a
small file, but you will need an Internet
connection for this to work. The tone
generator has a number of options and
can generate sine, triangle, square, saw-
tooth and impulse train tones. Go to
Tone > Number Of Tones to
change the value from 1 to 16 for the
number of parallel tones generated. It
is possible to change the frequency of

all these tones. Additionally, the
tone generator also generates
white noise and pink noise. Go
to File > Save As WAV to
save the tone for later use.
Clicking on Edit will open the
tone as a temporary file immedi-
ately in wavepad for you to edit. 

Remove Clicks And Pops
Many recorded tracks have

clicks and pops as artefacts of faulty

audio hardware—or when the equip-
ment is moved, handled or toggled.
Wavepad can automatically take care of
these clicks and pops. Go to Tools >
Auto Click/Pop Restoration.
Maximum click length is the length of
the longest defect in the track—the
poorer the recording quality, the
longer will this be. The default is 450,
which should take care of the problem.
If the clicks and pops persist, increase
it to 600 and run the operation again.
If there are still clicks and pops after
this, identify the artefact in the wave-
form, select it and then either press
the delete key or go to Tools >
Manual Click/Pop Repair. 

Frequency Analysis
Wavepad offers two kinds of fre-

quency analysis. The basic frequency
analysis plots the waveform into its fre-
quency components. For stereo files,
there is a blue graph (left channel) and
a red graph (right channel). Select a
portion of the file, go to Tools >

Frequency Analysis. You can zoom
in or zoom out in the frequency
analysis window to more closely look at
the waveform. An alternate mode of fre-
quency analysis offered by wavepad is
Temporal Frequency Analysis, under
Tools > Temporal Frequency
Analysis. The intensity of any fre-
quency at any point of time is mapped
on this graph, giving a hot to cold gra-
dient that can be analysed. A slider
adjusts the heat of any particular fre-
quency, which is useful for high inten-
sity music. The brighter areas mean
greater intensity (more decibels) of a
particular frequency, and the darker
areas show a lack of intensity at partic-
ular frequencies. This window also has
a zoom function, and a grid toggle for
reference. ■

aditya.madanapalle@thinkdigit.com

The tone generator can play upto 16 tones
simultaneously

The frequency analysis window in Wavepad

Recording audio using Wavepad

Set a lower bitrate in the format options
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Slider phones are hot, in
more ways than one. They

have also become associated
(sometimes falsely) with
higher prices than other
phones, thanks to flagship
devices like Nokia’s N95. The
6210 Navigator is part of
Nokia’s new series of phones
where GPS is the selling fea-
ture. A lot of other phones
have GPS—this phone is just
blatant with the handle
Navigator. It’s a good looking
phone that looks better in
black than mocha red, which
are the two colours available.
The build and working of the
slider is excellent—a very
smooth and positive action.
The back of the phone has a
cheap and tacky feeling—a
pity since the rest of the

phone is quite well built. The
front has this shiny plastic
coating that we feel is over-
done—this makes the 6210
look a little too loud. The
Navigator monogram—a blue
four cornered star—on the
front of the phone looks
overdone too. Call Accept,
Reject and menu buttons are
large, well laid-out and very
easy to use. The number
keypad, although flat, is
large and well spaced—a
boon for SMS junkies. All the
buttons on the body feel
solid and work well.

The screen is crisp and
can display up to 16 million
colours. The 6210 Navigator
has a 3.15 megapixel camera
that is good for taking the
odd image, but falls short of

some of the other 3.2 MP
rated cellphone cameras
we’ve seen. Music quality is
decent, but not as good as
some of the other Nokia’s. A
3.5 mm jack means you can
use your own headphones.

The phone interface is
fast, thanks to an ARM 11,
369 MHz processor, and

signal quality is good. We
feel a larger battery should
have been present. At
Rs 20,039, the 6210 Navigator
is expensive for what it
offers. 

Specifications
CPU—ARM 11, 369 MHz, 64 MB
SDRAM, Screen size—2.4 inches,
16 million colours, resolution—
240 x 320 pixels, 3.15 MP
camera, inbuilt GPS.

Contact
Phone: 124 4199358
E-mail:  communications.india
@nokia.com
Web site: www.nokia.com
Price: Rs 20,039

We test the latest hardware
and software products 
available in the marketBazaarBazaar

Nokia 6210 Navigator
Slick Slider, Overdone GPS Concept

V iewSonic makes great
though somewhat ordi-

nary-looking, LCDs. Enter the
VX1962WM. It sports the
same lines, stand and body
shape and finish that we’re
used to seeing on much cost-
lier LCD and Plasma TVs. We
feel this monitor will look
equally at home in your
living room and your office.

A surprise—normally a
19-inch widescreen has a
resolution of 1440 x 900
pixels, this one offers a
crisp resolution of 1680 x
1050 pixels. Some will
protest saying that font and
icon sizes will also decrease.
True—small, high resolution
screens aren’t everyone’s
cup of tea. 

Although ViewSonic
claims a Dynamic Contrast

Ratio (DCR) of
6000:1, this is a
TN panel so
we’re not fooled.
The static con-
trast ratio is
stated as 1000:1,
and this figure
seems a little
high too. A
response time of 2 ms seems
accurate. The inbuilt
speakers are strictly OK in
terms of usability and
quality, but you’ll want
more punch.

In Display Mate we had
the usual issues that TN
panels exhibit with contrast
in our grey scale intensity
check, and this monitor
should be avoided by hard-
core multimedia afi-
cionados. Its better at

gaming, but a 22-inch with
the same resolution may be
better for gamers. One
great thing is this monitor
gives good quality even at
non-native resolutions.

It performed decently
throughout our movie
tests, but there are places
where we could notice
issues with contrast.
Colours however are good,
and very few users will
complain.

At a price of Rs 12,500, its
costlier than most 19-inch
monitors, but offers a higher
resolution than the others. If
desktop space is at a pre-
mium—go ahead and pur-
chase it. Imaging profes-
sionals can look elsewhere.

Specifications
Size—19 inches, Resolution—
1680 x 1050 pixels, Contrast
Ratio—1000:1, Brightness—300
cd/m2

Contact
Phone: 26681921
E-mail: viewsonic@rooponline.com 
Web site: in.viewsonic.com
Price: Rs 12,500

ViewSonic VX1962WM
Sleek And Stylish

Razer caters to the gaming
fraternity. They name

their products accordingly,
and Goliathus seems apt for a
colossus of a mousepad. Built
from micro fibre, which is
the choice of material for the
best mouspads the Goliathus
takes up a lot of desktop
space—be warned before
hand. Its a beauty, thanks to
the patterned weave.

Its designed to offer a
somewhat rough surface
which is flat but has slight
pits which are created from
the weave of the fabric itself.
This is a control mat, and the
slightly coarse feeling of the
surface fabric is able to con-
trol the slither motion of the
slick Teflon feet that gaming
mice have, thereby offering

greater twitch
precision and
accuracy to
the discerning fragger.
However fans of smooth
finish a.k.a. speed mats will
beg to differ. For us, the
smooth mats offer greater
mouse acceleration which is
a boon for RTS and RPG
genres of games, but control
mats offer greater precision
for smaller mouse move-
ments like rail-gunning in
Quake 3 Arena or sniping in
Unreal Tournament 2003.

We had a few goes with
Quake 3, Warcraft 3, and UT
2003. The Goliathus definitely
offers a lot more control
than every regular mat out
there, and even image
editing professionals and 3D

artists will appreciate the
extra control their mouse
pointer gets. The sheer size
of the Goliathus does give it
an edge over other smaller
gaming mats.

At Rs 1,399, the Goliathus
is well priced in compar-
ison to the competitors
products. This is no ordi-
nary desktop mat, and defi-
nitely not meant for an
ordinary user. Discerning
gamers and imaging profes-
sionals will want to take a
serious look at this mat, for
the razor sharp precision it
allows. Of course you need
at least a Logitech MX518
(or costlier) grade of mouse

to fully exploit the preci-
sion it offers.

Specifications
Size—444 x 355 x 4.3mm, Silk
Cloth Weave

Contact
Phone: 022-40053901
E-mail: enquiry@
netplacetechnologies.com
Price: Rs 1,399

Goliathus Alpha Speed
Whatta Mat!

ViewSonic’s new PJ513DB
is touted as a compact

projector. Well—most DLPs
are compact. We’ve seen pro-
jectors that are smaller, and
weigh less— some models
from NEC come to mind. It’s
built well, with very solid
quality plastics used on the
body throughout—piano
white and glossy black aren’t
bad colours and these are
the two shades this projector
is available in. It’s a very
clean looking device, with an
attractive shape.

The quality of accessories
provided is good, and the
remote is rather compact.
Connectivity options are
scanty—only one D-Sub con-
nect has been given for PC
connectivity and S-Video and
Composite connects are pro-

vided. For a home entertain-
ment projector we find it
weird to not include at least
Component connectivity, if
not DVI and HDMI connects.
ViewSonic’s menu system is
well laid out, and reasonably
intuitive. With a native reso-
lution of just SVGA (800x600
pixels) it seems pointless for
ViewSonic to advertise sup-
port for 720p and 1080i sig-
nals, simply because most
projectors don’t do well at
any other resolution besides
their native resolution.

In Display Mate we had
no issues with the contrast
tests save one part in the
grey scale and intensity
check test—a deficient con-
trast ratio. In the movies
tests this projector did
well, although we’d have
liked a higher resolution of
at least XGA (1024 x 768
pixels)—at its current
native resolution, anything
higher than DVD quality
isn’t as immersive as we
liked. For gaming the
PJ513DB isn’t going to win

many hearts. The reason,
its lower resolution.

At Rs 38,000 this pro-
jector is cheap, and we for-
give most of its shortcom-
ings. It’s also attractive
enough to find its way into a
decent mid-range home
entertainment setup.

Specifications
Dynamic Contrast Ratio (DCR)—
6000:1, Static Contrast Ratio
(SCR)—1000:1, Brightness—300
cd/m2, Native Resolution—SVGA
Contact
Phone: 42243535
E-mail: viewsonic@redington.co.in 
Web site: in.viewsonic.com
Price: Rs 38,000
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ViewSonic PJ513DB
White And Bright!
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The PXC 450 belongs to
Sennheisers active noise

cancellation series. The PXC
450 is very well builf, and
looks nearly identical to the
PXC 350—which we reviewed
some time ago. The head-
band has been given a slight
boost in padding material,
once again the ear cup mate-
rial is pure leather—making
its pedigree evident. The
steel headband makes for a
really fit tight over ones
head. Due to this sound iso-
lation is very good—even
with the noise cancellation
(NC hereon) switched off.
There’s a neat talk through
button that momentarily dis-
ables NC, (till you press the
button again). This allows
one to hear outside sounds
like someone calling you,
without actually removing
the headphones. The earcups
can also be rotated and
folded inward, to allow
packing and transportation

without
risk of
damage. The
NC part of the
headphone is pow-
ered by a single cell AAA bat-
tery, although the head-
phone functions normally
without the battery since
only the active NC circuitry
requires juice.  

We tried these head-
phones with our test PC on
an X-Fi Platinum soundcard,
and on an iPod Touch for a
portable set up. To be quite
honest the PXC 450 sounds
nowhere near its best on a
system without proper
amplification. We tried
them with a headphone
amplifierand the difference
was startling. Without
amplification bass sounds
rather boomy and unfo-
cussed while the mids are
completely recessed,

although
detailing is present. The
highs are absolutely mud-
dled, and instrument sepa-
ration is guess work at best.
Amping these headphones
does the trick—bass becomes
clear, hard hitting and
much more precise. The
mids are more revealing,
and the highs lose that
muddy effect. Instrument
detailing is accurate.
However these aren’t in the
league of Sennheisers own
HD600 and HD650, AKGs
K701, or BeyerDynamics
DT880, which are true
audiophile cans.

At Rs 16,990, the PXC 450
is slightly overpriced,
although to be quite fair you
do get a lot of headphone for
the price. It’s also not quite a

pure audiophile headphone.
Its biggest feature—active
noise isolation, works well,
but these headphones isolate
noise well with NC off as
well. Then there’s the issue
with amplification—another
investment, which leads to
other investments, as you try
to clean up your sound
source (since amplification
of poor quality signals leads
to discernable noise). If only
they didn’t need a dedicated
amplifier, and sounded even
10 per cent better, we’d
heartily recommend them.

Specifications
Closed circumaural type
headphones, Active Noise
Cancellation
Contact
Phone: 95124-4187800
E-mail: info@sennheiserindia.com
Web site: www.sennheiser.com
Price: Rs 16,990

T he ASUS Xonar U1 looks
like a fancy external con-

troller for your speaker but it
is a full fledged external
soundcard—an external ver-
sion of the Xonar series of
sound cards.

The design is really neat
and solid. It’s a smooth
finish with a port for a
microphone and one for
headphones or speakers. It
connects via USB, and setting
it up is simple after you
install all the drivers. The top
of the Xonar U1 rotates
freely and endlessly and is
used to control the volume.
Pushing the dome down tog-
gles the muting. 

The Xonar performs well
and provides a very neutral
tone without emphasis on

any particular frequency
ranges. The player also has
a built-in amplifier that
also does a good job.
Things can get pretty loud
and the volume control must
be used with care. There is
no clearly audible hissing.
There is an array micro-
phone supplied with the
player. The drivers and the
software bundled are simple
and light on system
resources. There are features
for surround sound effects
built into the software.

There are a few shortcom-
ings with the external Xonar
U1. First and the most
obvious one is the lack of
support for anything more
than 2.1. This means you
have to use this mainly for

music playback. The USB
cable is also quite short.

The ASUS Xonar U1 is a
decent improvement over
the integrated sound solu-
tions found on mother-
boards. Being compact and
also because of the USB con-
nectivity, it can be used with
laptops and carried around
very easily. With a decent
amplifier built into it, it can
also be used to drive high-
end headphones. A Rs 4,140
tag makes it a good option
for those who want quality
music. Movie buffs wanting
quality surround sound and
gaming experience will have

to opt for dedicated PCI-
based sound cards. 

Specifications
Analog/Digital Combo out,
Stereo mic/line-in, Bundled
array mic
Contact
Phone: 67668800 / 18002090365
E-mail: media_india@asus.com 
Web site: www.asus.in 
Price: Rs 4,140

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

If HTC’s Touch didn’t win
you over with its iPhone rip-

off touch interface that was
quirky at best, you can have
another go at finger swiping
with the Touch Diamond. If
the touch interface was
really all that productive we
wonder why the extra menu
keys like Home,
Back, and call
accept/reject have
made their way
into this device. 

Its very well
built, very slim,
and compact for
a WM device.
This is a truly
pocketable PDA,
though the lack
of a keypad does
hamper any sort
of serious produc-
tivity. The screen
sports an ultra
high resolution

of 480x640 pixels and the
result is a very, very crisp dis-
play—colours are excellent,
much better than any WM
device we’ve used before, and
text quality and readability is
amazing. The 3D touch inter-
face lags severely, a faster
processor (maybe a dual core)

and more
memory is
needed.

Its packed to
the gills with
software and
applications.
There’s inbuilt
GPS with Google
Maps prein-
stalled, Voice
Commander, a
UTube video
viewer, an MP3
editing software,
Adobe Flash and
Adobe Reader LE
as well as the

Opera Browser inbuilt.
Incidentally, the Touch
Diamond has no memory
expansion—4 GB of inbuilt
flash has been provided. 

Although this device
works well as a touch only
device—HTCs effort at imple-
menting any kind of gesture
sensor doesn’t seem to work
as well as Apple’s touch
interface. In terms of pure
interaction the Diamond will
always fail when compared
to the iPhone. What really
works for this device, is its
compact dimensions, and
the fact that it’s a full
fledged PDA, (minus keypad).
A good bundle of utilities
are never bad.

It’s not revolutionarily
different, but it is different
enough from most PDAs to
create its very own little
niche away from the com-
peting crowd. If you want a
WM based device that’s
sleek, aesthetic, and reason-
ably usable the Touch
Diamond is very suitable,

and perhaps the only
choice. If you want a PDA
for a lot of office work and
mailing then skip this. For
Rs 27,990, the HTC Touch
Diamond is admittedly
expensive, perhaps prohibi-
tively so. If it appeals to you,
wait for the price to fall.

Specifications
CPU—528 MHz Qualcomm,
RAM—192 MB, ROM—256 MB, 4
GB memory built-in, GPS, 3.2 MP
camera, WM 6.1 Pro, 110 grams

Contact
Phone: 9310746555 / 9350263618
Email: deepak@jainaindia.com,
htc-sales@brightpoint.co.in
Site: http://www.htc.com/in
Price: Rs 27,990

ASUS Xonar U1 Audio Station
A Soundcard And Amplifier In One?

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

The Mako 2.1 are the Razer
branded speakers

designed for gamers. The
design is fresh and unique.
Both the satellites and the
woofer have a dome style
design and they have been
built well. A flashy lit-up
touch-enabled remote also
comes with the speaker set.
The source can be connected
through a 3.5mm jack or
using RCA connectors. The
remote also has a Line-in and
a headphone out connector
built into it.

The performance gets
better as time goes by, but
there’s one important
factor—it still doesn’t sound
powerful enough. The quality

too improves and overall it
is pretty satisfactory. The
bass is rather shallow and

only a few regions of the low
frequencies are generated
really well.

There are no signs of
sound cracking anywhere
because the volume doesn’t
up all that much. The highs
are bright, and though the
bass isn’t loud, it’s quite
tight. It sounds great—there’s
nothing special it does with
movies, but it sounds good in
fast action games.

The remote’s touch fea-
ture doesn’t work very well,

and we had to struggle to
set the volume to the max-
imum. Other than volume,
there is an option to adjust
the amount of bass. Users
can have two inputs con-
nected to the speakers and
switch between the two
through the remote. The
second Line-in is through
RCA connectors. The satel-
lites sound a little brighter
and less muddy if turned
upwards.

As a set of speakers for
everyday use with a bit of
style element thrown in, the
Razer Mako 2.1’s are fine.

Rs 22,355 is extremely
expensive for 2.1 speakers.
Stylish they may be, but
there are better performing
audiophile and desktop
speakers available. 

Specifications
3.5mm and auxiliary inputs,
Frequency range - 25 -
20,000Hz. Power: 300W RMS

Contact
Phone: 022-40053901
E-mail: enquiry@
netplacetechnologies.com
Price: Rs 22,355

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

Features 
Performance  
Build quality
Value for Money
Overall 

RATINGS

HTC Touch Diamond
Not So Precious

Sennheiser PXC 450
Shhh!—I’m Listening

Razer Mako 2.1
Fanciful And That's It
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Advertising itself as a free
phone is misleading, for

you will not be getting the
Neo FreeRunner as a gift any-
time soon. The novel concept
turns out to be a phone
based on a Linux based OS
called Openmoko GNU. The
device itself is physically
rugged and the hard rub-
berised finish exudes quality.
With a Nokia N-Gage like
shape, the FreeRunner has a
very large eyehole built into
the bottom and looks like a
GPS unit. The screen is ultra
crisp—even the bootup
screen, which has really
microscopic text, is very
readable. At 2.8-inches, it’s at
par with most PDA screens,
the resolution is a crisp 480
x 640 pixels—which is much
better than average.
Processing grunt is provided
by a single core ARM9
processor clocked at 400
MHz, we’d like a faster CPU
as the interface lags a bit.

There’s a command line
interface provided which
speeds things up—but only
Linux users will be able to
utilise this feature. A camera
has been forgotten.

As with any open source
application or Linux distro
the real potential of this
phone lies on the Web, once
you get down to trying out
all the free applications—
which really unleash the
potential of open source
applications. Since the
source code is available
Linux aficionados will dig
into the FreeRunners soft-
ware innards. Openmoko
also provides you the liberty
to actually access the Neo
FreeRunners PCB, although
how useful this feature is to
regular users we leave to the
individual. While the Web
site has a section dedicated
to opening your FreeRunner
we didn’t see many options
to mod the device.

Our device was very shy
on application support—no
document editor or PDF
reader or any PMP capabili-
ties, but we’re told that all
these applications will be
added soon. Sadly no applica-
tions were available for
download at the time of
reviewing this product.

We found the on-screen
number pad to be too small,
perhaps future software revi-
sions will remedy this. In
terms of signal quality we
had hardly any issues, and
handsfree quality was good
although due to its elon-
gated ends the Neo Runner
does feel bulky in hand, and
weighs a ton in cellphone
terms—185 grams. As a
phone, this is a device that’s
flawed in terms of usability
and users looking for a func-

tional platform will defi-
nitely look elsewhere. At
Rs 22,000 the FreeRunner is
costly, but not for Linux
buffs.

Specifications
CPU—400 MHz ARM9, RAM—128
MB, ROM—256 MB, MicroSD
expansion, GPS, WiFi,
Linux/GNU based, 185 grams

Contact
Phone: 011-413243321
E-mail: sales@idasystems.net 
Web site: www.idasystems.net
Price: Rs 22,000

In the age of 3-way SLI and
overclocked quad-core

processors, it’s easy to get
carried away with buying a
super high-end power supply
even when your PC doesn’t
really need something that
hefty to power it. Enter the
CM Real Power M700—a
700W, modular power
supply. This unit is built
around ATX 12V version 2.3
specifications. 

The build quality of the
unit itself is a mixed bag—
cable and connector quality
is top notch, but the guage
of sheet used on the body is
light. A single 120mm fan
provides the basis of cooling.

This power supply sup-
ports two PCIe power slots,
and two each of the six and
eight pin connects have been

provided, which means SLI
and CrossFire are supported,
even for the latest generation
of cards like the ATI Radeon
HD4870 and NVIDIA GeForce
GTX 280. We loaded up an
Intel Core 2 Quad Extreme
QX9650, 4 GB of RAM, with
two WD Raptor 10,000 rpm
drives, and a GeForce GTX
280 graphics card. There
were no issues with reboots,
false starts, or freeze-ups
even while stressing the CPU
and GPUs with synthetic and
real-world benchmarks.

For those looking for
something basic to power a
home PC, this is too much of
a power supply for you. For
those looking at 3-way
CrossFire and GeForce
GTX280 SLI look elsewhere
too, as the M700 may not be

able to support adequate
juice to the setup, and a
power supply in the range of
1 Kilowatt may be required. If
you’re looking for something
for a fast gaming rig that’s
not too heavy on power the
M700 is worth a glance. At Rs
7,800, this PSU is overpriced,
especially considering the
excellent Corsair HX620,
which offers nearly the same
power output is priced at Rs
6,200 only.

Specifications
Total Power—700 Watts, four
12V rails, 1x 120mm fan,

modular, 8x SATA power
connectors, 4x four pin
connectors, 2x 6 pin PCIe
connectors

Contact
Phone: 9833870302
E-mail: Tanmay_L@
Coolermaster.com 
Web site: www.coolermaster.com 
Price: Rs 7,800

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Openmoko Neo FreeRunner
Freedom Beckons?

CoolerMaster Real Power M700
For Mid-range Enthusiasts/Gamers

W e’re used to seeing net-
work hubs and gate-

ways, and then we saw the
BiGuard S6000! Its very well
built, has a great, industry
grade silver finish, with the
word Billion engraved on the
top. What the BiGuard S6000
is, is a secure, VPN-based net-
work hub that allows secure
access of corporate resources
from public terminals. In
short the S6000 is a switch,
with support for 2 parallel or
seperate WAN/Internet con-
nections (RJ45). It is SSL
secured—meaning secure
links are possible from any
remote terminal to access
your enterprise resources
with minimum risk. The
S6000 has a couple of fea-
tures worth mention. Network
Extender allows for remote
connections to internal net-
work resources. Transport

Extender allows the use of the
secure path created by the
SSL secured route to be used
for mail delivery. There is a
fail over feature whereby, in
case of network failure on
one of the RJ45 ports,
another takes over automati-
cally, and both of these ports
can also be set to balance
loads between themselves.

One of the best features
for us was the fact that
client-less connections are
supported. This means that
virtually anyone who has
been authorised to access
resources can do so. Another
benefit is the support for
multiple platforms,
including flavours of
Windows, Linux, and even
PDA platforms. There is also
a chat service which can be
used for getting immediate
technical support during

working hours. This service
is offered for up to six
months after registration.
Firmware upgrades are also
free, for a period of one year
from the date of purchase.

The BiGuard S6000 sup-
ports up to 200 secure tun-
nels, or information path-
ways at a time. The number
of concurrent sessions is a
whopping 1,20,000 or 50,000
(there are two versions),
which should be enough for
most medium-sized busi-
nesses. The inbuilt firewall
has SPI (Stateful Packet
Inspection), Packet Filter,
Intrusion Detection, and
Denial of Service prevention.

A neat product and one
that is sure to be appreciated

by business houses with
employees always on the
move. For anyone with an
organisation consisting of
less than 25 people - you can
do without the S6000.

Specifications
2x RJ45 WAN/Internet ports, 8x
RJ45 LAN ports, 2x USB, 1x
RS232 control, VPN, SSL secured
Contact
Phone: 9821014253
E-mail: sales@onenetwork.co.in
Web site: www.onenetwork.co.in 
Price: Rs 1,75000 / 3,75000

The large numbers of
cheap cabinets are slowly

being sidetracked with
brands known world over
bringing their offerings to
the India market. The Elite
330 from Cooler Master
arrives to bring in some
sanity by trying to get entry
level cabinets some quality
and decent design.

This new case has a
decent design and doesn’t
have an out-of-the-world look
that will amaze anyone. The
quality isn’t all that impres-
sive either. 

The panels are made of
really thin metal and they
wobble and flex a lot. The
top being a comparatively
smaller area feels sturdier.

The interiors have smoothly
folded metal edges so users
don’t get scratches and
bruises while working on the
insides of the cabinet. There
are thumbscrews on one side
of the cabinet. There are a
few useful locking mecha-
nisms to hold the rear expan-
sion panels in place and lock
all the drives in their bays.

For cooling, there is a
single 120 mm fan at the
rear of the cabinet and there
is space for additional fans
in the front. The side panel
has a vent to funnel air to
where the processor usually
lies. Cooler Master has dust
filters placed where the
drives go in. 

The front of the cabinet
has the power and reset but-
tons, two USB ports and an
audio out and microphone
in. It also comes with con-
nectors for HD Audio.

The power supply that
comes with the cabinet is a
Cooler Master RS-390-PMSR-
A3—a 390 W one from the
eXtreme Power series—OK for
most onboard graphics solu-
tion running systems. The
cables are long and the PSU
case itself is sturdy. Only the
12V power cable going to the

motherboard comes with
sheathing. Although we
wouldn't highly recommend
this product, if you really
want a Cooler Master cabinet
at a low price, this Rs 1,950
cabinet is a decent buy.

Specifications
120 mm fan, Motherboards: ATX
and Micro-ATX, four 5.25-inch
and six 3.25-inch drive bays. 189
x 425 x 485 mm. 6 Kg
Contact
Phone: 9833870302
E-mail: Tanmay_L@
Coolermaster.com 
Web site: www.coolermaster.com 
Price: Rs 1,950

Features  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Cooler Master Elite 330
A Case Of Mediocrity

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Features 
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Build Quality
Value for Money
Overall 

RATINGS

BEC Technologies Billion BiGuard S6000
Secure Connections Galore



81SEPTEMBER 2008 DIGIT

Digital Tools l Bazaar

80 DIGIT SEPTEMBER 2008

Digital Tools l Bazaar

T he 780a SLI is an NVIDIA
chipset designed for

AMD Phenom and Athlon
CPUs. It is the first chipset to
feature Hybrid SLI, which is
sorely missed on all 780i and
790i boards. Hybrid SLI
allows an integrated NVIDIA
graphics chipset to work in
tandem with an NVIDIA
GeForce 9xxx series or newer
card. This helps increment
performance and save power.

ASUS’ M3N-HT Deluxe is
a beautiful board. The build
quality is absolutely superb,
and the beautiful heatpipe
solution keeps things cool.
The CPU region is quite
clean, and the use of high
quality solid state capacitors

didn’t escape us.
The integrated graphics

solution offers performance
just below the GeForce
8400GS graphics card, and
an HDMI port has also been
provided—HD junkies take
note. We tested this board
with an AMD Phenom 8450
tri core CPU, 4 GB of DDR2
1066 MHz, WD Raptor 10,000
RPM HDD, and a GeForce
8800GTX.

At Rs 17,600 the M3N-HT
Deluxe is uber costly, in fact
a little too costly even for its

array of features. At
the end of the day,

Intel’s Core 2
Duos and

Quads win
the battle,

and everybody
looking to invest in a high-
end setup would go for an
Intel solution. Only for AMD
fan boys as of now.

Contact
Phone: 67668800 / 18002090365
E-mail: media_india@asus.com 
Web site: www.asus.in 
Price: Rs 17,600

The P43 is a new, and
slightly cheaper variant

of the high end P45
chipset. Gigabyte’s offering
is an all solid capacitor
model (the D in the model
name signifies this).

In terms of build quality
this board is solid—no com-
plaints. The layout is good.

The BIOS itself is feature
packed and well laid out,
complete with overclocking
options—although a surprise
(and an irritation) was the
lack of detailed information
on the CPU model, and the
memory installed.

On the rear I/O panel, it’s
interesting to note the pres-
ence of eight USB 2.0 ports—
PS2 ports for mouse and key-
board are also provided.

We installed
CoolerMasters Hyper 212 on
this motherboard with
absolutely no clearance
issues, and there was quite
a lot of room available. The
CPU region features an
eight phase design, and the

quality of mof-
sets is top class.
We used an Intel
Core 2 Duo
Extreme X6800 (2.93
GHz), 4 GB of DDR2
1066 MHz RAM, NVIDIA
GeForce 8800GTX and a WD
Raptor 80 GB 10,000 RPM
drive to test this board.

These
scores are just about

equivalent to a P45s scores,
meaning the GA-EP43-DS3L is
right there in terms of per-
formance. We’d like to point
out that the new PCIe 2.0
interface makes a slight dif-
ference in the gaming per-
formance results, particu-
larly at higher resolutions
which is significant to
gamers and overclockers who
will use such benchmarks. At
Rs 8,500, the GA-EP43-DS3L is
a well laid out, and moder-
ately feature-rich offering.
The important thing is the
price difference between this
and the higher P45 chipset,
as boards based on that
chipset will have more fea-
tures, or possibly greater
overclocking potential, as
manufacturers pump more

goodies into the
higher-end
chipsets. That
being said this
board is very
suitable for

anyone looking for a
decent mid-range solution
with moderate overclocking
potential.

Specifications
Northbridge—P43 chipset,
Southbridge—ICH10, 16 GB
DDR2 1200 MHz RAM support,
all solid state capacitors, 1x
PCIe x16 slot, 2x PCI slots, 3x
PCIe x1 slots, 8x USB 2.0 ports,
7.1 channel Realtek ALC 888
audio solution.

Contact: 
Phone: 40633222
E-mail: vivek@gigabyte.in
Web site: www.gigabyte.in
Price: Rs 8,500

CoolerMaster Hyper 212
Cool Skyscraper

ASUS M3N-HT Deluxe
NVIDIAs 780a SLI On A Rampage! K VM solutions are pretty

common, but this
beauty is advertised as a
wireless presentation system.
The device is actually a
multi-port KVM control unit
that works on the basis of IP
addresses. Just like regular
KVM switches allow the user
to juggle between two PCs
desktops, the KE8220 allows
the any PC/notebooks
desktop environment to be
transmitted to another
PC/notebook or a display. It
has WLAN (802.11 b/g) capa-
bilities and that allows the
user to make presentations
without the need for
switching cables. In terms of
looks, the KE822 is a very
simple, yet attractive
looking device, housed in a

rugged metal
shell, finished
in all black. It
looks like a
miniature network hub sans
all the ports. There’s also a
rack mount bracket pro-
vided. The best part of the
inbuilt WiFi is that for use
with notebooks and other
such WLAN enabled devices
no external access point is
required. The KE8220
embedded Web server has
software installed on it
which users connecting to
its network wirelessly can
download. The software
allows switching the display
focus between computers—
an enormous boon in case
multiple people are giving
presentations.

At the rear of the
product you’ll find an RJ45
connect for an Internet/LAN
connection, and for WLAN
purposes there’s a single USB
type A connect. There’s one
each of keyboard, mouse and
monitor (D-Sub) connects.
Note that both keyboard and
mouse connects are USB
based, so PS2 port based key-
boards and mice are out.

We tested this device and
used it to stream PowerPoint
presentations and video files
to our 32 inch Vu LCD
screen, from one desktop PC,
and two notebooks. The
KE8220 works really well,

except that with four wire-
less clients connected we feel
speed could become an issue.
Maybe once 802.11n specifi-
cation becomes standard
we’ll see a WiFi N version of
this product. At Rs 22,500,
this an IT concious business
houses’ dream tool—ease and
flexibility of use.

Specifications
WLAN based on 802.11b/g,
Video connect—D-Sub, Wired
LAN connect—RJ45
Contact
Phone: 022 -25008962
E-mail: marketing@cubixindia.com
Web site: www.cubixindia.com 
Price: Rs 22,500

Aten ALTUSCN KE8220
Connectivity Galore

Features
Performance 
Build Quality
Value for Money
Overall 

RATINGS

Features 
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Gigabyte GA-EP43-DS3L
P45 mini edition…

The last famous CPU
cooler from CM was the

Hyper 6, which was large and
heavy. CM has now decided
to go all out to claim the
performance to price ratio
throne with the Hyper 212.
Its attractive, large, and is an
all aluminium (except for
the copper base) tower type
heatsink. It comes with a CM
120mm blue LED fan already
attached. Build quality is
goo. The heatsink is huge,
larger than Thermalright’s

Ultra 120 Extreme. The
Hyper 212 is, however, sur-
prisingly light for its size.
While assembling the cooler,
we found an issue with the
tiny screws supplied to
mount the bracket of the
retention front plate on to
the cooler—one of these
screws didn’t fit properly. Its
easier to install as compared
to other tower-type coolers
since the CPU retention plate
bolts on to the heatsink and
this prevents the screws

from falling off once you
reverse the motherboard to
tighten the backplate on.

The Hyper 212 is accom-
modated easily on even
heatpipe based boards. The
option to install a second
fan in a push-pull, (one fan
pushes air, the other fan
pulls this pushed air
through), is available.
However a second fan isn’t
provided.

We tested it using a Core
2 Quad Extreme QX9650 (3.0
GHz), comparing it against
Intel’s stock cooler and
Thermalrights Ultra 120.

For loading the CPU we
used WPrime. The results
show great cooling at stock,
although it loses ground on
an overclocked setup. At
Rs 2,250, its a well priced,
great cooler for non hard-
core overclockers, we wish
it were less bulky, like the
TR Ultima 90i.

Specifications
Tower type cooler, aluminium
with copper base, 120mm
fixed fan

Contact
Phone: 9833870302
E-mail: Tanmay_L@
Coolermaster.com 
Web site: www.coolermaster.com 
Price: Rs 2,250

Features
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Build Quality
Value for Money
Overall 
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Stock Intel HSF Thermalright Ultra 120 CoolerMaster Hyper 212

Stock Speed (3.0 GHz), Idle Stock Speed (3.0 GHz), Load
Overclocked (3.7 GHz), Load
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CoolerMaster Hyper 212 And The Rest

PC Mark 05
CPU 5637
Mem 4208
GPU 11733
HDD 7216
Overall 7261

3D Mark 2005 14173
CPU 7904

DOOM 3
640 x 480 163.3
1600 x 1200 159.5

Far Cry
640 x 480 150
1280 x 1024 152.2

SiSoft Sandra 2008
CPU Dhrystone 20102
CPU Whetstone 11238
CPU Multimedia Integer 122787
CPU Multimedia Floating 70929
Drive Index 78
Memory Bandwidth (Integer) 5156
Memory Bandwidth (Floating) 5147

PC Mark 05
CPU 7538
Memory 5847
Graphics 13742
HDD 7118
Overall 8534

3D Mark 2005 17163
CPU Score 10650

SiSoft Sandra 2007
CPU Dhrystone 27046
CPU Whetstone 18754
CPU Integer 161614
CPU Floating 88038
RAM Integer 5495
RAM Floating 5490
Drive Index 79 MBps

Far Cry
640 x 480 134.55
1600 x 1200 150

DOOM 3
640 x 480 244.2
1600 x 1200 202.1
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2.1 Speaker Sets
Altec Lansing MX5021

Excellent performance
Some minor vibrations in woofer

Contact Rashi Peripherals Pvt.Ltd
Phone +91-22-67090909
E-mail altec@rptechindia.com
Price Rs 7,600

5.1 Speaker Sets
Logitech Z-5500 Digital

Explosive power
Too expensive

Contact Logitech
Phone +91-22-26571160
E-mail kavita_nath@logitech.com
Price Rs 27,995

Projectors
NEC VT800

Excellent performer
Slightly pricey 

Contact NEC India Pvt. Ltd.
Phone +91-11-4657 0000
E-mail enquiries@necindia.in 
Price Rs 92,000

MP3 Player above Rs
10,000
Cowon D2

Very good performance
Slightly bulky 

Contact Lipap Systems P. Ltd
Phone +91-9819917440
E-mail iaudio@lipap.com
Price Rs 11,000

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India
Electronics Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

MP3 Players up to Rs 5,000
Apacer Steno A4351

Good performence
Tacky build, Screen quality

Contact Apacer Technology
Phone +91-80-25702208
E-mail suraj_raina@apacer.com
Price Rs 1,720

MP3 Players up to Rs 10,000
Samsung T10

Good music quality, nice
screen
Tacky exterior

Contact Samsung India Ltd
Phone +91-11-41511234
E-mail jitendra.c@samsung.com
Price Rs 6,600

Digital Cameras
(Upto Rs 16,000)
Canon PowerShot SX100 IS

Powerful zoom
Bulky and average
build quality 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 15,995

Internal Hard Drives
Seagate 7200.11 750GB
ST3750330AS

Class leading performance
None as such

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 8,900

Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up

Contact Technology and Gadgets
Phone +91-22-23823331
Web site technologyandgadgets 

.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular

Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers Pvt Ltd
Phone +91-11-26214751
Web site www.championindia.com
Price Rs 6,500

Internal Hard Drives
Seagate 7200.11 500GB
ST3500320AS

Value for money, performance
None in particular

Contact Fortune Marketing
Phone +91-11-2641 4468
E-mail sales@fortune-it.com
Price Rs 4,900

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT SEPTEMBER 2008

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive

Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

LCD Monitor
LG 246Wp

Great performance and Build
Bulky, Slightly expensive

Contact LG Electronics India Pvt. Ltd.
Phone 91 - 120 - 2560900 / 940
E-mail sanjoyb@lgindia.com
Price Rs 28,000
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Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Features Galore
Slider Quality

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Multimedia Cell Phone 
Upto Rs 8,000
Sony Ericsson K550i 

Compact
Lacks Features

Contact Sony Ericsson Mobile 
Comm. India Pvt Ltd

Web site www.sonyericsson.com
Price Rs 7,354

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive 

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

WiFi Routers
D-link DIR-655

Excellent signal coverage
Expensive

Contact D-Link India Ltd. 
Phone +91-22-3061 6666
E-mail sales@dlink.co.in 
Price Rs 13,500

Multi-Function Devices
Canon Pixma MP 610

Terrific performer
Average Scanning quality

Contact Canon India Private Limited 
Phone 1800-180-33-66
E-mail info@canon.co.in
Price Rs 15,995

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix
(India) Pvt Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Laser Printers
HP LJ P1007

Compact and fast
Nothing Specific

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone 1800425499
E-mail cic.quality@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Laptops
Dell XPS 1530

Well built, powerful
Heavy

Contact Dell India
Phone +1-800-4254026 
E-mail Online_India@dell.com
Price Rs 49,900

Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt. Ltd.
Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

DVD/DivX Players

Samsung DVD-1080P7
Great looks and perform-

ance
No 5.1 channel RCA

Contact Samsung India Electronics
Pvt. Ltd.

Phone +91-11-41511234
E-mail shailja.m@ samsung.com 
Price Rs 2,990
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Agent 001

Last month I took you through the process
of buying hardware for a small office, but
without the right software installed, all

that hardware is useless. In t his article, I will
take you through the processes involved in buy-
ing software for a small office setup. 

Piracy is rampant, and India is no exception—
9 out of 10 people in India have pirated software
installed on their machine. Worst, most of them
are not even aware of this fact. With cyber laws
in place, it would be prudent not to be on the
wrong side of the law. That’s not the only reason
why one should buy genuine software though.
Legal obligation aside, if you are using pirated
software, critical updates and patches required
to bolster security against viruses, worms and
other malware are not made available to you,
which leaves your entire computer network
open—a situation which should be avoided at all
costs, especially in a business environment. 

Buying legal software also entitles you to
technical help from the vendor. Initially, this
might seem unimportant, but as your business
grows and dependence on IT increases techni-
cal help becomes a critical factor. For example,
you might want to customise the accounting
software to your needs, or might want to merge
two different databases, or want your old data-
base made available on a newer version, in such
situations vendors are your best bet and buying
original software from them automatically
gives you bargaining power.

Proprietary Or Open Source?
Once you have made up your mind to invest in
software, the immediate question that arises is,
“Should I opt for Free, Open Source software, or
pay and buy proprietary software?” The answer
to this question depends on the kind on infra-
structure you want to put up, and whether you
will have a resident technical person looking
after it. Both Open Source and proprietary soft-
ware have their distinct advantages, and hence a
healthy mix of both should be used to maximise
return on investments (ROI). In a client/server
model, which will be used in most organisations,
Open source can be deployed on the server side
and Windows can (should) be used on the client
side. Such an approach will return good ROI and
on a technical level will offer a robust platform. 

For an office with more than 10 computers
it’s better to have a technical administrator over-
seeing matters. If he is competent in Open Source
Software (OSS) then deploying OSS might be an
option. Even if you have a consulting Open
Source Software expert, deploying OSS can be
considered. The key in deploying OSS is the avail-
ability of technical competence. 

Can’t Linux be deployed on the desktop too?
Technically, yes, there are many opportunities
to deploy Linux on desktops. If you are running
a technical firm, for example, software develop-
ment, where there is no dearth of technical peo-
ple, you can deploy Linux on the desktop. Also,
if you’re looking at a customer service and data
entry department, where only data read/write
happens from databases, Linux can be deployed.
However, in the case of an Accounts depart-
ment, the Marketing, creative department, etc.,
Linux on the desktop isn’t recommended.
People from such departments are generally
accustomed to the Windows environment, and
expecting them to unlearn it and learn Linux
can be a serious challenge. In order to improve
bottom-line and ROI, don’t blindly push Linux
as it might prove counter-productive. 

First Things First
An operating systems (OS) is the first software
you need to install on all machines. Microsoft’s
Windows is widely used and is very popular.
Windows XP and Windows Vista are the two ver-
sions which you will come across most often, as
they are pre-loaded by PC and laptop vendors.
Windows is not the only OS available though,
Mac OSX by Apple and various flavours of Linux
are also available. In a business environment, you
need two types of OSes; desktop or client OS and
server OS. Windows XP and Windows Vista are
client operating systems whereas Windows
Server 2003 is a server operating system. 

Before any software is purchased, pay close
attention to its licensing policy. A license is noth-
ing but terms and agreements related to the use
of that particular software. Let’s take some
examples here to clear the mysteries surround-
ing Windows products. Microsoft’s software can
be bought in three ways namely, OEM, Buying
online and Dial-a-software. Vendors such as Dell,
Lenovo, Wipro, etc., offer pre-loaded operating
systems with their PCs and laptops—these fall
under the OEM bracket. 

Answer the
questions, why,

what, where and
how to buy

software for your
business

Soft Where?
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At times, you may come across OEM OSes
being offered in the grey market at lower rates.
Though they appear to be genuine software with
proper license keys, they have to be used with the
hardware they were originally meant for. If you
buy a PC or a laptop without an OS, then you can
buy it online or get it from your local Microsoft
partner by simply calling them. In either case you
will get a license for your personal use. For e.g.
typically when only a single copy is ordered you
get the software packed in a box and hence it is
termed as Box license. This license is valid for
only a single machine which means you can only
install it on one computer. 

But most offices have more than one com-
puter, for such scenarios, volume licensing
should be considered. Most vendors specify the
minimum amount of licenses one needs to order
before their request is considered for volume
licensing. Under volume licensing, you can just
buy a single copy of that particular software and
install in on as many computers you have. For
every computer you install it on your vendor pro-
vides you a paper license. If you have 100 com-
puters then you need to possess 100 paper licens-
es but you need not buy 100 software boxes just a
single box would do. When you buy any software
it is often validated by entering a code often
known as serial key. Under volume licensing you
only get one serial key to be used across 100 com-
puters; this saves lot of administrative trouble. 

When opting for volume licensing, always
think forwards. Today, your office might have
just 20 computers, but if you expect it to grow
to say 50, it is advisable to buy 50 licenses
before hand. This is because the more licenses
you buy at once, the better your bargaining
power. Also, keep a look out for combo deals. If
you are buying OSes, it’s likely that you will
need to buy office productivity suites such as
MS Office as well. If this is so, ask for combo
deals. Getting deals on software purchases are
very easy in India, because we are so used to not
paying for software in India, that vendors and
dealers are eager to sell, even at lower prices.
Bargain hard, they will give in. 

When it comes to server operating systems,
there is yet another type of license, often known
as Client Access License (CAL). Here the licenses
depend on the number of clients that would con-
nect to the server. So, in our case we need 100 CAL
to be on the safe side. For small offices, this could
mean heavy investment, and Open Source alter-
natives are welcome. 

Alternatives, such as Linux as server operat-
ing system workout great in the longer run. Not
only will you save money but Linux on a server is
a more robust solution. RedHat, SuSE, Mandrake,
Ubuntu etc are some of the distribution you can
get for the server side. Ubuntu, which is a rage
nowadays, also has a special server edition called

LTS (Long Term Support), which, as the name sug-
gests, are kept alive for longer periods before a
new version is released thus ensuring stability
over longer period.    

Productivity
At some point in time, everyone uses word
processors, spreadsheets, presentation applica-
tions and some database application. Microsoft’s
Office is the most widely used office productivity
suite in the world, and it completely deserves the
credit. Word, Excel, PowerPoint and Access are
often used, but not everyone may use all these
applications in their profession—hence Microsoft
offers eight editions of its favourite suite. 

If you only need Word, Excel and Outlook (e-
mail client) then MS Office Basic 2007 is the way
to go. Microsoft Office Standard 2007 comes with
all the three in Basic plus PowerPoint and that
should be enough for most offices. These two edi-
tions are more than enough for any small office;
you need not look into the remaining six editions.
Licensing is similar to Microsoft’s Operating sys-
tem as described earlier, and volume licensing is
also available for Office products. 

If you have limited budget, then MS Office
might not work out in your favour. In such a case,
you can definitely opt for Open Source office
applications such as OpenOffice.org. This open
source office is very similar to MS office in terms
of user interface and has nearly all the features
you need. People who swear by Excel initially may
have some difficulties working with Calc (Excel
alternative), but persistence pays rich dividend.
My advice would be to begin with OpenOffice, if
things don’t work out get Microsoft office.

Accounting department needs more than
just office application for keeping track of daily
expenses and I would recommend investing in
proper accounting software. Tally is well known
in the accounting circle and I would recommend
it for two reasons; first, it is good and second
every fresh commerce graduate coming out of
college ensures to learn Tally and hence compe-
tent work force is available easily. There is other
good Accounting software available too, for
example from Wingsinfo.net, who has wider
range of products to choose from but then staff
training will be required. Most of these account-
ing software are available as single user license
but if you want to deploy it across your account-
ing team then Multi-user license will be required.
A single user license copy can be bought for no
more than 10K—no really expensive for some-
thing which will help manage assets worth lacs. 

Every office creates some kind of database be
it customers, clients, subscribers or just simple
inventory. Every office needs a good database to
ensure business runs smoothly. Microsoft’s Access
can be used to good effect for creating small but
powerful databases and it wouldn’t cost you a

Digital Business l Smart SoHo
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bomb to buy it. Oracle, MySQL are other database
applications which should be considered if your
database will eventually run into thousands of
records. For a small office, Access would be more
than enough to get the work done. 

Security
Each computer on your business network
should be properly secured against viruses,
worms, Trojans and malicious spywares. The
general trend is to install a copy of an Anti-virus
on each machine, and further bolster it by hav-
ing personal firewalls and spyware removal
tools running in the background. Well, that’s
passé; I will suggest a better way.

It’s not enough to have an Anti-virus run-
ning on all PCs, as they need to be periodically
updated with recent virus signatures. Most
people often forget to do so, or the update fails
due to numerous reasons. Instead of opting for
individual anti-virus licenses, you should con-
sider deploying an anti-virus server. In such a
system, the anti-virus is running on a server
and its client runs on individual machines. The
advantage is better manageability, higher effi-
ciency and total control. Only the anti-virus
server connects to the Internet and gets the
new virus signatures, and then it automatical-
ly updates all the client machines without
human intervention. This not only saves time
and effort, but also minimises the use of
Internet bandwidth, since the signature file is
downloaded just once. The anti-virus server
should be hosted on proper server hardware
though, or at least on a powerful PC to ensure
smooth operation.  

In terms of manageability, a system adminis-
trator can check the status of each client from his
desk, and can mend problems without getting up
from his seat. He can also force check any
machine on the network for viruses and other
malicious content, thus ensuring a virus free net-
work. Anti-virus applications are more affordable
these days, and they are a must if you’re ever
going to protect your data—so make sure to budg-
et for them. You will easily earn back the invest-
ment in terms of man hours by keeping your net-
work virus-free.  

installing a firewall on or between the
gateway and your network, spyware problems
can be tackled. This, in conjunction with a
proper proxy server will save you a lot of
headaches in the long run. 

There are many types of firewalls avail-
able, individual machines can have personal
firewalls, and some examples are ZoneAlarm,
Comodo, etc., but these are not as effective as
network level firewalls. An old Linux box (PC)
with correctly configured IP Tables can be
turned into an excellent network firewall.
Proprietary hardware firewall devices are also

available, but they are expensive, and you
have a large network, these can be ignored. 

Network
The Internet plays a pivotal role in all offices
today, and as a resource, it needs to be shared
amongst all computers on the network. A
decent speed Internet connection won’t come
cheap, and hence every effort has to be made to
ensure as a resource it is properly shared and
utilised. Setting up a proxy server is the best way
to do this. Linux can be put to good use here, as
one of the best proxy servers, Squid, is available
for free. Squid is an excellent proxy server, and
to be effective, it needs to be configured proper-
ly. Also, it is a caching proxy server, so you
should pay attention to utilising and exploiting
this to its maximum. Though Squid is deployed
by many, the caching part is often left out,
which is not advisable. Implement it properly,
and you will tell the difference in terms of
Internet speeds. On the hardware front, even an
old machine will do. So long as you upgrade the
RAM and put in a new har       d disk, there’s not
much that can go wrong here.

The Internet plays a pivotal role in all offices
today, and as a resource, it needs to be shared
amongst all computers on the network. A
decent speed Internet connection won’t come
cheap, and hence every effort has to be made to
ensure as a resource it is properly shared and
utilised. Setting up a proxy server is the best way
to do this. Linux can be put to good use here, as
one of the best proxy servers, Squid, is available
for free. Squid is an excellent proxy server, and
to be effective, it needs to be configured proper-
ly. Also, it is a caching proxy server, so you
should pay attention to utilising and exploiting
this to its maximum. Though Squid is deployed
by many, the caching part is often left out,
which is not advisable. Implement it properly,
and you will tell the difference in terms of
Internet speeds. On the hardware front, even an
old machine will do. So long as you upgrade the
RAM and put in a new hard disk, there’s not
much that can go wrong here. 

In all probability, have at least one Linux
machine on your network running. This machine
can be used to administrate the proxy server, file
server, and firewall, or it can also be used to diag-
nose network related problems. Get a good net-
work analyser such as WireShark (formerly
Ethereal) to detect network problems. Such a
machine can also be used for remote administra-
tion of Servers, FTP transfers, etc. 

I hope this guide helps you to grasp the basics
involved in selecting the right kind of software for
your small organisation. If you have any sugges-
tions, queries, questions or need any help, drop us
a mail and I will be glad to listen and help you. 

agent001@thinkdigit.com
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Xerox 3117 replicates Samsung’s 
design, but is finished in white. 
The HL-2140 is a new series from 
Brother and is designed to appeal 
with its low profile, horizontal lay-
out—but it uses more desk space.     

Laser printers are often defined 
by their speed given as PPM (pages 
per minute). All these devices nearly 
delivered on their speed promises. 
Importantly, each device was able 
to print the first page within 10 sec-
onds and that matters more than 
PPM. Except for Canon, all other 
printers are equipped with 8 MB 
of onboard memory. But despite 
lower memory, the Canon machine 
is just as fast when printing the 
first page. Canon uses system mem-
ory, a method it calls CAPT, and it’s 
definitely delivering the goods. 

Canon’s LBP 2900B, Samsung’s 
ML-1640 and Xerox’s 3117 had paper 
trays that tuck away into the printer 
when the flaps are closed. However, 
Brother’s HL-2140 has a paper cas-
sette which holds paper, due to this 
design the Brother printers seem 
to occupy more space. You have to 
remember that in the first three 
printers, the paper trays extend 
from the body, and this uses nearly 
the same space as the Brother HL-
2140 does. Hence, all four printers 
irrespective of their design need 
same amount of desk space. 

Eco mode is available on all 
these printers and can be set via 
the driver settings. In the Eco 
mode, the printer uses less toner 
and hence less electricity too. 
Automatic dual-side printing is 
not offered on any of these print-
ers. The drivers provided with each 
of these printers offered extensive 
control over the device.

The usual options for paper, 
orientation, quality were present 
and other pre-defined options for 
printing text, graphics, photos were 
present for one touch selection.

Performance
On printing speed, Canon’s LBP-
2900B was ahead of other print-
ers on most of the tests we put 
it through. The first printout 
is delivered in just 10 seconds, 
while the rest take 11 seconds. 
When printing large files such 
as the combi-document, the 

CAPT technology helps the Canon 
maintain the lead. Both Samsung 
and Xerox deliver almost identi-
cal performance figures, with the 
Brother HL-2140 trailing slightly 
behind. 

If we scrutinise print qual-
ity, then Brother’s HL-2140 deliv-
ered excellent results, followed by 
Samsung and Xerox. Canon’s LBP-
2900B missed out on some details 
especially in the lighter shades of 
the grey scale.  Graphs are faith-
fully reproduced by the Brother, 
Samsung and Xerox printers, and 
Canon does a good job, but misses 
out on finer details. With respect 
to laser printers tested a couple 
of years ago, all the four printers 
here are remarkably better in terms 
of print quality—especially in the 
graphics department. The result is 
smooth consistent-looking images, 
without any gradient or pixilation.

If you are on a shoestring bud-
get, and want a laser printer, then 
go for Xerox 3117. Both the Samsung 

ML-1640 and Brother HL-2140 are 
excellent buys—just make sure your 
dealer readily stocks their toners. 
We have chosen Brother’s HL-2140 
as the Best Buy over Samsung’s ML-
1640 simply for its better perfor-
mance and bigger paper tray. If 
Brother Printers are not available 
in your locality, then the Samsung 
ML-1640 should be considered.

Brother’s HL-2150N, Canon’s 
LBP 1210, HP’s P1007 and P1008 and 
Samsung’s ML-2245 are all priced 
between Rs 6,000 and 10,000, and 
they form our next category of pre-
mium personal laser printers. These 
machines offer higher duty cycles, 
and hence can take some thrashing. 
They also offer some additional fea-
tures such as networking options 
and higher speeds. 

      
Features
The P1007 and P1008 are new 
laser printers from HP and sport 
a modern design. The Brother HL-
2150N is identical to the HL-2140 
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Printers Test
Laser and 

inkjet 
printers 
tested 

across two 
categories 

to help 
you find 
the right 
solution 
for your 
business

SoHo applications. We will begin 
with the laser category first and 
then look into the inkjet products. 
 
Laser Printers

Personal Laser Printers
As the name suggests, these are 
laser printers for personal use. In 
this category we got nine print-
ers priced between Rs 4,000 and 
10,000. For clarity, we have further 
divided them into two categories.

Brother’s HL-2140, Canon’s LBP 
2900B, Samsung’s ML-1640 and 
Xerox’s 3117 printers are priced 
below Rs 6,000, and form the 
entry-level personal laser group.  

Features
A personal laser will often be kept 
near you desk and hence it has 
to look good, Canon’s LBP 2900B 
excels here due to its intelligent 
design and compact form factor. 
Samsung’s ML-1640 has a famil-
iar design, but the proportions 
are well within acceptable limits. 

coloured printouts at lower speeds. 
Laser printers where known to 
deliver mono prints at impressive 
speed and proved economic in the 
longer run. But now you get Inkjet 
printers which offer similar bene-
fits as laser printers and vice-versa.  

Volume of printing should be 
used to decide the type of printer 
except in some special cases. Laser 
printers work out cheaper when 
print volumes are high—100 pages 
a day. On the other hand, for 10 
pages a week, an entry level inkjet 
printer is sufficient. 

In this test we are looking at 
both laser as well as inkjet printers, 
but not exceeding Rs 20,000.  The 
Inkjet printers have been divided 
into two distinct classes. Products 
for home and small offices and 
photo printers with loads of fea-
tures. For lasers, there are two cat-
egories as well: for personal lasers, 
we have grouped all laser print-
ers below 10,000.  Then there’s 
the small workgroup laser print-
ers priced between 10K to 20K, for 

Sanket Naik

In the early days of personal 
computing, printers and scan-
ners were the chosen peripher-

als one would buy along with their 
PC. Then, printers were expensive 
and the consequent running cost 
would limit their use to occasional 
printing and very few could afford 
them. But today the prices have 
fallen and one can easily buy a 
small printer for not more than 
Rs 3,000. Also, Inkjet printers were 
the only option because Laser tech-
nology was new and laser printers 
would cost five times more than a 
similar spec inkjet printer. Today a 
good laser printer can be had for 
not more than Rs 5,000. 

Printing technology has made 
rapid advancement in the last cou-
ple of years, and today they boast of 
mind-numbing speeds and photo-
lab printing quality, irrespective 
of whether you choose Inkjet or 
Laser. Inkjet printers were typically 
known to be better at producing 

Our test-bed comprised of a Pentium 
4 3.2 GHz processor, plugged to an 

Intel 875PBZ motherboard, with 512 MB 
of corsair 400 MHz DDRRAM, MSI Ti4800 
display card and 40 GB 7200 rpm ATA IV 
Seagate Barracuda hard drive. We used 
Windows XP with SP1 as our chosen oper-
ating system. The system was made up 
to date by loading all the latest chipset 
drivers and graphics driver. The USB patch 
for windows XP was also installed and the 
devices were connected on the USB 2.0 port 
for optimum performance. We used 100 
gsm papers for doing all test except for the 
drain test were we used 75 gsm papers. For 
printing photographs, we used NovaJet’s 
130 g/m2 inkjet photo paper across all the 
printers, since they are widely available 
across the country

We tested all the printers on the same 
test benchmarks which comprised of a text 
document, a combi document, a continu-
ous document and an image file. These 
test documents incorporate every small 
detail that a printer will need to repro-
duce right from smallest point text, lines, 
specular effect (shining) on metal, etc. 

The combi document has many sec-
tions with text of varying points; lines draw 
in a circle, seven colour bars of decreasing 
gradient and a small picture at one corner. 

Each of these subsection tests the printer’s 
ability to reproduce every detail exactly 
as seen in the original file. The varying 
text point size test the printers ability to 
reproduce even the smallest possible text, 
in other word it test the spatial resolution 
of the printer when it comes to printing 
text. Where as the circle of lines test the 
printer’s ability to reproduce lines with-
out jarring the edges. Similarly the seven 
colour bar test the colour reproduction 
capabilities of the printer cartridges.

The continuous document is a small 
report with bar graphs, pie charts, line 
graphs, images and test all spread over 
six pages. We choose this document as 
it resembles the real world usage in 
most cases. 

The image document is made up of 
many elements, with varying contrast 
and brightness areas. This document 
test the printers colour reproduction 
ability on a photo paper, so that the 
final output looks as striking and bril-
liant as that taken from a studio.

All the test files were printed for two 
different quality settings, except for the 
test image. The text and the combi-docu-
ment file were printed at Normal and Best 
quality settings, where as for the image 
file we used only the best quality settings.

  How We Tested
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and has the same low profile hori-
zontal design.  Samsung’s ML-2245 
is similar to ML-1640, but larger in 
dimensions. Canon’s LBP-1210 has 
been around for a while, and its 
bulbous design feels dated.   

Brother’s HL-2150N comes 
equipped with inbuilt Ethernet 
network support, apart from the 
ubiquitous USB. All other print-
ers offered only a USB 2.0 connec-
tor. Further, the HL-2150N comes 
with 16 MB of buffer memory as 
compared to 8 MB seen on the 
others. However, the higher mem-
ory doesn’t seem to help the HL-
2150N perform better. Canon’s 
LBP-1210 had a Parallel port and 
as we said, this is an old printer 
from Canon—it’s fast though. 

Brother’s HL-2150N and 
Canon’s LBP-1210 had dedicated 
paper trays, and hence could hold 
250 sheets. All the other print-
ers had standard 150-sheet capac-
ity trays. HP’s P1008 also has a 
substantial 100 page sheet feeder, 
whereas Canon’s LBP-1210 has a 10 
page manual sheet feeder. None 
of these printers had automatic 
dual-side printing support; it’s a 
feature which saves lot of paper.

Installing these printers was 
a breeze, and there were no 
problems. The driver interface is 
intuitive, and the settings can be 
changed without any fuss. There 
are pre-defined profiles which can 
be used with a single-click of the 
mouse. The driver allows exten-
sive control over the device and 
also gives full details on the toner 
and drum life in all printers. 

Performance
HP’s P1008 and P1007 set the per-
formance benchmarking by deliv-
ering the first print—9 seconds flat. 
This was observed in all tests we 
put these two babies throug—even 
when printing heavy documents, 
both the HP printers completed 

the job in just 13 seconds.In this 
speed run, Samsung’s ML-2245 
was just behind the HPs. Brother’s 
HL-2150N took slightly longer 
than the other printers when 
printing heavy documents; other-
wise its performance was on par 
with Samsung’s ML-2245. Canon, 
despite being an older model, com-
peted well with these new mod-
els, and was even faster than the 
Brother HL-2150N in some tests. 

In print quality, Samsung’s 
ML-2245 delivered sharp and well-
detailed printouts. The ML-2245 
was right up there with HP print-
ers in most of the tests, and scored 
even better in some. The only area 
where the Samsung was well and 
truly beaten by the HP was when 
reproducing light shades of grey. 
Brother’s HL-2150N delivered rea-
sonably good printouts. Canon’s 
LBP-1210 couldn’t compete with 
these new age printers, we think 
it’s about time Canon should pull 
the plug on the LBP-1210.

Samsung’s ML-2245 is sensibly 
priced and given its terrific per-
formance we award it our Best Buy 
award. HP’s Laserjet P1007 takes the 
coveted Editor’s Pick for its balanced 
package of good performance, 
acceptable features, sensible pric-
ing and terrific after sales support 
(unit level replacement and ready 
availability of consumables).

        
Small Work Group 
Laser Printers

Brother’s HL-2170W, Canon’s LBP-
3300, Samsung’s 2850D and HP’s 
1505 are the contenders in the small 
work group laser printer category.  

Features  
Let’s begin with Brother’s HL-
2170W. This was the only laser 

printer to offer maximum con-
nectivity options. It offers wire-
less connectivity via 802.11 b/g 
protocol and have Ethernet as 
well as USB 2.0. Setting up the 
Wi-Fi is easy and can be done via 
the settings panel, and can be 
secured using the strong WAP2 
protocol. Brother should consider 
offering a higher capacity paper 
cassette as optional though. 

Canon’s LBP-3300 has a ver-
tical design profile and hence 
requires less desk space. The base 
model doesn’t come with Ethernet 
but it is available as option. Dual-
side printing is offered as stan-
dard. The paper tray holds 250 
sheets, but with dual-side print-
ing one can print 500 pages. 

Samsung’s ML-2850D sports 
the familiar boxy design but the 
use of good looking materials 
gives it a pleasing look. Samsung 
offers optional 250 paper cassette 
and 128 MB memory upgrade.

The HP P1505 sports larger 
dimensions, but designed clev-
erly to look good on a desktop. 
The P1505 is the base version and 
comes with just 2 MB of memo-
ry, but the higher spec P1505n 
comes with 8 MB of memory and 
Ethernet inbuilt. 

Performance
HP’s P1505 took the performance 
crown in the speed test by deliver-
ing printouts at sensational speeds. 
First page came in record breaking 
6 seconds flat. The combi-docu-
ment which generally takes 14 sec-
ond to get printed was delivered 
in just 9 seconds.  Samsung’s ML-
2850D came in second place as far 
as speed is concerned and averaged 
about 10 seconds on various speed 
tests we put it through. Canon’s 
LBP-3300 and Brother’s HL-2170W 
were neck and neck, and in most 
of the tests Canon was ahead by 
small margin of 2 seconds.

HP continued its dominance in 
the print quality test too, delivering 
crisp printouts. Finer details were 
faithfully reproduced. The grey scale 
gradients. graphs, lines, concentric 
patterns were printed immaculately 
without jarring edges. Samsung’s 
ML-2850D was equally impressive as 
HP and delivered near sharp print-

outs. Canon’s LBP-3300 and brother 
were locked in a close battle for 
the printout quality too. In some 
test Brother was marginally ahead 
of the Canon and in some Canon 
dominated but none of these two 
could match HP or Samsung.

HP’s laserJet P1505 takes away 
the Best Buy award due to its ter-
rific performance and sensible pric-
ing, not to mention the wide after 
sales support HP has pan India. 
Samsung’s ML-2850D also makes a 
good buy if you are willing to spend 
a thousand more for the dual-side 
printing and future upgrades.

Inkjet Printers

Home & SOHO printers

Features
In this category we had six such 
products which fit our crite-
ria. Two printers each from HP, 
Canon and Epson.  

The Stylus T11 is the newest 
in the extensive range of printers 
from Epson and the cheapest print-
er available on the market. Neatly 
designed the exterior panels show 
no signs of cost cutting, in fact it 
looks upmarket and would defi-
nitely appeal to a large audience. 
Under the hood, the T11 comes 
with meagre 32KB of memory and 
it is USB 1.1 compatible; not the 
recipe for fast printing. 

HP 910 comes from the small 
cute looking series it had intro-
duced a couple of years ago, but 
still retains the charm. Compact, 
laced with right kind features the 
HP 910 surely makes for a good 
home printer atleast on paper. It 
has 384 KB of memory and inter-
faces using full speed USB 2.0. 

Canon’s iP2580 is the small-
est baby in the PIXMA range of 
printers known for their terrific 
print speed and equally impres-
sive print quality. The iP2580 is 
beautifully designed and the exte-
rior are classy for this category of 
products. The iP2580 uses Canon’s 
CAPT technology to good use and 
relies completely on your system 
memory for delivering printouts 
at unbelievable speeds. 

All three printers above are 
entry level devices from respec-

tive vendors and are devoid of any 
frills such as memory card read-
ers, PictBridge, direct CD printing, 
etc. Moving a step ahead we have 
Canon’s iP-3500, Epson’s Stylus 
C110 and HP’s PS-D5368 offering 
few more features which would 
appeal to the SoHo audience. 

Canon’s iP3500 is a step up 
from the entry level iP 2580, and 
offers some additional features. 
Designed in much the same way 
as other PIXMA range of print-
ers—boxy yet good looking due to 
use of translucent material. The 
iP-3500 also has dual paper path 
wherein paper can be fed from 
the top as well as the both cas-
sette. Auto dual-side printing fea-
ture isn’t available though. The 
printer is PictBridge compatible 
and interfaces via USB 2.0. 

HP’s PS D5368 as the 
name implies comes from the 
PhotoSmart series which are 

capable of printing photographs. 
Amongst the three printers here, 
the HP PS D5368 is loaded with 
utility features. First, it comes with 
a small LCD display which helps 
in printing photographs without 
connecting it to a PC. It has inbuilt 
memory card reader to do so, but 
doesn’t support PictBridge. Second 
it features dual-side printing and 
hence would save lot of paper in 
the longer run. Third, HP has pro-
vided a tray for printing directly 
in CD/DVD, albeit you need media 

which support direct printing. 
Epson’s C110 is the typical no 

non-sense office printer with the 
right mix of feature and perfor-
mance. We did like to see Epson 
to include dual side printing sup-
port for it to be the perfect office 
printer. Apart from faster print 
engine and more memory there 
is hardly any other feature it 
offers over the Stylus T11. 

Performance   
Coming to print speed, Canon’s 
iP2580 literally murders HP 910 
and Epson stylus T11. In some test 
such as the photograph printing, 
the difference is staggering—6 min-
utes to be precise. We have seen the 
PIXMA print engine blew the com-
petition away in our earliest test 
and hence this result wasn’t any 
surprise to us. Between HP 910 and 
Epson T11, HP is much speedier. In 
the photograph printing test the 
Epson stylus T11 took 9 minutes 
to deliver the printout, when HP 
910 did it in 5 minutes and Canon 
iP-2580 took just 3 minutes. One 
thing to remember though is these 
printers will rarely be used for such 
heavy printing. They are meant for 
light text and graphics. 

Image quality is HP’s play-
ground and the 910 doesn’t disap-
point. The text printouts are flaw-
less with hardly any jarring edges 
or smudges. The colour printouts 
are vibrant and saturation is per-
fect. The photograph we printed 
was reproduced as is with hardly 
any tonal deviation. Interestingly, 
Epson’s T11 does better job than 
Canon’s iP-2580, though both are 
equally matched when printing 
text, the same cannot be said when 
printing graphics. Overall, it was 
HP 910 which delivered exceptional 
results in the print quality test. 

In the SOHO category, Canon’s 
iP-3500 sets the benchmark for 
printing speed and delivers the 
fastest printout. However, in this 
category the other two contenders 
from HP and Epson are fast enough 
and are behind by smaller margins 
as compared to the home category 
of printers. Epson’s Stylus C110 is 
ahead of both Canon and HP when 
printing text documents, it’s only 
when printing large graphic files 
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Personal Laser Printers Small Workgroup Laser Printers

Brand
Model

Brother 
HL-2140

Canon
LBP 2900B

Samsung
ML-1640

Xerox
3117

Brother
HL-2150N

         Canon
       LBP-1210

HP
1007

HP
1008

Samsung 
ML-2245

Brother
HL-2170W

Canon
LBP-3300

Samsung 
ML-2850D

HP
P1505

Features 20.90 20.22 20.60 20.60 22.62 22.04 19.18 21.70 20.60 23.42 24.74 24.22 21.90

Performance 38.70 36.58 38.63 37.43 39.58 33.75 43.75 43.75 42.73 39.67 40.09 43.23 46.81

Price 5900 5995 5299 4704 9090 7195 6999 8299 6999 11810 13695 12999 11299

Warranty 1 Year 2 Year 1 Year 1 Year 1 Year 2 Year 1 Year 1 Year 1 Year 1 Year 2 Year 1 Year 1 Year

Pros Appealing design, fast 
printer

Fast printing speed Good overall 
performance

Affordable Networking built-in Parallel port present Compact and fast Fast and superb print 
quality

Reasonably priced Connectivity galore Appealing design Upgradable memory Terrific printing speed

Cons Larger footprint Small paper tray Nothing specific Nothing specific No Dual side printing Mediocre print quality NA No dual side printing No dual side printing Dual side printing missing Nothing specific None No dual side printing

Features (40%)

Print PPM 22 12 16 16 22 14 14 16 22 22 21 28 23

Resolution (dpi x dpi) 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600 600 x 600

Interface (USB, Parallel, Network 
etc)

USB 2.0 USB 2.0 USB 2.0 USB 2.0 USB 2.0, Ethernet USB 2.0 and parallel USB 2.0 USB 2.0 USB 2.0 USB 2.0, Ethernet, WiFi 
802.11 b/g

USB 2.0, Ethernet 
optional

USB 2.0 USB 2.0, Ethernet 
Available

Input buffer (Kbytes) 8 MB 2 MB 8 MB 8 MB 16 MB 2 MB 2 MB 8 MB 8 MB 32 MB 8 MB 32MB 2 MB

Buffer Memory Upgradeable / Up to NA NA NA NA NA NA NA NA NA NA NA 128 MB NA

Paper capacity (Input / Output) 250 / 100 150 / 100 150 / 100 150 / 100 250 / 100 250 / 125 150 / 100 150 / 100 150 / 100 250 / 100 250 / 65 250 / 150 250 / 150

 Eco-Mode 4 4 4 4 4 4 4 4 4 4 4 4 4

 Duplexing (Auto/ Manual) Manual Manual Manual Manual Manual Manual Manual Manual Manual Manual Auto Auto Manual

Usability (Printer settings, Driver 
interface, etc)

6.33 6.17 6.42 6.42 6.33 6.17 6.83 6.67 6.42 6.33 6.67 6.50 6.92

Data cable / Power Cord 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4

Troubleshooting guide 4 4 4 4 4 4 4 4 4 4 4 4 4

Quick setup guide 4 4 4 4 4 4 4 4 4 4 4 4 4

Performance (45%)

Speed test (in sec)

First Print out 11 10 11 11 11 11 9 9 10 11 11 10 6

Point Size Document at Normal 11 11 11 11 11 11 9 9 8 10 11 9 7

Point Size Document at Best 13 11 12 12 13 11 10 10 10 13 11 10 7

Combi document- Normal 15 14 14 14 16 13.5 11 11 14 16 14 12 10

Combi document-Best 16 13 15 15 16 14 13 13 14 16 14 14 9

Pie Chart 12 13 11 11 11 11 10 10 11 12 13 10 9

Line Graphs 12 11 12 12 12 11 10 10 11 12 11 10 9

Image Quality Test 

   Point Size Document 7.5 7.5 7.5 7.5 7 7 8 8 8 7 7.5 8 8

  Combi Document  (Normal & Best)

Text print 7 7 7 7 7.5 6 8 8 8 7.5 7 8 8

Resolution of circles on concentric 
pattern

6.5 6.5 7.5 7.5 7 5.5 7.5 7.5 8 7 7 8 8

Uniformity of colors in lines of con-
centric pattern

6.5 6.5 7 7 7 5.5 7.5 7.5 8 7 7.5 8 8.5

Seven color bars - how many dif-
ferentiated?

7.5 5 5.5 5.5 7.5 5.5 8.5 8.5 8 7.5 7 8 8.5

Yellow text on black background 6.5 4 7.5 7.5 7.5 6.5 8.5 8.5 7.5 7.5 7.5 7.5 8

Quality of small photo 6 6 6 6 6.5 5.5 6.5 6.5 6.5 6.5 6.5 6.5 6

Highlights on red berries 7.5 5 7 7 7.5 5.5 7.5 7.5 7 7.5 7.5 7 8

Details on fruit 7 6 7 7 7.5 5.5 8 8 7.5 7.5 7.5 7.5 7.5

Grille on the wooden plate 7 7 6 6 7 5.5 7.5 7.5 7 7 7 7 7.5

Minimum readable text point size 6.5 6.5 6.5 6.5 6.5 5.5 6 6 6.5 6.5 6.5 6.5 6.5

Image Quality Graph 

Pie Chart Saturation 7 7 6.5 6.5 7.5 5.5 8 8 8 7.5 7.5 8 8

Background colouration 6.5 6 6 6 7 5.5 7 7 7.5 7 7 7.5 7

Background Pattern 7.5 8 7.5 7.5 7 5.5 7.5 7.5 8 7 7 8 8

Line Details 7.5 7.5 7.5 7.5 7.5 5.5 7.5 7.5 7.5 7.5 7.5 7.5 7
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 Inkjet Printers Home Inkjet Printers   SoHo Inkjet Printers High-end  Inkjet Printers

Brand
Model

Canon 
Pixma iP2580

Epson 
Stylus T11

HP 
910

                     Canon 
                    iP3500

Epson 
Stylus C110

HP
Photosmart D5368

Canon 
iP4500

Epson
Photo R230

Epson 
Photo R290

HP
Photosmart D7268

Features 14.2 13.06 14.14 17.09 14.48 24.51 22.47 16.26 16.26 25.41
Performance 40.96 35.54 40.30 43.94 37.91 43.13 46.95 36.90 39.40 43.06
Price 3995 2199 4999 5995 5299 5599 7995 6999 8499 7199
Warranty 1 Year 2 Year 1 Year 1 Year 1 Year 1 Year 1 Year 1 Year 1 Year 1 Year
Pros Fast print engine Very Affordable Superb print quality Dual paper path Fast print engine In-built Dual side printing Very fast printer Good software bundle Relatively fast Loaded with features
Cons Mediocre Print Quaity Very Slow Pricey Relatively pricey Less features available Nothing specific No memory card reader Slow printer Photos lack punch No dual side printing
Features
Resolution (dpi x dpi) NA 5760 x 1440 4800 x 1200 4800 x 1200 5760 x 1440 4800 x 1200 9600 x 2400 5760 x 1440 5760 x 1440 4800 x 1200
Interface (USB, Parallel, Network etc) NA USB 1.1 USB 2.0 USB 2.0 USB 2.0 USB 2.0 USB 2.0 USB 2.0 USB 2.0 USB 2.0 , Ethernet
Input buffer (Kbytes) System Memory 32KB 384KB System RAM 64KB NA Systetm RAM 128 KB 64 KB 64 MB
Paper capacity (Input / Output ) 80 / 25 80 / 25 80 / 25 250 / 50 120 / 25 120 / 50 300 / 50 120 / 25 120 / 25 100 / 50
 Duplexing (both sides printing) 6 6 6 6 6 4 4 6 6 6

Photo-Printer specific
Display (Normal / Touch) 6 6 6 6 6 4 / Normal 6 6 6 Touch
Memory Card Reader 6 6 6 6 6 4 6 6 6 4

Pictbridge 6 6 6 4 6 6 4 4 6 4

Direct CD Printing 6 6 6 6 6 4 4 6 4 4

Data cable / Power Cord 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4 4 / 4
Troubleshooting guide 4 4 4 4 4 4 4 4 4 4

Quick setup guide 4 4 4 4 4 4 4 4 4 4

Usability (Installation, Driver Interface, printer set-
tings etc)

6.64 6.21 6.57 7.21 6.29 7.29 7.21 6.50 6.50 7.79

Software Bundle Printer Driver, Easy 
PhotoPrintEX, Solutions 
Menu, Adobe RGB,  MyPrinter

Epson EasyPrint Module, PIF 
designer, , Web-To-Page, Easy 
PhotoPrint,

HP Imaging Device Function, 
HP Solution Centre, HP 
Update, HP Drivers, Smart 
Web Printing, HP Photosmart 
Essentials

Printer Driver, Easy PhotoPrintEX, 
Solutions Menu, Adobe RGB, 
CDLabelPrint, MyPrinter

Epson EasyPrint Module, 
PIF designer, Epson 
PrintCD, Web-To-Page, Easy 
PhotoPrint, Print Image 
Framer, Epson Creative Suite

HP Imaging Device Function, 
HP Solution Centre, HP 
Update, HP Drivers, Smart 
Web Printing, HP Photosmart 
Essentials

Printer Driver, Easy 
PhotoPrintEX, Solutions 
Menu, Adobe RGB, 
CDLabelPrint, MyPrinter

Epson EasyPrint Module, 
PIF designer, Epson 
PrintCD, Web-To-Page, Easy 
PhotoPrint, Print Image 
Framer, Epson Creative Suite

Epson EasyPrint Module, 
PIF designer, Epson 
PrintCD, Web-To-Page, Easy 
PhotoPrint, Print Image 
Framer, Epson Creative Suite

HP Imaging Device Function, 
HP Solution Centre, HP 
Update, HP Drivers, Smart 
Web Printing, HP Photosmart 
Essentials

Performance
Speed Test (in sec)
First Print out 10 30 21 13 11 12 7 34 17 17
Point Size Document at Normal 7 25 20 7.7 11 13.5 6 30 15 16.12
Point Size Document at Best 28 80 94 26 22 37 16 30 25 21.75
Combi document- Normal 36 135 72 25.6 71 38 21 43 22 34.27
Combi document-Best 121 259 173 26.6 123 107 50 120 57 73
Photo Target 187 547 339 100 264 151 62 217 205 101
Image Quality Test  (Out of 10)
   Point Size Document 6.5 6.5 8.5 8 6.5 8.5 8 6.5 6.5 8
  Combi Document (Normal & Best)
Text print 8 6.5 8 8 6.5 8 8 6.5 6.5 8
Resolution of circles on concentric pattern 7.5 6.5 7 8 6.5 8 8 7 7 8
Uniformity of colors in lines of concentric pattern 7.5 7 7.5 8 7 8 8 7.5 7.5 8
Seven color bars - how many differentiated? 7 7.5 8 7.5 6.5 8.5 7.5 8 8 7
Yellow text on black background 7 6.5 6.5 8 7.5 6.5 8 5.5 5.5 6
Quality of small photo 5.5 6 6 6 6 6 6 6 6 6
Highlights on red berries 5.5 6 7 5.5 6 7 5.5 6 6 7
Details on fruit 6.5 7.5 8 6 6.5 8 6 6.5 6.5 7.5
Grille on the wooden plate 6.5 7.5 8 7 7.5 8 7 7.5 7.5 6
Minimum readable text point size 6.5 7 7 6.5 6 7 6.5 6 6 7
Image Quality (Photograph) 
Details on the motherboard 7.5 7.5 8 6.5 6.5 7 6.5 6.5 6.5 8.5
Details on the Pen stand 7.5 7.5 8 6.5 7.5 7 6.5 7 7 7
Details on the scale 7 6.5 8 7 6 7 7 6 6 8.5
Details on the Corn stalk 7 6 8 7 6.5 7 7 6.5 6.5 8
Refelection on the Binoculars 7.5 7.5 8 7 6.5 7 7 7 7 8
Translucent effect on the flower Vase 7 7.5 8 8 6.5 8 8 6.5 6.5 8.5
Refelction on the Flask 7 7.5 8 7.5 7.5 8 7.5 7.5 7.5 8
Human skin tone 6.5 6 8.5 6 6 8 6 6 6 8
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does it slid down. HP D5368 put 
up consistent performance across 
the tests and delivers printout with 
acceptable time limits. 

Coming to print quality, HP’s 
D5368 sets the benchmark for oth-
ers to follow. Be it text, graphics or 
photographs this printer delivers 
exceptional printouts which are 
faithful reproductions of their orig-
inal. The tonal balance was spot 
on with no over saturation seen 
in any colour. Finer details were 
also perfectly rendered. Canon’s iP-
3500 comes in at second place here 
displacing the Epson Stylus C110 to 
third place. Epson’s C110 does good 
job of reproducing the text and 
graphics, but looses out on tonal 
balance especially in the graph-
ics test. Otherwise it is as good as 
Canon’s iP3500.

If you want the cheapest and 
basic printer for printing noth-
ing but documents then Epson’s 
Stylus T11 should 
be in your list. HP 
910, Canon iP2580, 
Epson Stylus C110 
and Canon iP3500 
are good printers, 
but nothing quite 
beats HP Photosmart 
D5368. It has all the 
features you can ask 
from a printer and 
is versatile at doing 
many things, plus the pricing is just 
perfect. We suggest HP’s PhotoSmart 
D5368 as the ultimate Home/SoHo 
printer and give it the Best Buy as 
well as the Editor’s Pick award.     

Photo Printers   
In this category we have grouped 
together photo printers from 
HP, Canon, and Epson. Though 
termed as photo printers they 
can also be used for general 
purpose printing too. Canon’s 
iP-4500, Epson’s R230 and R290 
and HP’s PS D7268 were the con-
tenders here. 

Features
On paper, HP’s D7268 has an impres-
sive list of features for a Photo print-
er. It has a small touch sensitive 
LCD panel which allows the printer 
to be used for printing photographs 
without a PC. The inbuilt memory 
card reader helps in this matter too. 
The printer is PictBridge compliant 
and hence digital cameras can be 
directly connected to it. It comes 
with a separate tray for printing 
directly on a CD/DVD. The D7268 

has inbuilt Ethernet and 
came be connected directly 
using the USB 2.0 interface. 
The only thing missing is 
dual side printing.

Canon’s iP-4500 comes 
from the same PIXMA series 
but has features which 
defines it as a photo printer. 
Unlike HP it doesn’t have any 
LCD panel or memory card 
reader, but is PictBridge com-

pliant and can also print to CD/DVD 
directly. It has dual-paper path and 
the combined capacity equals 300 
sheets. The iP-4500 also offer auto 
dual side printing. 

Epson’s R290 and R230 are 
from the same series; R230 is an 
old model. While the R230 sport-
ed contoured design, the R290 is 
boxy, but appealing. Both these 
printers are positioned by Epson 
as photo printer based on the 
fact that they use more than 
three ink cartridges to improve 
colour gamut. But none of the 
features present in HP or Canon 

is made available here, which 
is a serious drawback for both 
these printers. 

Performance      
You guessed it right! Canon’s iP-
4500 simply blows the competi-
tion away when it comes to print-
ing speed. It retains its speed 
advantage across the various tests 
we put it through. Be it text, 
graphics, photographs or large 
files it just prints them instantly.  

HP D7268 and Epson R290 are 
neck and neck returning similar 
timing at least in the text docu-
ment test. In the graphics and 
photograph test HP surges ahead 
of the R290 which takes more time 
to complete the job. The Epson 
R230 gets left behind in almost 
all the tests. We thought it would 
be because its an older model and 
competing with the latest would 
always be a challenge.

In the print quality test, HP’s 
D7268 and Canon’s iP-4500 were 
lugging it out. Both these printers 
were exceptional in printing text 
and on par with each other. But 
in the combi-document, the finer 
differences between the two started 
appearing. Finer details were ami-
cably reproduced by both printers. 
Canon has a slight advantage in 
the colour gamut test and was able 
to reproduce all colour and their 
gradients. In the photograph test, 
it was HP’s D7268 who took the 
lead by reproducing a flawless pho-
tograph. The tonal accuracy was 
superb and the photograph came 
out stunning. Canon’s printout was 
near as good but the photograph 
had a warm tone to it. Epson’s 
R230 and R290 did reproduce good 
prints but their performance was 
completely overshadowed by HP 
and Canon’s performance.

If you are looking at an afford-
able photo printer then HP’s 
PhotoSmart D7268 is better 
equipped in terms of features to 
handle you needs. The Epson print-
ers are too basic and the Canon 
iP4500 does deliver great results 
but doesn’t have the feature list 
HP’s D7268 offers. For this very 
reason we give the HP PhotoSmart 
D7268 our Best Buy award.  

sanket.naik@thinkdigit.com
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ing task force (IETF) signaling protocol for global,
interoperable real-time communications. With
SIP, IP telephony becomes as simple to use as a
Web application integrates easily into other
Internet services.

To accommodate spontaneous and sched-
uled business transactions, corporations go in
for audio conferencing that has the capability
to handle communication needs ranging from
brainstorming sessions to online meetings. But
for situations where presentations are a neces-
sity, a visual collaboration technology called
Web conferencing is essential. This brings an
in-person experience by enabling a collabora-
tive visual environment with tools such as
shared whiteboard. 

Chat tools give the ability to manage col-
laboration. It aids in sharing of PC applications
such as presentations, documents among the
participants. These audio and Web conferenc-
ing solutions employ the existing devices such
as telephone and personal computers connect-
ed to the Internet. 

To eliminate scheduling and managing
dual conferences, the business community
uses integrated conferencing solutions that
incorporate both audio and Web capabilities
giving a seamless conferencing experience.
Video conferencing solutions give the user a
virtual environment for face-to-face contact in
addition to the capabilities offered by audio
and Web conferencing software.

Streaming media facilitates one-to-many
business communications. Multipoint confer-
encing solutions add the ability to extend the
reach of communication across multiple loca-
tions. It supports continuous presence, camera
switching to enable people to see everyone on a
multipoint call. The technology is becoming the
best solution for meetings, online education,
training, conferences, etc.

Technology Myths
Some common misconceptions about enterprise
communication technologies, are now being
addressed due to the technical advancements: 

Hitch In Moving From TDM To Pure-IP
Contact centers, which have already invested in
TDM infrastructure, used to consider investing
in pure-IP strategy as an unfruitful investment
and a waste of resources. However, pure-IP does
not mean scrapping legacy circuit switched
products. It rather ensures the smooth migra-
tion, leveraging existing infrastructure with
gradual change to a pure-IP network. This mis-
conception supports the hybrid-IP approach.
However, many contact centers will find that
introducing a hybrid-IP approach will in fact
lead to a longer migration to IP and at a greater
expense for the contact center.
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Enterprises today are confronted with an
array of responsibilities with a pressing
need to communicate regularly with

employees, customers, partners, suppliers and
shareholders. Ubiquity is a bedrock value in com-
munication technologies. The advances in tech-
nology have changed the fabric of the business
community—getting woven into every thread.

Changes in business perspective have neces-
sitated organisations to manage time and busi-
ness relationships globally. An array of technolo-
gies such as e-mail, SMS, fax, pager, voicemail,
conferencing solutions, streaming media and
instant messaging help in communication.
Guaranteed service acknowledgement as offered
by FedEx has enhanced traditional features and
capabilities of snail mail. 

Organisations today have moved from tradi-
tional private branch exchange (PBX) systems to
IP-PBX system in search of greater value.
Organisations wanting to address their com-
pelling business issues have switched to Internet
telephony. It offers transporting communication
services such as voice, facsimile and voice messag-
ing applications via the Internet, rather than over
the public switched telephone network (PSTN). 

E-mail has been the dominant group work-
ing application. It is dominated by open stan-
dards such as simple mail transfer protocol
(SMTP), Internet message access protocols
(IMAP), post office protocol (POP3). SMTP con-
trols delivery to the server. IMAP allows a client
to access a server that stores all e-mail folders
centrally; POP3 requires users to download and

manage their messages locally. The Business
community has realised the problems with this
form of communication with the rapid increase
in the number of e-mail users. E-mail is inher-
ently inefficient as much content is duplicated.
There is a migration towards highly distributed
common discussion group platform such as
Usenet News to resolve these problems. This
presents a threaded view display with direct ref-
erence to all the messages. 

To reap business benefits in terms of cost and
productivity is to communicate ideas among
people through Groupware. Groupware works
by delivering messages in a structured manner
with varying degrees of privacy and priority.
Corporations have shifted to solutions such as
Digital Equipment Corporation (DEC) Notes,
Lotus Notes, Novell’s GroupWise and Microsoft
Exchange that provide better security and struc-
tured content delivery to appropriate groups in
contrast to e-mail lists. 

Facilitating dynamic group creations, peer-
to-peer (P2P) communication and others, require
that the communication solutions support
mobile workgroup, location sensitivity and
telephony support. To add flavor to the group-
ware is the standard session initiation protocol
(SIP) and SIP for instant messaging and presence
leveraging extensions (SIMPLE). These messaging
protocols work along with instant messaging
and presence protocol (IMPP) to present a global-
ly accepted standard for instant messaging solu-
tions such as MSN Messenger, Yahoo! IM. Session
Initiation Protocol (SIP) is the Internet engineer-

Around The World
In Real Time

Advances in
technology are
enabling
organizations to
communicate
faster to
address their
business needs

Digital Business l Communication Technologies



100 DIGIT SEPTEMBER 2008

Digital Business l Communication Technologies

Lack Of Reliability
A common misconception about pure-IP contact
centers is their lack of reliability. However, in the
last couple of years, service providers of packet
switched data communications services have
been successfully able to come out with robust
and redundant infrastructure, providing highly
reliable service. Wicom’s contact center solution
is worth mentioning here.

Poor Voice Quality
Another broad misconception has been of poor
voice quality in a pure-IP environment. But that
is not true, as many contact centers utilising
pure-IP technology have reported excellent
voice quality, which can be compared to TDM
service. For enterprises, pure-IP comes in the
form of a managed corporate network, not the
public Internet, which still remains question-
able for voice traffic.

Scalability Issues
In the past, due to the immaturity of voice over
IP (VoIP), scalability was an issue for IP contact
centers. Now with pure-IP technology, contact
centers are able to quickly and efficiently scale
up or down as needed on a site-by-site basis.

Technology Application Areas
Each industry vertical taps the potential of an
enterprise communication technology differ-
ently. The following are a few examples:

Healthcare
The clinical departments can collaborate togeth-
er without the constraints of conflicting sched-
ules. Online meetings help them manage project
communication and collaborations among the
physicians, employees, vendors and contractors.
Organisational communication and collabora-
tion solutions offer the healthcare workers full
mobility. By sharing medical resources available

in a central repository, skilled physicians provide
their diagnostic assistance to remote areas. It is
now possible to systematically track projects. 

Healthcare departments manage scarce
resources, making cost reduction for labour and
for voice and data communications an essential
aspect. IP telephony offers a proven path for cost
reduction in communication. 

Call Center
Person-to-person communication through IP
enables enterprises of all sizes to increase rev-
enues and reduce costs. Customer service agents
who are physically distributed provide a cen-
tralised service offering better resource utilisa-
tion and business flexibility. It helps balance
demand across time and locations. Location inde-
pendence functionality helps match the needs of
every person, function and service.

Education
Collaboration between distributed scientists and
researchers throughout the world is possible.
Today, students and professionals participate in
online discussions and classrooms. 

Banking And Finance
The unified mode to receive voice, video and data
enhances productivity of sedentary and on-the-
fly staff. It reduces maintenance costs by manag-
ing a single, integrated voice, video and data net-
work in a central location, rather than maintain-
ing separate voice and data networks in many
locations. It enhances customer experience by
decreasing their idle time, provides customised
value-added services after customer identifica-
tion, bridges a communication channel between
the customer and the expert advisors, and makes
services available in the most remote locations. 

IP Conferencing helps easy connectivity to
pioneers across the bank channels. It also
improves employee satisfaction—provides ease of
connectivity to people after detecting their avail-
ability, reduces time spent in unsuccessful
attempts, employee education enables them
to understand the service and thereby resolve
issues effectively. IBM enhanced enterprise com-
munication solution for the banking sector is a
noteworthy technology here.

Others
Software companies, real estate, government,
industrial and retail resort to communication
technologies to empower on-the-fly and dis-
tributed decision makers and to make collabo-
rative communications in real-time.
Information Technology departments, media
firms, brokerage houses, financial institutions
use instant messaging tools to notify employ-
ees, customers and others, and implement
group communications and messaging. n

Video conferencing
solutions create an
environment for
face-to-face
communication
along with the
capabilities offered
by audio and Web
conferencing
software

The following are the two most important benefits that can be extracted
from the advanced software packages available in this domain.
Business Continuity And Desktop Productivity
Deployment of emergency notification and escalation services help locate
any person, any group, anywhere, at any time, and at the same time
deliver alerts and strategic intelligent information simultaneously across
virtually every available communications device. It is possible to deliver
high-speed acknowledged communications via landline, cell phone, e-mail,
pagers, SMS, fax and satellite phone to individuals, employee desktops.
Emergency Operations
In case of unavailability, it is now possible for emergency departments to
contact the emergency worker through phone, e-mail, and pager and organise
an interactive mode of channel so as to ensure service by him. Emergency
operation centers are able to provide better service since messages are
tailored to the first responders with specific expertise. It effectively speeds up
and enhances quality and reliability of communication.

Technology Adoption Benefits
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pay less, a stop-gap arrangement before jump-
ing to greener pastures. In fact, even lecturers
and principals are jumping to industrial jobs as
they are better paying.”

An HR team confirmed this view in a pres-
entation that it made to its management. The
company is a leading automotive components
maker in Chennai. Many candidates recruited
from leading institutions stay for an year or
two, pick up the tricks of the trade and move on
to more lucrative jobs.

Picking students from the not-so-top class
institutes is a dicey affair as there is the ever-
present question raised about the quality of
education imparted. The well-known capita-
tion fee structure does nothing to dispel the
misgivings.

Down Memory Lane
Technical education in India has a rich history,
starting with the first survey school in 1794,
near Fort St George in Chennai, with eight stu-
dents. Now it’s well known as the Guindy
Engineering College. A modest beginning, but
by no way insignificant, and by independence,
there were over 12,000 students admitted to the
engineering colleges.

The Technical Education of Central
Advisory Board of Education, 1943, envisaged:
“The primary function of technical instruction
remains, and is likely to remain, that of satisfy-
ing the needs of industry and commerce for a)
skilled craftsmen, b) intelligent foremen and
executives, and c) research workers.” It includes
engineering, pharma, applied arts, MBA, MCA
and similar professional courses.

Post-independence, the first breakthrough
in education happened with the setting up of
the Indian Institutes of Technology (IIT), con-
ceived by Prime Minister, Pt Jawaharlal Nehru,
and set up in 1950 in Calcutta—later shifted to
Kharagpur—and called the Eastern Higher
Technical Institute. It was called IIT just before
the inauguration in 1951. The other IITs were
in Bombay (1958), Madras (1959), Kanpur
(1960), Delhi (1963) and Guwahati (1995). The
first management institute came around this
time, in 1954, and was called the Indian

Institute of Social Welfare and Business
Management, in Calcutta.

Private institutions
Post liberalisation, education was freed and
private institutions started coming up, espe-
cially in Maharashtra, Tamil Nadu, Karnataka
and Andhra Pradesh. Even today, these states
easily take the lead in the number of institu-
tions and the number of students graduating
each year. While initially the purpose of these
institutions was envisaged as charitable,
today profit making is recognised as the goal
of the private-run institutions, which has also
thrown up questions of the quality of educa-
tion imparted.

Technical Education Administration
One of the problems faced by the industry
today is the lack of uniformity in technical
education, as different institutions are run
differently. There are the institutions run by
the central and state governments, the univer-
sities, the deemed-to-be-universities and pri-
vate institutions. 

The Central government runs its institu-
tions through the Bureau of Technical
Education under the Ministry for Human
Resources, the UGC and the AICTE. It is respon-
sible for policy formulation, funding AICTE,
University Grants Commission (UGC) and
national institutes, partial funding of RECs,
training and paying stipends to
graduates/diploma holders under the
Apprenticeship Act, to teachers for training in
industry, linking institutions with foreign
agencies for developmental activities, etc.

The UGC allocates funds for maintenance
and development to universities.

AICTE, instituted in 1945 as an advisory
body, takes care of planning, formulation and
maintenance of norms and standards, accredi-
tation, funding of priority areas, monitoring
and evaluation of institutions, maintaining
parity of certification and awards and ensuring
the coordinated and integrated development of
technical and management education. AICTE
looks at the development needs, coordinates
development, allocates and disburses funds for
technical education, promotes research, etc. It
also accredits colleges through the National
Bureau of Accreditation (NBA).

The state government runs its technical
institutes through the Directorate of Technical
Education (DTE) and State Board of Technical
Education. While the DTE is responsible for
development of technical education, manpower
forecast, curriculum design, starting, new insti-
tutions, budgeting and human resource devel-
opment, the State Board undertakes policy pan-
ning, formulations and approval of curriculum,

Meeting The Chinese Challenge

This is a reality that cannot be ignored. China has improved its
infrastructure and lifestyle to meet the global needs. In a recent visit
to India, the Chinese premier visited the IITs and IISc. “No doubt, this
was to emulate the education system followed by these institutions.
And what India is doing in small numbers, China will replicate in
hundreds. We have but five years before the Chinese catch up,” said
Kiran Karnik, President, NASSCOM. “Unless the education system in
India is revamped dramatically, India cannot retain the advantage it
has today,” he added, voicing the concern of many.

“The study of the scientific methods and principles
underlying the practice of any handicraft, industry or
profession; and the application of those methods and
principles of the handicraft, industry, or profession in
question. The first is the primary or technological
aspect of the subject; the second is its subsequent and
practical application.”
— 1901, Lord Curzon, the then Viceroy of India.

India produces over eight lakh graduates and
diplomas in professional degrees, from over
four thousand approved institutes. Yet,

there is an acute shortage of the right man-
power across industries. A severe attrition prob-
lem exists in many industries other than IT;
from the candidate’s side, there is the ever-
looming prospect of unemployment and under-

employment. Typically, the graduation certifi-
cate needs an additional certificate that stu-
dents get independently of their college educa-
tion—like in IT or management—to find the
right job. With campus interviews—the trend
not just in the IIMs and the IITs, but even in
other universities—the gap between the indus-
trial HR needs and the qualification of the pas-
souts has come to the fore.

Typically, soft skills are most conspicuous
in their absence. The stress now is more and
more on the need for emotional quotient
rather than just the IQ. R Guhan, Country
Manager, JobsDB.com says, “Communication
and commitment are problems that most com-
panies face while recruiting. The salary expec-
tations are high. And, employees treat jobs that

Uniformity in
technical
education and
not the English 
language alone
will help India
win the race to
become a global
destination for
bagging
contracts

Revamping The 
Technical Education System
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The growing dependence of information
technology in modern society has created
new vulnerabilities. Breaches in informa-

tion security can have grim consequences.  
The spectrum of products and procedures

aimed at providing information security is vast.
One of the most common and useful technolo-
gies is encryption.

This report provides current information on
encryption and other emerging technologies
and trends driving the development of new
information security products, applications,
and markets.

Encryption provides a secure communica-
tion channel even when the underlying system
and network infrastructure is not secure. This
is important when data passes through shared
systems or network segments where many peo-
ple may have access to the information. In these
situations, sensitive data and passwords should
be encrypted in order to protect them from
unintended disclosure or modification. 

Key Factors Affecting The
Encryption Marketplace
Many organisations have produced encryption
products, which include software, services,
servers, and consulting. The market segments
vary from PC users, to financial institutions to

military and government. Several approaches to
encryption have been developed but there are
substantial barriers to widespread deployment.
For example, there are many different and
incompatible encryption techniques available,
and not all the software needed implements a
common approach. Effective use of encryption
requires vendors to agree on methods and stan-
dards. Two different cryptographic methods are
being applied to computer security problems:
private-key and public-key encryption. 

The general public is concerned about access
to private information. In many countries, there
is already strong and public debate about both
data security and secrecy. Many experts say that
security concerns of the average home comput-
er user are unfounded, although the public at
large has not been very well informed to date.
Improvements in security provided by public-
key cryptography and other encryption systems
are actually already providing much higher
security than existed before, and public educa-
tion will go a long way to addressing this issue. 

Relatively weak encryption appears to have
been used to protect files recovered from two
computers believed to have belonged to Al-
Qaeda operatives in Afghanistan. The files were
found on a laptop and desktop computer
bought by Wall Street Journal reporters from

How Secure Are You?

Encryption and
other
information
security
technologies 
are receiving
heightened
attention now,
thereby driving 
the development
of new
information
security
products, 
applications,
and markets 

diploma/certificate exams, quality approval
and other development activities.

Together, there are the government-run
universities, the IITs and IIMs, the RECs that
are partly government-funded and the private
institutions—all with different management
and administration.

The other problem, which has come to the
fore with Tamil Nadu’s doing away with the
Common Admission Test, is the different
selection procedures for each of the institu-
tions or group of institutions—so there is JEE
for the IITs, CAT for the RECs, state level
exams for the state level colleges, GATE for
the MTechs and so on.

Challenges 
“It is a myth that only the premium institu-
tions are producing the best; there are many
institutes doing a good job,” asserts Arulmani,
Head of HR and Administration, Igarashi
Motors. However, there are miles to go before
the institutes can rest. Shortage of staff, and
high-quality staff at that, is the recurrent
theme in the technical education scenario in
India. There are not enough qualified teach-
ers. The IITs produce 60 per cent of the MTechs
and 75 per cent of the PhDs today. Better pay at
the industry and the lure of the industrial
experience, in addition to the famed brain
drain to the western countries, are a common
cause for concern. The other recent develop-
ment, the boom in the ITeS market and their
need for graduates from any stream (employ-
ment has grown from 284,000 in 1999-2000 to
1 million in 2004-2005) has led to many bright
students being pulled away to work instead of
pursuit of education.

The government, too, since the Fourth Five-
Year Plan, has shifted its focus away from tech-
nical education to elementary and adult educa-
tion, with a result that only Rs 100 crore has
been allocated for technical education.

A weak R&D culture, poor manpower plan-
ning, almost negligent linkage with the indus-
try, poor participation of women and slow
response to changes threaten to weaken the
technical education scenario in the country.

Initiatives
The need of the hour is action. China is a real
threat. A professor from Purdue University
mentioned at an HR Summit conducted by
NASSCOM recently that engineers coming from
China are almost as good as those graduating
from the IITs. And, unless there is uniformity
across all colleges, the English language alone
will not help India become a global destination
for bagging contracts.

Recognising this, the NBA was created in
1987 to certify the quality of the institutions.

Any institute that has functioned for five years
can apply for this. The rate of accreditation in
the country currently is low, says Nath, with
just 200 of the existing 5,000 colleges having
been given the status. Infrastructure and man-
power limitations at the AICTE themselves are
a major concern in this regard. “Of course, stu-
dents prefer word of mouth and the past per-
formance of the institutions before they
apply.” However, what also needs to be
addressed, in this context, is the huge capita-
tion fee charged by the institutes and not
reported by students. 

NASSCOM, recognising the lacunae in the
Indian technical education system, has signed
up with AICTE for a faculty development pro-
gram in the IT sector, in partnership with the
IT industry. Such initiatives are needed across
streams and industries. Says Kiran Karnik,
President, NASSCOM, “The industry can play a
major role in ensuring that the curriculum is
up-to-date and relevant by sharing trends,
likely future developments and the require-
ment of skill-sets.” As part of the memoran-
dum of understanding (MoU) signed between
the two, NASSCOM and AICTE will jointly
undertake curriculum review, develop train-
ing modules, develop a database of engineer-
ing and management colleges across the
country and study international models for
industry-academia partnership.

Nath also suggests that for improving the
communication skills of the students, it
would be a good idea to follow the REC model
of admitting students from rest of the country
also. “A mix of students from different regions
will mean more interactions, a broadening of
perspectives and better communication
skills,” he suggests.

Retention: The Bane
The IT industry’s retention problems are well
known. But, this industry itself has added to
the retention problem of other industries as
the demand for functional experts is growing.
With better pays, that is a lure difficult to over-
come. But some of the retention tactics appli-
cable to the IT industry are applicable here too:
Creating a conducive work atmosphere, pro-
viding the scope to innovate, delegating
responsibilities, changing personal success
symbols from just monetary rewards to roles
and responsibilities and retraining and
enhancing skill sets. 

In the modern world, no job is for life and
loyalty to the employer has been replaced by
loyalty to the designation or job role.
Recognising this is of utmost importance and
approaching HR problems in this perspective
will be helpful in better attraction and reten-
tion of employees. n

One of the
problems faced by
the industry today, 
is the lack of
uniformity in
technical
education, as 
different
institutions are
run differently
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As IT organisations face greater pressure
to manage, store, and retrieve increas-
ing amounts of corporate information,

they are searching for new ways to keep data
readily available, whenever and wherever
needed. To support the requirement for
Business Continuity and Availability (some-
times referred to as ‘BC&A’), there are a wide
variety of solutions available in the industry
for various kinds of organisations. To name a
few, cluster solutions, replication solutions
and to some extent backup and recovery solu-
tions qualify as BC&A solutions based on the
requirement of the business.

For business requirements one solution
which stands out and provides the most
secure and robust mechanisms of data repli-
cation and availability of applications is stor-
age-based replication. Based on the industry
standard Fiber Channel (FC) protocol, this
mechanism is the default choice for busi-
nesses today.

In a typical scenario, the infrastructure
would comprise of servers, SANs, storage sub-
systems and IP networks for connectivity to
the information islands. To achieve a true
Disaster Recovery (DR) capability, the same
and scaled down version of infrastructure has
to be maintained at the DR site as well. So,
there would be a set of servers in production
using the production copy of data at the pri-
mary site and another set of servers at the
DR/BC site waiting for the primary servers/site
to fail. The servers on DR site can also be used
in active-active configurations where these
servers are performing some other computing
tasks for the organisation.

To achieve Business Continuity and
Disaster Recovery (BCP/DR), each one of these
components has to be taken into considera-
tion and robust methodologies applied to
each component. Storage Area Networks and
storage subsystems at the core of this infra-
structure require special attention. For con-
nectivity requirements between two sites

refer to Figure 1 which states the technologies
available and where they best fit. Other than
the link between the sites, such technologies
would essentially require SAN infrastructure,
storage subsystems with licensed replication
software (like PPRC, SRDF, True Copy,
Continuous Access) and routers which would
do long distance propagation and protocol
conversion, if needed.

Long-distance SAN extension works on the
storage-based replication of the storage sub-
systems and requires interconnects which
can propagate the FC protocol over long dis-
tances. This propagation can be done in
native FC protocol or by converting FC into IP
and sending the signal over infinite dis-
tances. Although long distance FC connectiv-
ity is generally the most reliable, organisa-
tions sometimes prefer to send FC over exist-
ing long-distance IP links to take advantage
of existing IP infrastructure. 

It is essential to consider future needs
when choosing the appropriate technology.

Today, the most common approach and
also the most logical approach towards build-
ing a DR practice is to build a BC site not very
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looters in Kabul a few days after it was captured
by Northern Alliance forces on November 13.
The files provide information about reconnais-
sance missions to Europe and the Middle East.
A report in the UK’s Independent newspaper
indicates that the encryption used to protect
these files had been significantly weakened by
US export restrictions that existed until last
year. The files were reportedly stored using
Microsoft’s Windows 2000 operating system
and protected from unauthorised access using
the Encrypting File System (EFS), which comes
as standard on this platform. They were pro-
tected with a 40-bit Data Encryption Standard
(DES), according to the Independent’s report. 

This was the maximum strength encryp-
tion allowed for export by US law until March
2001. All systems are now sold with the stan-
dard 128-bit key encryption, exponentially
stronger than 40-bit. 

The Competitors
The computer-security market is rapidly coalesc-
ing around a few big players, including firewall
leaders Check Point and NetScreen, and anti-
virus company, Symantec. In this down econo-
my, smaller companies that may have better
technology, but less staying power are strug-
gling to land clients. Often, it’s hard for them to
attract big customers who need assurance that a
supplier will be around to support its product.

Competition is strong among the big name
vendors. Cisco Systems has gained ground on sev-
eral key server rivals, such as Juniper Networks,
during this tech spending downturn. Cisco has
been a big player in firewalls, intrusion-detection
systems (IDS), and virtual private networks (VPNs)
that use encryption to secure remote connec-
tions to corporate computer systems.

A VPN is a means by which certain autho-
rised individuals (such as remote employees)
have secure access to an organisation’s
intranet, by means of an extranet (a part of the
internal network that is accessible via the
Internet). VPN can be far less expensive than
using actual private lines in a wide area net-
work (WAN). VPNs can be strictly software, but
most often they are hardware devices.

Customers would like to buy more than one
security solution from a single company rather
than piece together the products of several sup-
pliers. Venture capitalists put $1.6 billion into
140 computer-security startups during 2000.
That fell 38 percent to $990 million invested in
100 startups, during 2001. In 2002, some 60
startups received less than $500 million
through the first three quarters. 

In 2001, corporations spent on an average 3
per cent of their tech budgets on security. Many
analysts are expecting this market to grow to
$15 billion 2006 from what was $6 billion in

2001. Over the next 10 years, markets for fire-
walls and VPNs, both relatively mature prod-
ucts, should grow at rates above 10 per cent.

On the leading edge, in areas such as wire-
less security, competition is especially fierce.
Startups that build security options for cell
phones and wireless local area networks are
competing with established players such as
Check Point and General Dynamics for a mar-
ket that is still more promise than a reality.

Products Offered
Faster growth is expected from advanced forms
of protection, such as intrusion detection, and
tools that protect specific applications on cor-
porate networks and vulnerability-assessment
software and services. An Intrusion Detection
System (IDS) inspects all inbound and outbound
network activity and identifies suspicious pat-
terns that may indicate a network or system
attack from someone attempting to break into
or compromise a system. This trend should con-
tinue for the next few years as more companies
add IDS to their existing security infrastructure
and the technology becomes easier to use.

Vulnerability assessment involves engaging
tech experts to check a corporate network’s
security by probing and testing it. The market
for this service was $500 million in 2002, with
sales of automated diagnostic tools probably
making up 10 per cent of the total. Annual vul-
nerability checks by humans can cost as much
as $150 each. The same amount or less can buy
multiple checks using automated systems. 

Another growth area is protecting servers
and desktop machines. Most companies, large
and small, now use some form of perimeter fire-
wall protection to protect their networks com-
bined with antivirus software on mail servers
and individual desktops. In fact, corporate
antivirus software alone will be a $2.7 billion
market by 2006, up from $1.2 billion in 2001. 

From a security company’s viewpoint,
antivirus protection is not enough. Desktop
firewalls are mandatory for many companies,
leading to big deals for suppliers such as San
Francisco-area companies ZoneLabs and
Sygate. Both these companies have gotten big
venture financing in recent months—proof
that investors believe the market is ripe for
these products. 

The wireless LAN (WLAN) industry is experi-
encing tremendous growth aided by lower pric-
ing points and standardisation of the technology.
Analysts believe that this growth will continue to
accelerate, all the multi-billion dollar technology
and telecommunications companies such as
Microsoft, Intel, Dell, AT&T, and IBM, to name a
few, enter the WLAN industry. These corpora-
tions bring their deep financial pockets and mil-
lions of consumers to the WLAN industry. n
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ed data (or some of them are already doing it
while replicating data) and ensure that each
byte transferred is referable by the applica-
tion servers on the DR site.

There is intelligence built into the storage
sub systems which allows them to change the
state of the data volumes at DR site from
read-only to read-write enabled. This is neces-
sary as the copy of data would be the produc-
tion copy for applications until the primary
site comes up.

Geographically dispersed cluster solutions
play a vital part in such implementation as
they sense the failure on the primary site and
then take corrective action by mounting the
volumes onto the servers on the DR site and
firing up the applications.

The storage subsystem and replication
utility ensure consistency; the cluster soft-
ware along with volume managers ensures
that this particular DR copy of data is consis-
tently accessible to the servers and ready to be
accessed by applications.

A financial organisation in Mumbai repli-
cates its data to an alternate site, about two
kilometers away, and has a full facility where
key application users can come and sit on net-
worked PCs and start working. As soon as they
log on to the network, their profiles, applica-
tions and permissions are restored to that PC
and they continue to work seamlessly. Testing
has made it possible for this system to work all
the time and more so at the time of disaster.

To summarise, many customers in India
have got on to DR implementations and few
others have successfully completed their proj-
ects as well. Implementing DR requires
expertise from various areas of IT infrastruc-
ture; each one of these functional experts
play a vital role in the success of the project.

The key to running a resilient IT setup is to
implement DR practices, training the team
members and making them aware of their
roles and responsibilities. To implement and
depend on DR/BC plans, a perpetual test
process is absolutely necessary. n
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far from the production site and then from
thereon build a seismically distant DR site.
Refer to Figure 2.

The major advantage of this approach is
that companies don’t have to invest in redun-
dant infrastructure and high cost links from
day one. As and when business grows and
demands another level of protection, DR sites
can be built. However, there are some compa-
nies especially in the telecom and finance
industries, which have invested in a complete
DR site from day one. It is the business—rather
the business impact in case of disaster—which
defines the level of redundancy and justifies
the case for two stage DR (multi hop DR sites)
or a single stage mirror site.

Also, latencies of the networks involved
play a vital role in achieving DR and BC. If the
latencies are high and bandwidth is less then
replications that are not in sync are general-
ly proposed and implemented. This is also a
function of qualification from vendors for
different links and the acceptable latencies
for their replication technology.   While stor-
age based replication software manages the
data replication at block level from the stor-
age sub systems, the application servers con-
tinue to access data non-disruptively and
work on the local copy of data, i.e. the data
residing in the storage on the local site.
While making a decision for storage based

utilities and storage sub systems, the organi-
sation should ensure that these replication
utilities are certified with the applications or
databases they wish to replicate over to
another site.

This certification merely ensures that the
bits and bytes replicated would be consistent
when they arrive at the DR site storage. These
utilities are storage controller based and take
the I/O load off the servers.

Now, imagine a scenario when disaster
strikes. The applications and servers lose con-
nectivity with the production copy of data
(there is a high chance that servers are also
down). At this moment, the replication utili-
ties start a consistency check on the replicat-
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Summary Of Solution And Best-Fit Scenarios

Full performance is required and supported distances is 80 to 100 kilometers or less.
Optical cables are in place between the sites, or budget is available to install/lease
cabling. Fibre channel switches and/or routers on each end have enhanced buffer-to-
buffer credit services to support full-speed operation over long distances, and have
Long Wave-Length (LWL) or Extended Long Wave-Length (ELWL) media.

Same as above, but more inter-site links are required than there are fibers available
to carry them. (CWDM supports multiple links per fibre pair.) The LWL or ELWL media
must support different frequencies of light in addition to being strong enough to
cover the required distances.

Like passive CWDM, active WDM services map multiple links to a single fibre pair.
They also increase the supported distance by hundreds of kilometers beyond passive
technologies, can share links between different protocols such as Ethernet and Fibre
Channel, and can be rented from providers. However, they are more expensive than
passive solutions.

It is possible to transport Fibre Channel over SONET/SDH to support very long dis-
tances. This is useful when native solutions are unavailable, are cost-prohibitive, or if
SONET/SDH networks are already in place.

If the other technologies are unavailable, it is possible to transport Fibre Channel
over IP. This is a less-reliable and lower-performance option, but it is widely available
and typically less expensive.
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Michael Brownee

T   he year is 2210, mankind has taken to the 
stars, exploring, discovering, and populating. 
In his thirst for exploration he inadvertently 

sets foot on a planet sacred to another ancient 
species called the Kerak. Suddenly attacked, the 
space fleet is quickly decimated and these aliens 
seem intent hunting humanity to extinction—a 
goal which they intend to achieve by following 
stragglers back to Earth, and destroying the home 
planet of the interlopers. You play Seth Walker, an 
engineer and robotics specialist, aboard one of the 
large motherships, en route to Earth. Kerak forces 
have infiltrated your ship, and they’re intent on 
killing everybody aboard and allowing the ships 
navigation systems to take them to your home 
planet. PILOT, the ships control computer, decides 
to put everybody to sleep in their sleeping pods, 
while flooding the ships environs with a toxic gas, 
thereby eliminating the Kerak. You awaken later, 
only to find you’re alone. The other crew members 
have gone missing from their pods. As you arm 
yourself and fight your way through Kerak forces 
(who somehow survived the poison gas) you’ll 
find remnants of the crew aboard who’ll join you 
in your objective—to rid the ship of these invad-
ers. But the Kerak are not your only worry. There 
are also cybernetic entities onboard—part-human, 
part-machine, all trouble. Where did they come 
from? Since they’re hostile towards both you as 
well as the Kerak, what do they want? Then there’s 
PILOT, who seems to have his own agenda, and his 
own methods of saving humanity.

At the outset, Space Siege doesn’t have a 
very strong storyline, and there are a lot of 
gaps—especially about who the Kerak are, why 
is your ship so important to them, and such, and 
these you will have to fill in yourself. This tale 
isn’t without its twists, and in the end, you’ll 
be entertained. As Seth Walker, you have a per-
sonal dilemma as well. There are a number of 
cybernetic body parts—legs, hands, and even a 

spine and brain that you will come across 
in the game. These body parts enhance 
skills and make you stronger, or bestow 
bonuses to your character stats. You’ll 
need to decide whether you wish to stay 
human, or...err...indulge your RoboCop 
fantasies. There’s also a point in the 
game where you’ll need to make 
an important and rather epic 
decision—but we’re not spilling 
the beans!

The game has great body 
physics and rag doll effects. For 
example, when an explosion 
throws bodies around, they’ll 
slide to the floor rather real-
istically. Weapon and gre-
nade effects are good, as is 
the animation and attacks 
of your main melee weap-
on, the Magblade. Keep in 
mind though, that this is 
an isometric game, and not 
fully 3D, like some of the 
other hack-n-slash games 
out there.

I quite liked the game, and was 
entertained for around ten hours, 
thanks to the sometimes interesting 
storyline, and the action. However, 
there’s nothing that stands out 
about Space Siege, and I’m waiting 
for Diablo 3 to get my real hackin-n-
slashin thrills.

michael.browne@thinkdigit.com

Rating: 7/10

Developer: Gas Powered Games

Publisher: Sega

Save humanity
by sacrificing yours – part by part
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Michael Brownee

C
  OH was a superb game—superb visuals, a 

superb aural component, amazing campaign 

scenarios, and an immersive experience like no 

other. Creating such an RTS isn’t easy, and sequels are 

only fun if they out do their predecessors. Out came 

Opposing Fronts, and I just had to get my hands on it. 

For me, the best part of the COH franchise is the game-

play itself. The beautifully crafted, realistic locales, 

the winding storyline, the sheer grit of combat, and 

the beauty of immensely detailed maps, all add to the 

level of immersion, and after a while, I effortlessly 

slipped into the role of a World War 2 sergeant, or tank 

commander, depending on the mission. The missions 

themselves were very well done, and hardly repetitive. 

As a gamer, you were always kept on your toes, guess-

ing, and COH rewarded quick strategic thinkers—a 

formula which I absolutely loved.

Opposing Fronts brings with it two campaigns. 

This time you get to play as both the Axis (German) 

forces as well as the Allies (British). This adds some 

more replayability for the campaign part of the game. 

Both add up to be longer than the original game's 

campaign—I’m a fan of single player, so goody! In the 

first campaign, you’ll play as two German brothers 

who are tasked with battling British forces who air-

dropped in a daring raid that was historically known 

as Operation Market Garden. The British part of the 

campaign has you battling against the forces of the 

Third Reich in a struggle to regain the French city of 

Caen. At the very outset both the Germans and British 

play very differently from the original game, and 

there are a number of new units, with new abilities, 

and a host of new vehicles.

The terms of strategy the British, as a race, focus 

on their infantry and artillery more, they rely on 

CompanyIn The
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delaying enemy advances with mines, and Howitzers. 

They are also a lot more mobile with good infantry 

support providing tanks, like the Sherman FireFly and 

the Cromwell—the former a tank destroyer, and the lat-

ter a general purpose tank. The light Stuart battle tank 

makes short work of foot soldiers, and can be used 

to support advances against troop emplaced within 

structures and machine gun nests. The lumbering, 

heavily armoured Churchill tank is also available, in 

three avatars. The British infantry are also able build-

ers, especially their sappers, who can also lay mines 

and wield anti tank weapons.

The Germans are also mobile, in fact, even more 

so, as they have the most powerful tanks in the game. 

While the British must build their tanks, the Germans 

have most of their tanks made available to them via 

the command point tree. Although they can only build 

a Panzer IV tank, you can summon powerful all pur-

pose Panther tanks, tank hunter Hetzer tanks, and the 

super tank-hunter the Jadgpanther. In the campaign 

you will also get to control the King Tiger, a very pow-

erful tank strong against most enemies. The Germans 

tend to bulldoze the map—once they get access to 

these powerful tanks.

Despite their differences I found both sides to be 

evenly matched, the British with their devastating 

artillery and the Axis, with their ability to booby trap 

resource points and buildings. Relic’s winning formula 

remains largely unchanged, except for faction changes, 

and why the heck not?

Environments and effects detail remain a treat 

for the eyes. Battlefields can be rain drenched, foggy, 

or arid, and everything from the totally destructible 

environments and structures is detailed to perfection. 

Remnants of vehicles, scorched bodies, and debris 

can be seen after battles, even terrain deformation 

is impressive. All weapon effects are impressive, and 

attention to detail is good—for example, you will wit-

ness details like the smoke that comes out of a tank's 

exhaust, or the recoil of a shoulder mounted bazooka. 

Troops will seek cover if fired upon, and their desper-

ate scampering around amid shouted orders really sets 

the tone for realism. 

The multiplayer component is robust, but due 

to the high system requirements, you may be hard 

pressed to find servers. Skirmish mode against AI 

opponents is fun though.

For me COH: Opposing Fronts is a game virtually 

sans flaws. I happen to have a fast PC with a quad 

core, 4 GB of RAM and a GeForce 8800GTX graphics 

card, so I could enjoy this game in all its splendour. 

And I’ve never come across a better WW2 based RTS 

experience! michael.browne@thinkdigit.com
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The fearsome King 

Tiger in action 
German infantry go to work repairing a damaged tank

Infantry with a Nebelwerfer rocket artil-
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Rossi Fernandes

For those unaware and wondering 
how they missed the last 3 chapters 
of this game, Devil May Cry is a hack-

n-slash game that once again comes back 
again to the PC for the second time. You 
play Nero, and for the first time, Dante! 

The game plays by missions that are 
to be completed one after another. There’s 
no proper story-lined gameplay through 
the game, but there’s a very satisfying 
heart-warming start to the story. It’s not 
just non-stop mindless slicing of monsters 
either. There are puzzles on the way to 
open up gates leading to large halls or 
corridors of creatures waiting to welcome 
you. Everyone wants a change, so there’s 
the boss fight. These boss fights are not so 
rare. They aren’t too easy to win, but are 
still good fun. At the end of every mission, 
you get a score card for your performance, 
and depending on the amount of items 
you’ve collected on the way, you get to 
choose from new combos and items. It’s 
not just swords—there are guns, and com-
bos for them are available.

Gameplay is great and there’s a tuto-
rial in the beginning that flows alongside 
the initial storyline, and  shows you how 
to use the controls. Most of the AI is 
simple, but the attacks are well-timed, 

so that you relish the game. Since this 
is a hack-n-slash, people expect it to get 
repetitive... it doesn’t! There’s a good vari-
ety of creatures to defeat—each one with 
a unique and charming way of trying to 
kill you. You discover new ways to defeat 
these cute little colourful beings, and over 
time, you may find even more spectacular 
ways. It’s like trying to learn a musical 
instrument—sometimes frustrating, but 
always exciting.

Graphically, the game looks absolute-
ly gorgeous. Users who saw screenshots 
online, and felt it looked great should 
know that it looks a lot better in motion. 
The cut-scenes are some of the best and 
most entertaining. Sure, they are cheesy 
as hell at times, but they’re still good fun 
to watch. The levels are well designed too 
and range from indoors and outdoors and 
sometimes a mix of them. 

Sure the graphics are great but can 
you run it? It runs on pretty much any 
decent hardware. An 8800 GT for example 
can run it flawlessly at 1680x1050 with 
the graphics turned up to the maximum 
and FSAA turned on. Sounds have been 
made well too. The acting has influences 
from East Asian cultures, and it all adds 
up well with the cut scenes to form the 
kind of game that Devil May Cry is.

Upgrades in the game come in the 
form of combo moves that you can do 
and there’s plenty to keep you occu-
pied. Speaking of combos, controls 
are very good if you use a controller. 
I used an Xbox 360 controller and it 
did wonders. Using the keyboard is 
fine if you just want to get through the 
game, but if you want some of the more 
advanced combos, you're going to find 
it difficult. 

Besides, sitting back on a reclining 
chair and playing a game that is usually 
destined for consoles suddenly makes 
you forget that you’re actually playing 
this on a PC.

If you are looking for a game with an 
open world gameplay, character build-
ing and meeting new friends online, we 
suggest you play Second Life. If you want 
a complete change from FPS games that 
you're used to playing on the PC, then 
DMC4 with its fun gameplay, cool graph-
ics and sound, and cheesy cut scenes is 
perfect for you.

It earns a well-deserved rating of 
8.5 from us, and is a must-play for any 
one who wants good button-mashing 
action on the PC. 

rossi.fernandes@thinkdigit.com
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Devil May Cry 4
Cry he will… cry he must!



He looked far into the future
and discussed the various
transformations that he
expects in technology. He
noted how the increasing
connectivity to the Internet
will allow for more
development of server-based
technology. “People often
talk about this as the
Internet service revolution,
that will eventually lead to
machines that have lots of
server  capacity, lots of low-
cost computing, low-cost
storage  and that will let us
write software in an even
more ambitious way,
eliminating the last
constraints we have.”
Reading between the lines, it
means that in the future,
Microsoft hopes to catch up
with Google and offer
services on the lines of
Google apps.

His other gem was about
touch screen appliances
being everywhere, “because
they’re fairly developed in
the labs, I can say that in 10
years (they) will be
widespread.” Yes, he did say
“In ten years, they will be

fairly widespread,”  in case
you thought you read
wrong. In another interview,
for BBC, he said “I’ll be
brave, in five years we’ll
have many tens of million of
people sitting browsing
their photos, browsing their
music, organising their lives
using this type of touch
interface.” 

Err... Mr Gates, it’s
called an iPhone or an iPod
Touch, and millions are
already using such devices.

Some other Gates gems
include “I believe OS/2 is
destined to be the most
important operating
system, and possibly
program, of all time.” 

It’s sad really, because a
lot of Linux fanboys and
general Microsoft bashers
now get to add more fuel to
the already raging anti-
Microsoft fire. On some
forum a member seems to
have the last laugh, “Hell,
what do you expect from a
person who never saw the
end of the millenium
coming.” This was in
reference to the Y2K bug. 

PSYCHOTECH

The Spam
King Is Dead
In 2002 Edward “Eddie”
Davidson started an Internet
promotions company known
as “Power Promoters”.
Between 2002 and 2005,
Davidson’s company
specialised in sending
thousands of unsolicited e-
mails advertising watches,
perfumes, penny stocks and
other products. He lied and
misguided about the
products in his mails,
increasing their apparent
value. The voluminous
nature of his activities earned
him the title of “Spam King.”

On December 3, 2007 he
plead guilty in a US Court.
By April 2008, after many
hearings, he was judged
guilty by US District Court
Judge Marcia S. Krieger and
sentenced to two years in
prison. Some of his ill-gotten
gains including property and
gold coins were forfeited,
and he was ordered to pay
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FirstEscape

There have been
ridiculously priced
tech products

around ever since people
had the money to spend
on them, but this one
takes it to an entirely
different level. The i-
Phone was more or less
a status symbol till the
skimming tactics got the
prices low enough for a
lot of people to afford
one, and along comes a
German fellow called
Armin Heinrich who
puts together an iPhone
app that displays a red
gemstone with a glowing
effect and puts it on sale on
the iPhone online app store
for $999.99, which is the
most any software
developer is allowed to
charge for an app on the
store. 

The app is called i-am-
rich, and does not do
anything else. So in effect,
for a little less than a
thousand dollars, you get
an icon on your iPhone
that proclaims your
richness. The miserable
excuse for an app, for
reasons unknown was
removed from the store,
without any explanation
being given to the
developer or the users. 

That was however, not
before eight people bought
it, six from the United
States and one each from
France and Germany—all
within the twenty four

hours for which the app
was available. The
application is still available
on the developer’s Web
site, by special request over
e-mail. Message boards on
blogs discussing this
scam/brilliant marketing
gimmick/exceptional
exercise in human
psychology are awash with
posts of those who want to
offer a look-alike for $1 or
the $1500 i-am-richer
iPhone app, but the
original stands without
being equalled. 

Heinrich didn’t receive
the amount that is due to
him from the site, but that
is probably because there
were some purchases made
by mistake or after
thinking the application
was a joke. Despite the ‘all
sales final’ policy, Heinrich
has offered to return the
money of those who have

purchased the app by
mistake, but he has to get
the $5,600 he has earned
first. Those people who
now own the app, are
really happy about how
exclusive it is, and have
said so in their mails to
the developer. 

SHORTSIGHTED SEER

Bill Gates
Predicts The
Future; Or
The Past

Bill Gates is often called a
stealer of ideas, and accused
of indulging in less than
ethical business
practices.He’s also infamous
for his sometimes awry
predictions—“640 K ought to
be enough for everybody,”
which to be honest was
probably wrongly attributed
to him. It’s probably all that
money that he’s surrounded
by that causes jealousy and
the need for such rumours. 

However, his latest
prediction, some say,
suggests that he’s retired just
in time... Addressing a
gathering of 1,600
researchers, developers and
academics in Hong Kong, Bill
Gates shared his “vision”
about the future of computer
use. This was a seminar
marking the tenth
anniversary of Microsoft, at
their Asian research wing.

Jimmy Wales was the guy
who turned around the
concept of the mob
mentality by using it for
fruitful purposes. In
retrospect it may seem like
a simple idea, but
Wikipedia was an

important breakthrough
on how efforts of various
individuals are
collaborated over the
Internet, and paved the
way for many technologies
that are called ‘Web 2.0’.

Born in 1966, Wales
began by working on
Nupedia, which was like
any encyclopaedia—
experts were called in to
write articles, and peers
would review it. There was
only one major
distinction, it was free.
Wales hired Larry Sanger
to be the editor-in-chief for
the Nupedia project.

Larry Sanger had the
idea of using the wiki
script to make the
encyclopaedia editable by
anyone. Wikipedia spread
like wildfire, more than
doubling in size every
year. The free multilingual
open content
encyclopaedia was born.
In 2006, Time magazine
named him on the list of
the most influential
people in the world. 

People Who
Changed

Computing

Facebook Bans Scrabulous
The popular Facebook application Scrabulous was banned
on all facebook networks across the world, except in India,
from where it originated. The app by Jayant and Rajat
Agarwalla was used by ten times as many people as
Mattel and Hasbro’s official scrabble app. Luckily, Indians
are the only people in the world who get to play it

WHO NEEDS SWAROVSKI?

The $1000 iPhone App

Paul V. Mockapetris

Whatever 
Happened To…

64-bit Computing 

Abit is the most
fundamental unit of
data, either a 0 or a 1. A

32-bit processor is the norm,
and they can process data
units that are 32-bits or 4
octets wide. A 64-bit
processor, can handle data
units twice as wide, i.e. 8
octets, and therefore promise
faster computers. 

64-bit computing has
been around since the sixties,
and at the turn of the century,
it looked as if they would
replace the 32-bit processors
in the PC market. Intel’s
Itanium, AMD’s Athlon 64 and
Apple’s G5 were all competing
with each other to establish
themselves in the 64-bit
market—only, there was no
market. All the hype fizzled
out, and 64-bit computing has
been stuck in limbo ever since.
The biggest benefit of 64-bit
computing was also its biggest
problem. A 32-bit processor
can use up to 4 gigabytes of
RAM, with 2 GB allotted to the
OS and 2 GB for the
applications. A 64-bit
processor, on the other hand
can handle 16 billion
gigabytes—there is simply no
need for it. 

The transition from 16-bit
to 32-bit happened in the
heydays of Windows, and was
pretty smooth. However,
changing over to 64-bit is
much trickier process. Video
content and Gaming stand to
benefit the most in the
changeover, and will be the
driving forces, if and when it
happens. There will always be
a need for more computation
power—and no one will put an
upper limit on this.

Hack Your Brain
Mitch Altman has made a brain machine that induces
hallucinations, nirvana or deep sleep cycles using
LEDs that flash into your eyes along with alpha, beta,
theta and delta sonic pulses phased to your brain
through the ear. This is a piece of open-source
hardware from the guy who made TV-B-Gone

Call Airtel on XXX-XXXX-XXX for help

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture with a tech angle to it.
The picture should have been shot by you, and should not have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal address, oonn oorr bbeeffoorree tthhee 2200tthh

ooff tthhiiss mmoonntthh to digipick@thinkdigit.com. One prize-winning picture will be published each month.

Participate and win next month:
Google Power Tools-Bible
by Ted Coombs, Roderico DeLeon

Published by

Last month’s winner:

Imtiyaz Jariwala

Jimmy Wales

n  China blocks access to iTunes n  Scientists herd cows using GPS n  Doggyspace, social network for dogs launched n n Airtel claims iPhone unhackable n The PSP3000 is also a phone n Parents fear gaming more than Porn n Facebook hits 100 million users
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Escape

NOSEY GMAPS

Drunk Man
On Google
A man, known only as “Bill”
from northern Australia,
wanted to go biking with his
buddy on the island of
Tasmania. Only, before he
could do this, his buddy
died. So Bill went down to
the local bar and had a few
drinks, got properly drunk
and a bunch of his friends
bundled him into a cab and
sent him home. After
reaching home, he promptly
collapsed on his mother’s
front lawn. On any other
day, he would have woken
up a few hours later with a
splitting headache, and gone
inside for a cup of coffee...

Along comes a car, with
a guy operating a video
camera in the back. The
object of the whole setup is
to upload entire streets on
to the Internet, for Google
Map’s latest offering, called
Street View. Bill eventually
gets up, presumably has his
cup of coffee, and is well on

his way towards recovering
from his buddy’s death,
goes surfing for a while,
decides to look up his own
home on the Street View
offered by Google, and
suddenly he sees himself in
a right state on the World
Wide Web. He was obviously
not too happy with it. Bill
did not officially complain,
but a number of users
flagged that part of the site,
and Google has since then
removed the content—but
not before the hilarity of
the whole situation made a
pint sized celebrity out of
him on the Web. 

UPGRADE TO XP

Vista Users
Like XP
Better
Microsoft is trying hard to
get people to fall in love
with Vista. Despite Vista

being far superior to XP in
terms of security, a third of
Vista users downgrade to XP
according to research firm’s
CTO Craig Barth in
collaboration with
InfoWorld. They surveyed
more than 3000 computers
shipped in the last six
months and came to this
conclusion. Sometimes, the
downgrade was done by the
customers once they
purchased their computers,
but there were instances
were vendors such as Dell
downgraded their systems
based on requests from their
customers. Perhaps the most
demeaning thing about the
whole issue is that a lot of
people are not looking at
this as a downgrade at all.
In their opinion, replacing
Vista with XP is actually an
upgrade!

The deep permeation of
XP in the corporate
environment is the
reason for this. It looks
like Microsoft’s $300
million advertising
campaign to boost
Vista sales isn’t
helping.

Hard Hit…Or Hitting Hard?
August—not the most
eventful of months. We had
a long, lazy weekend, since
the fifteenth was a Friday.
After that none of us could
seem to get our stuff
together. For one, everybody
seemed to be coming to
work late, and our office
looked like a night-shift
affair at 10.00 am. Then
products we intended to test
got delayed, courtesy
the heavy rains. 

We were hit hard with
the loss of Bhaskar Sarma,
and Rohan, who just joined
us last month, but was
bitten by the malaria
parasite. Aditya came in
though, and saved the day.
It’s brilliant how so many of
our readers, like Aditya, join
us and are able to hit the
ground running. Of course,
he’s often seen running for

cover in our Q3
deathmatches.

Milind Koyande
http://tinyurl.com/5qdb5z
http://win-regedit.blogspot.com/2008/08/native-
processor-performance-control-in.html

The following tweak applies to processors with
either Intel SpeedStep or AMD PowerNow!
Processor performance control technologies.
Windows includes inbuilt processor performance
control to utilise it more efficiently. Some CPUs
that support the aforementioned technologies
have trouble with random hangs under XP. Even if
you’ve installed an updated CPU driver, XP might
not have enabled it. This hack is for such cases.
Navigate to: HLM\SYSTEM\CurrentControlSet\
Services\P3\Parameters

Here, create a new DWORD value (or modify
the existing value) called HackFlags, and edit its
value according to the following.

0: Disables native XP support
1: Use settings inherited from Intel Software

during your XP upgrade.
5: Allow XP to support all modes when on

battery

You will need to restart for the change to take
effect.

Jal Desai
http://tinyurl.com/59m7md
http://jal-infotech.blogspot.com/2008/08/flock-
powerful-yet-unnoticed-internet.html

When we think of an Internet browser, the first
thing that comes into our mind is Microsoft
Internet Explorer.

Too bad. Well, times changed and people
migrated to Firefox and then ‘flocked’ around
Opera. I think one should now flock around
‘Flock’—ya that’s the name they gave it. Flock is an
Internet browser that was hiding for all these
years, and nobody noticed it.

First of all, it does it all. Casual surfing is
awesome with the tabbed interface which almost
all browsers have these days. Digging more into
the features, it has many many plugins built into
it, such as its own RSS Reader, a People sidebar,
a cool personalisation facility ‘My World’ which
integrates snippets of Yahoo!, Digg, Flickr,
YouTube, etc.

Boredom Killer
The inane, weird and
sometimes hilarious
underbelly of the Web
can be accessed from
www.i-am-bored.com—the
site is constantly updated,
and never fails to deliver a
dose of refreshing
miscellany. 

Check out the links in the
weird or tech category. You
can also login to keep track
of your favourites if you end
up being a regular.  

Homepage Surfer
www.coolhomepages.com
keeps track of the cutting
edge in Web page design.
Most of the sites here are
online portfolios of
designers, studios or artists,
and each site has a unique
approach in terms of
interface and navigation.
These sites use flash or java
in innovative ways, and many
are content heavy with
videos and special effects
integrated into the site

layout. Beware though; many
of the sites here are heavy
on bandwidth.

Loony Toons Junkie
Which firm sells anti-nightmare
machines, strait-jacket ejecting
bazookas, jet-propelled pogo
sticks and rocket powered
roller skates? ACME, of course.
Head over to home.nc.rr.com/
tuco/looney/acme/acme.html
and you will find a complete
catalogue of Acme products.
Pity you can’t buy them. 

$714,319 in restitution to the
IRS. In May 2007, Davidson
was asked to report to a
facility designated by the
Bureau of Prisons. 

Not even three months
into his sentence, Davidson
decided that he had seen
enough of the prison life. It
was a minimum security
prison, and Davidson
jumped ship into his wife’s
car when she came to give
him a visit. He forced her
into the car, went home,
changed his clothes, picked
up some cash and
vamoosed. A warrant for the
escaped Davidson was
issued, and the FBI, the IRS
and the Rocky Mountain
Safe Street Task Force
combined forces in their
manhunt. 

It did not last too long.
He was discovered in a car
with three bodies, the one
of his wife, his three year
old daughter and his own.
Presumably, he first shot his
wife and child, then turned
the gun on himself. The
spam king is survived by a
one year old son. We’re just
hoping no one tries to make
the most of the situation,
and starts sending spam
that asks you to help the
son out by not deleting. We
know, it’s a terrible
thought, but then
spammers are notoriously
low human beings.

DUBYA ESCAPES RTI

White House
Server Loses
E-mail
Anyone in their right
minds would assume that
the White House is one of
the safest, most secure and
technologically proficient
places to receive and send
e-mails in the world. Well,
they would assume wrong,
because as many as 225
days of e-mail have
mysteriously gone missing
from the White House
servers. This is not thanks
to some renegade hacker
from Afghanistan, there is,
in fact no one to blame
but the White House staff
themselves. 

While on the one hand,
the White House has asked
for bids to make a recovery
attempt, on the other, they
refuse to admit that the
event has even occured—
ignoring all media
enquries on the topic.

It is unlikely that the e-
mails are going to be
recovered because of the
scale of the problem. There
is a 9 page document that
gives the details about the
e-mails stored in 35,000
disaster recovery backup
tapes. The recovery efforts

are running into reels of
red-tape and going
nowhere. 

Meanwhile, a fresh
angle is thrown in by
citizen watchdog groups
who claim that the
missing data conveniently
covers the period of the
Iraq violence and the Abu
Gharib prison scandal.
Those for open legislation
have hit a brick wall
because of documents
being withheld from the
common public—as these
documents are entirely
missing.

Conspiracy Theorists
are sure to put this tit-bit
of information to good use
for their own purposes.
Suspiciously, a huge chunk
of the 400 million or so e-
mails falls bang in the
middle of the period of
time when the White
House was planning to
attack Iraq. 

The recovery of these e-
mails, if at all it ever
happens, will easily outlast
the term of Bush’s
presidency.

This at a time when the
White House is taking
increasing measures to
keep track of the hundreds
of thousands of e-mails
that fly around the
Internet each day. We’re
waiting for the Dubya
jokes to start flying.
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Wiki Jargon
Stub: A stub is an article that
stops short of giving an
encyclopaedic coverage of any
topic. The article is usually
very short, giving a very brief
overview of the topic without
an index or sub sections.  
Wikify: Many articles are
added without the markup
language (known as wiki
markup) used by wikis and do
not follow the formatting
guidelines of the wiki. To
wikify an article means to
format the content as a wiki. 
Patrols: Patrols are units of
wiki editors who regularly go
through a class or category of
articles and take any
reasonable actions to improve
their quality. Most patrollers
are humans, but there are a
few bots as well, programmed
to automatically enhance the
content of articles. 
Cleanup: A cleanup is the
term used by image editors
on a wiki to enhance the
quality  of an image. This
usually involves removing
distracting backgrounds,
color correction or using an
image of a higher resolution. 
Forking: Forking is the practice
of lifting or copying an article
from one wiki, and pasting it
onto another and editing it to
suit the needs of the wiki that
it is copied to. The GNU
licences on wiki articles makes
this a legitimate practice. 
Collaboration: A bunch of
people combining their
creative efforts towards a
portal or a class of articles is
known as collaboration. 
Usage: Was patrolling the
Culture and Arts pages of
Wikipedia, and came across
quite a few stubs and a few
images that need a cleanup.
Many pages on Uncyclopedia
are forked from wikipedia, and
some of them need to be
wikified by collaboration.

Wild Wild Web

n Scientific research says World of Warcraft increases scientific thinking n American engineering Geek names his son Jon Blake Cusack 2.0 n Mobile number 9111119 sold for $19,000 in Bahrain n GPS tagged tortoise wanders into Cannabis farm in Washington DC n 

Featured here are
snippets from some of
the best bloggers who
have registered at the
Blog Watch section on
thinkdigit.com.

If you wish to be
featured too, head to
www.thinkdigit.com/
blogger.php and
sign-up.
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Who said, “All your base are
belong to us”?

a) CATS
b) DOGS
c) RATS
d) PIGS

Which was the first gaming
console to use 128-bit

architecture?
a) Playstation 3
b) X-box 360
c) Sega Dreamcast
d) Mitashi Cub

Which is the largest
computer manufacturer in

the world?
a) Apple
b) IBM
c) Fijitsu-Siemens
d) Hewlett Packard

Who made the game
Dangerous Dave?

a) Ubisoft
b) Softdisk Publishing
c) Bluemoon software
d) Apogee software

Which was/were the first
dog(s) in space to safely

return back to earth?
a) Laika
b) Chernushka
c) Belka and Strelka
d) Veterok and Ugolyok

Why do many Linux users
work from the command

prompt?
a) It is faster
b) It is more geeky
c) It allows more control
d) GUIs are for idiots

What was the first portable
audio cassette player called?

a) iTape

b) Aiwasonic
c) Walkman
d) Stereobelt

Which was the first computer
virus?

a) The Creeper
b) Brain
c) ElkCloner
d) MyDoom

Who developed the Java
programming language?

a) Alan Kay
b) James Gosling
c) Niklaus Wirth
d) David Pascal

10

9

8

7

6

5

4

3

2

ACROSS
2. The account name used to gain access to a 
computer system (5)
5. Short for signature (4)
7. A software or hardware feature included in order
to simplify later additions or changes by a user (4)
8. America Online (abbr) (3)
9. ASCII character 35 (5)
11. Maximum clarity of an image rendered by
an optical system (5)
12. Microsoft’s current mail client and office
information package (7)
17. 3.5 inch input drive (6)
18. Search------ -series of alphanumeric characters 
used to perform an online search (6)
21. A simulation of the real thing (7)
24. Bug free code (5)
25. Finnish mobile telephone company (5)
26. Telelocator Alphanumeric Protocol (abbr) (3)
27. Recording sound over a single channel (4)
28. ------printer — kind of impact printer in which the full
character set is on a rotating cylindrical magnetic media,
available for each printing position (4)
29. Code name used for the beta version
of Microsoft’s SQL Server 2005 (5)

DOWN
1. LIfecycle Global HyperText (abbr) (5)
3. Popular search engine and internet company (6)
4. An online community where users read
and post topics of common interest (5)
6. Popular software for burning and copying 
various formats (4)
7. Same as 7 across (4)
10. A free open-source application that is used for
exchange of data using the TFTP-is also a name
of a large fruit (7)
11. Early computer language for numerical
and scientific applications (7)

13. System not in operation (3)
14. Out---- — folder where e-mail is stored before
it is sent and after it is created (3)
15. Basic unit of numbering in a binary numbering
system (3)
16. ‘---Of Empires’ — real time strategy game (3)
19. An attempt to violate computer security (6)
20. -----light — artificial light providing illumination
over a large area (5)
21. Sony’s trade name for its desktop and laptop
PCs (4)
22. To copy a program into memory so it can
be run (4)
23. Manmade programs that infects systems
and causes them to crash (5)

Crossword

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

All Your Base, And More...
Which 2 famous companies
have come together to

colonise Mars?

a) Dellorola (Motorola and Dell)
b) Asun (Sun and Asus)
c) Orapple (Oracle and Apple)
d) Virgle (Virgin and Google)

1

In Mesopotamia—as early as
200 BC—the first

batteries were used.
These primitive
people used a half-volt
battery to electroplate silver
on to copper!

Did You
Know?

Answers

1. d
2. a
3. c
4. d
5. b

6. c
7. a
8. d
9. a
10. b

Crossword by Nitta Jaggi

Last month’s Winner
Sandeep Kumar Srivastav

Send in your entries to
TQ@thinkdigit.com on or by
the 20th of this month. One
lucky participant 
will win 

Professional Outlook
2007 Programming
By Ken Slovak
Published by

Win!

August’s Solution
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10th standard then (2002). Today, I’m a
computer science and engineering
graduate. Digit fueled my interests in
computers, and I’ve read many
technology magazines, both Indian and
International, and believe me, you rock!
Nobody beats you in the quality and
content balance that you strike. The Fast
Track itself is worth the whole price tag.

Still, I have a few complaints /
suggestions / requests:

The Anniversary Issue was not up to
the mark, apart from the cover story
which was good. Please mention
minimum system requirements in
game reviews.

Give us a detailed guide to video
encoding, compression, etc. 

Lastly, keep up the good work!

N. Lalit Vidyadhar Sharma

We’re going to try and make sure that you will
like all the issues to come. We will also start
publishing minimum system requirements for
game from the next issue onwards.

Team Digit

At Any Cost
First of all, my hearty congratulations to
you for being India’s No 1 technology
magazine. This is surely a tribute to your
team’s hard work for bringing a
technology navigator in our hands every
month! I’m a reader for the past two
years, and I can’t get digit in my
hometown Kangayam, because it’s a small
town. I travel every month to another city
(Coimbatore) to buy Digit, and am filled
with joy every time I get it in my hands.
I’ve loved each and every issue of Digit,
especially your all new colour Fast Track.

Digit has made me tech-savvy
amongst my friends, and has also helped
increase my self-confidence. When I
wasn’t a Digit reader, I used to just listen
to my friends when they spoke about
computers. Today, I’m the most
knowledgeable of them all, and it’s all
thanks to you.

I suggest you review more games,
and please don’t inform me of SKOAR!,
because I’d like to stick to Digit only. Also
please start mentioning minimum
system requirements, and which
platforms the same game is available for.
I also want a Fast Track to: Gaming-II,
Virus proof your PC-II, Upgrade your PC-
II, etc. Your August 2008 issue rocks!

Sathiyamoorthy.S

Inbox

Sharing Is Caring
I am a class III employee with the Orissa
State Govt., and a non-technical person
by profession. I am a regular reader of
Digit since July 2004. The Tips and
Tricks, Q&A and software sections have
turned me into a computer quack in my
locality—I help others by referring to
knowledge provided in your magazine. 

Now I have more than 125 GB of
different software that you have
provided in the CDs and DVDs. I want
to share the software with other
people, but I don’t know if it will be
legal to do so. 

Recently I visited thinkdigit.com,
and I must say, it’s marvelous! I forget
time after entering the thinkdigit
world, as everything that is needed to
keep a man glued to a site is right
there.

The articles, blogs, Tips & Tricks,
Q&A, etc., makes one forget about
other sites. However, I find that the
software section is not up to the
standard of a reputed magazine like
Digit. I would like a section on the site
that tests and reviews software, so we
know that all that is on your
download’s section has been
recommended by Digit.

Ajaya Kumar Pani

You may share most of the content of the
discs with your friends, but you may not
share any licenses for full version software
that are provided specially for Digit readers—
one disc equals one license. As for the
downloads section on the site, we will try and
implement your suggestion.

Team Digit

No Net Nonsense
I am a reader since October 2002. I’ve
read many computer magazines before,
but Digit is just special. Your articles are
amazing and the software on your CDs
and DVDs help users like me who are
not connected to the Net. However, I
find that certain software that you
provide need you to connect to the Net,
which are completely useless for people
like myself. I love games, and would like
to become a game tester. What
qualifications will I need?

I am a physically challenged person,
will that matter?

Praveer Joshi

Unfortunately, we cannot ignore software that
need a Net connection, just as we cannot give
only Linux software, or only multimedia software.
Although useless to you, the same software could
be very useful for those who do have a Net
connection. Our attempt is to give some of the
best applications being developed, regardless of
their requirements. We hope you will continue to
find enough software that you like, so that the
ones you cannot use will cease to bother you.

As for becoming a game tester, there’s really
no qualification, as experience and skill is all
that matters. Even though the gaming industry
in India is just in its infancy, there’s been enough
buzz for us to consider it to have a very
promising future. Your physical handicap should
not stop you from becoming a game master,
which is the whole beauty of games.

The best example we can cite is that of a
colleague of ours, Mayur Bhatia, who despite
a severe handicap, remained one of the best
FPS gamers we’ve seen. He passed on from
this world a couple of years ago, but we
remember him fondly, as the guy who used to
whip our butts in Quake 3!

Team Digit

Missing Pages, Again
I loved the August issue of Digit, but I
found that pages from 25 to 33 were
repeated, and 16 to 24 were missing.
This meant that I had to miss the article
related to graphics cards. I do not want
a replacement, because I am content to
read the article when you provide PDFs
next, but please be more careful in the
future. I have seen repeated pages once
before in the magazine and the Fast
Track, but I didn’t have missing pages
then, just extra repeated ones. You are
doing a great job though, and the
content is getting better and better.
Keep up the good work.

Darshan Singh Kali Rai

First of all, I would like to congratulate
you for publishing such a great and
informative magazine. I am a faithful
reader for over 10 years now, and have
never missed a copy of Digit from April
1998-when you began as Chip. This,
however, is the first time I am writing
to you to show my appreciation of your
hard work. I have collected all you Fast
Tracks, and they are very useful to me.

You are doing a fantabulous job,
and have raised your standards a lot,
but I think it’s time to go global.
Instead of being confined to the sub-
continent, we readers promise to
support you if you decide to undertake
global projects such as creating
hardcore games or making essential
software and hardware.

This month, when I opened the Fast
Track and the magazine, I found that
some pages were missing—33 to 64 for
the Fast Track and 109 to 116 for the
magazine. Please do the needful.

Anurag
Kanpur, UP

Darshan and Anurag, please send us your full
postal addresses via e-mail and we will
replace your copies immediately. Since a
couple of readers have complained for two
months in a row, we will look very carefully
into the binding process from now on.

Team Digit

Praise And Protests
Digit is definitely the No.1 tech
magazine, not only in India, but
probably the world! I’ve been reading
Digit since its very early days. I was in

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com
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We will try and address all of your complaints
and suggestions as soon as possible,
especially in the game reviews section.

Team Digit

Thanks!
I’ve been reading Digit since August
2006 and this is the first time I am
writing to you. You don’t need to
remind us that you are India’s no. 1
tech magazine, as we know this
already. Over the past two years, your
articles and the wonderful Fast Track
have really helped me to increase my
Tech Gyaan. I am a BCA student, but
unlike others, I can even compete
with my seniors, and it’s all because
of you guys! I appreciate all your hard
work, and thank you for all that you
have done for us readers.

Although Digit is the best, I still
think there’s room for improvement:

Please include less expensive
gadgets in your Bazaar section, as not
all of us can afford high-end products. 

A regular Linux article would be
appreciated, although I respect what
you have already done to promote
Linux and the Open Source
movement.

The DVDs and CDs also need
to contain more Free and Open
Source software.

Rishabh Sharma

More Than Meets The Eye
I thought computers were only meant
to play games on, until the Digit light
dawns on me, that is. Thanks to Digit ,
I am known as a computer specialist
in my class.

I even suggested the book to a
colleague, and he’s hooked. The Fast
Track is portable, informative, and is
the ideal companion for me.

I don’t like the idea of giving
bootable DVDs or CDs, and thank you
for the advertisements. My brother
recently bought a Dell XPS Laptop,
and this was the result of an
advertisement in Digit. If possible,
please start adding Bollywood songs
to your discs.

Ranganath Pai

We will try and address all of your complaints
or suggestions as soon as possible.

Team Digit

Secret Admirer
I can’t say that I’m a regular
buyer of Digit, but I am a regular
reader. It all started for me in class
8, when I wanted to buy a computer
magazine while I was travelling in a
train. I don’t know why, but I cried like a
baby to get one. Finally, since my parents
couldn’t bear it, my father got off at a
station to buy one for me. Unfortunately,
before he could get back in, the train
started moving. My mother started
screaming at me, and I blamed myself too.
Somehow, my father managed to grab a
magazine, pay for it and hop back on to
the train, but in a different compartment.
At the next station, he came back angrily
and handed me the magazine—Digit. Until
I read Digit, I thought computers were
only for games and word processing. That
magazine opened my eyes to the latest
technologies and innovations.

However, due to the events on the
train, my parents were extremely angry,
and decided to punish me by never
buying anything, especially Digit, for me.
For a year I read and re-read the same
Digit magazine, and thankfully, my
school subscribed in 2005. From then on,
I spent all my free time in my library
reading Digit, but never got a chance to
see the CDs or DVDs because the
Librarian used to throw them away.

I started buying Digit a year later,
because everywhere I would turn there
was Digit on the stands. Now you know
what would happen if I asked my parents
to buy me a Digit magazine! So, I secretly
collected money from anywhere possible,
and started buying Digit every month.
The best part is, nobody knows that I
have so many Digit magazines, because I
wrap them in school covers, and keep
them with my school books. I hide the
discs with my movie collection. It’s hard
work, but Digit is worth the effort! 

Thanks to Digit, I’ve scored 95 per cent
in class 12 in Computer Science. I will be
starting my course in B.Tech Computer
Science this September. While my friends
dream of joining MNCs, all I want to do is
work with you, Digit. You have the power
to defeat any competition that stands in
your way, and can become a global brand. 

Please publish this letter, as I plan to
show it to my parents, and hopefully,
finally forgive me for that day on the
train, and let me subscribe.

Elam Parithi
Coimbatore

Letter 
of the
Month

Feedback: August 2008 Issue
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Wacko Jacko turned 50 on August 29. To celebrate the
occasion, Sony BMG, GMTV and the Sun released a
compilation of his greatest hits in an album called the

King of Pop. The album itself is unique as fans get to vote for their
favourite songs and each country the album is released in will
have a different tracklist based on the votes of that country. To
promote the album, Jackson released a game across three social
networking sites to allow fans (those that still exist anyway) to
make a virtual version of Jackson dance. While it is not clear
whether there is any combination of keys that can make the dig-
ital Jackson grab his crotch, there are a bunch of hourly and daily
prizes up for grabs. Every hour, the best player gets a ringtone,
and the best player for every day gets a limited edition King of Pop
iPod Nano. The top 5 players (over 18) have a chance at grabbing
two round-the-world plane tickets, or a Sony Bravia 32-inch TV.
For the under-18 category, the top prize is a PS3 and thankfully
not a trip to Neverland Ranch.

Beat It

Obama has gone ahead and picked a vice presidential can-
didate who is known to be harsh on file sharing net-
works and Internet privacy. When Joe Biden was a sena-

tor, he sponsored a bill that would make using any software that
plays MP3 files on a computer a criminal offence. Thankfully,
the bill was not passed because all the heavyweights of Silicon
Valley were against it, and for once Apple and Microsoft were on
the same side. He has also sponsored another bill backed by the

RIAA (Recording Industry Association
of America) that makes it difficult for
listeners to record songs from satellite
and Internet radio stations.

If all the tech-hate was not
enough, Biden does not want the com-
mon public to have access to e-mail
encryption, as one of his many count-
er-terrorism measures. The measures
include allowing government access
to all kinds of information transmit-
ted by voice, text, data or any other
form of communication.

Obama’s VP Is
A Tech Hater

Usually it is Bill Gates who has to eat his words with infa-
mous proclamations like “Spam will be a thing of the

past in two years’ time.”
This time around, it’s the guys at Apple who are left in the

lurch. Jerry Seinfeld has just been hired by Microsoft to be a
part of a $300 million advertising campaign. This after the lat-
est offerings by Mac were seen in the background of many
Seinfeld episodes, and a decade after Mac proclaimed “Jerry
would never use a PC” in one of their own advertising cam-
paigns. For a writer and a comedian, working in the enter-
tainment industry, there must be a pretty good reason to
switch loyalties from a Mac to a PC. The reason happens to be
$10 million worth of greenbacks, which is sufficient incentive
to make anyone change his mind.

Mac Addict For
Microsoft




